This edition was last updated on 31* August 2018
This free e-Book will teach you Excel 2016 in five hours.

We’ve helped over 2 million students to learn Excel 2016. If you carefully work through this free book there
is absolutely no doubt that you will master Excel 2016.

Make sure you are using the latest version of this free e-book

This book has been completely updated to cover the July 2018 Version 1803 Semi-Annual* update to Excel
2016. Excel is constantly updated. You can always download the most recent version of this book
completely free of charge from: https://thesmartmethod.com. This book is for Excel 2016 for Windows users. If
you have an older version of Excel (2007, 2010 or 2013), or if you are using the Apple Mac version, you can
download the correct version of this free e-book at the https://thesmartmethod.com web site.

Why you should use this free e-book

B It is up-to-date Excel 2016 is the first Excel version that is continually updated (by regular automatic
updates). This book is also continually updated to match the latest semi-annual release of Excel 2016.
This means that the screen grabs will exactly match what you see on your screen and the instructions
will be easy to follow. It can be very frustrating to try to learn Excel 2016 using an out-of-date book.

B Learning success is guaranteed. For over fifteen years, Smart Method® classroom courses have been
used by large corporations, government departments and the armed forces to train their employees.
This book has been constantly refined (during hundreds of classroom courses) by observing which skills
students find difficult to understand and then developing simpler ways of explaining them. This has
made the book effective for students of all ages and abilities. We have never had a student who has
failed to learn Excel after taking one of our courses.

B Ttis the preferred choice for teachers. As well as catering for those wishing to learn Excel by self-study,
Smart Method® books have long been the preferred choice for Excel teachers as they are designed to
teach Excel and not as reference books. Books follow best-practice adult teaching methodology with
clearly defined objectives for each learning session and an exercise to confirm skills transfer. With
single, self-contained lessons the books cater for any teaching period (from minutes to hours).

B Ttis free (and you can print it). Because this book is free of charge, schools, colleges, universities and
businesses are able teach their students best-practice Excel skills without the substantial cost of
designing lesson plans or purchasing books. If printed copies are needed you can print them yourself,
or any copy shop can print books for you.

B Smart Method books are #1 best sellers. While this e-book is entirely free of charge, every paper
printed Smart Method® Excel book (and there have been ten of them starting with Excel 2007) has been
an Amazon #1 best seller in its category. This provides you with the confidence that you are using a
best-of-breed resource to learn Excel.

B No previous exposure to Excel is assumed. You will repeatedly hear the same criticism of most Excel
books: “you have to already know Excel to understand the book”. This book is different. If you've
never seen Excel before, and your only computer skill is using a web browser, you'll have absolutely no
problems working through the lessons. No previous exposure to Excel is assumed and everything is
explained clearly and in a simple way that any student, of any age or ability, can easily understand.

B It focuses upon the everyday Excel skills used in the workplace. This free Basic Skills book will teach
you the basics without confusing you with more advanced, less used, Excel features. If you decide to
expand your Excel education, you'll be able to move on to other Smart Method® books (or e-books) in
this series to master even the most advanced Excel features.

* Excel 2016 Version 1803 was released to the Semi-Annual update channel on July 10, 2018. An earlier build of the same version was released earlier to the

Monthly update channel. You’ll learn more about update channels, builds and versions in: Lesson 1-2: Check that your Excel version is up to date.
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Learn Excel in just a few minutes each day (or in one five-hour sitting)

Excel is a huge and daunting application and you'll need to invest some time in learning the skills presented
in this book. This will be time well spent as you’ll have a hugely marketable skill for life. With 1.2 billion
users worldwide, it is hard to imagine any non-manual occupation today that doesn’t require Excel skills.

This book makes it easy to learn at your own pace because of its unique presentational style. The book
contains 43 self-contained lessons and each lesson only takes a few minutes to complete.

You can complete as many, or as few, lessons as you have the time and energy for each day. Many learners
have developed Excel skills by setting aside just a few minutes each day to complete a single lesson. Others
have worked through the entire book in less than five hours.

Hardly anybody understands how to use every Excel feature

It is important to realize that Excel is probably the largest and most complex software application ever
created. Hardly anybody understands how to use every Excel feature, and for almost all business users, large
parts of Excel’s functionality wouldn’t even be useful.

Many learners make the fundamental error of trying to learn from an Excel reference book that attempts to
document (though not teach) everything that Excel can do. Of course, no single book could ever actually do
this. (There are some advanced Excel features that easily justify an entire book of their own).

This free Basic Skills book will teach you the basic Excel skills that are used every day, in offices all over the
world.

By the end of this free Basic Skills book you’'ll be completely comfortable creating your own formulas and to
make use of the functions available in Excel’s vast function library. You'll also have mastered many other
fundamental Excel skills such as AutoSum, AutoFill and Formula Autocomplete. You'll be confident in the
knowledge that you are using Excel’s features in the correct, best-practice, professional way and you’ll feel
really at home with Excel.

Leamn Learn Learn

Excel 2016 *'"" Excel 2016 *"~
Eggﬁ! g?(;luss Essential Skills Expert Skills

With The Smart Method With The Smart Method

With The Smart Method

Learn Excel in less
than five hours
with this
FREE book

Mike Smart

If you decide to further expand your Excel education, you'll be able to use other books in this series to
master even the most advanced Excel features.

If you’d like to review the precise skills taught in each book you can view the full course outlines for
Essential Skills and Expert Skills at: https://thesmartmethod.com.
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Excel competence levels

Office workers who use Excel every day for a living generally only use (and only need) a tiny fraction of
Excel's enormous feature set.

Excel is a huge application with thousands of features. For most users it is a mistake to attempt to learn
every Excel feature but, instead, to learn Excel to a competence level that is appropriate for your needs.

Expert

Essential

Basic Skills

This is where you will be at the end of this book. You'll feel really comfortable with Excel. Even at Basic
Skills level you'll have mastered many skills that most untrained Excel users are unable to use correctly.
You'll also be using the correct professional techniques rather than “muddling though” in the way that most
self-taught Excel users do. You’'ll be able to create your own formulas using functions from Excel’s vast
function library and have a complete mastery of fundamental Excel features such as AutoFill, Flash Fill and
Formula Autocomplete.

Essential Skills

At this level you will have excellent Excel skills, good enough to impress any employer, and your Excel skills
will be better than most office workers (even those with many years of experience). You'll be able to create
beautifully laid-out worksheets that will really impress. You'll also have mastered many advanced features
that few Excel users understand such as absolute and relative cell references, visualizations, advanced charts,
conditional formatting, date serial numbers, themes and cloud computing. You can see a full list of the lessons in
the Essential Skills book at: https://thesmartmethod.com.

Expert Skills

At Essential Skills level you'll be really, really good with Excel. If you want to join the tiny elite of power-
users who can do absolutely everything with Excel you can use this follow-on book to move to expert level
and become a true Excel guru.

This is a extremely high level of Excel competence that is very rarely found in the workplace (even amongst
top professionals). Your Excel skills will be greater and broader than almost all other Excel users and you
will understand (and be able to use) absolutely every Excel feature. You’'ll have a complete mastery of skills
that are often even a mystery to Excel power users such as Excel data models, many to many relationships, power
maps, solver, macros and get & transform. You can see a full list of the lessons in the Expert Skills course at:
https://thesmartmethod.com.
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Every lesson is presented on two facing pages

Pray this day, on one side of one sheet of paper, explain how the Royal Navy is prepared to meet the
coming conflict.
Winston Churchill, Letter to the Admiralty, Sep 1, 1939

Winston Churchill was aware of the power of brevity. The discipline of condensing thoughts into one side of
a single sheet of A4 paper resulted in the efficient transfer of information.

A tenet of our teaching system is that every lesson is presented on two facing sheets of A4. We’ve had to
double Churchill’s rule as they didn’t have to contend with screen grabs in 1939! If we can’t teach an
essential concept in two pages of A4 we know that the subject matter needs to be broken into two smaller
lessons.

How this book avoids wasting your time.

Over the years | have read many hundreds of computer text books and most of my time was wasted. The
big problem with most books is that I must wade through thousands of words just to learn one important
technique. If I don’t read everything I might miss that one essential insight.

Many presentational methods have been used in this book to help you to avoid reading about things you
already know how to do, or things that are of little interest to you.

There are now two versions of Excel
2016 (the pay-once Excel 2016 version
and the subscription Excel 365
version). Where there are differences

Learn Excel 2016 Expert Skills with The Smart Method

note Lesson 3-28: Use the IFS

N The IFS function is function

they are clearly documented.

only available in the
Excel 365 version of

Excel 2016

Screen grabs are provided in-line with
the text when they can explain what
you need to do more clearly than
words alone.

The IFS function was
introduced in the Excel 2016
Version 1601 update (released
oon Feb 16, 2016)

2016, you will not had
to this function.

If you want to progress through the
course as quickly as possible you don’t
have to read notes.

Notes usually expand a little on the
information given in the lesson text.

note

VLOOKUP is still
(usually) a better
solution than IF§
~N I Lesson 3-3- Use the IF logic
\ Jfunction (sidebar) 1 advised:

A et 2016 allones vou to nest
TF functions up to 64 levels

deep (which is 63 too many)”.

If you already know how to do
something simply read the bold text
for each step and just do it. Step notes
sometimes provide precise instructions
about how to progress if the one-line
description is inadequate. Notes also
often include interesting information
about the current task.

The new IFS and SWITCEH

of Tmpler alternative to
nested [F functions.

-~ This doesn’t mean using the [F5
and SWITCH functions
provides a better solution than
VLOOKUP.

It is easy to introduce errors
using IFS and SWITCH, as the
order in which the logic pairs
are listed is vital to the correct
operation of the function.

In almost all business situations
a VLOOKUP will provide a

When there is a sample file (or files) to
accompany a lesson, the file name will
be shown in a folder icon. You can
download the sample file set from:
https://TheSmartMethod.com

If you have Excel 2016 (rather than Excel 365) you will not be able to
complete this lesson (see sidebar).

In: Lesson 3-23: Use a VLOOKUP function for an inexact lookup, yvou used a
VLOOKUP function to return a grade from different pass mark
percentages.

In early 2016 Microsoft added a new IFS5 function to Excel 365. In this
lesson you will solve exactly the same problem posed in: Lesson 3-23: Lse
a VLOOKUP function for an inexact lookup, with a logic based (rather than
lookup based) solution.

1 Open IFS Grades-1 from your sample files folder.

A B C D E F
Exam Results

Name

Johnny Caine
George Marley
Betty Anan
Paris Winfrey
022y Dickens
Johnny Roberts

Percentage Grade
70%
68%
86%
80%
95%
8a%

Percentage Grade
0% Fail
60% C
70% B
80% A
90% A*

W0 N s W -

This is an exact duplicate of the Grades-1 sample file that you used
at the beginning of: Lesson 3-25: Use a VLOOKUP function for an
inexact lookup.

2 Use the IFS function fo calculate the grade for each student
by defining grade data within the function

Sometimes it may be better to “hard code” data (such as the
percentage grade thresholds) within the function itself. Thdis
prevents users from accidentally deleting or changing the grade
percentage thresholds within the worksheet.

The argument against this approach is that the worksheet is more
difficult to maintain if grade thresholds change in the future.

1. Clickin cell C4.

2. Click: Formulas-»Function Library->Logical >IFS.
The Function Arguments dialog for the IFS function appears.
The IFS function accepts up to 127 Logical Test/Value pairs.

3. Enter the following pair of arguments:

better and more elegant
solution than the use of the IFS LogkaLtest! [54:60% 3
or SWITCH function. Value_if_truel | “Fail £
i The Logical Test is an expression that returns TRUE or FALSE.
i * In this case the test asks if Johnny Caine's percentage is less
T—p | IFS Grades-1 I than 60%.
166 http://ExcelCentral com




Learning by participation

Tell me, and I will forget. Show me, and I may remember. Involve me, and I will understand.

Confucius, Chinese teacher, editot, politician and philosopher (551-479 BC)

Confucius would probably have agreed that the best way to teach IT skills is hands-on (actively) and not
hands-off (passively). This is another of the principal tenets of The Smart Method® teaching method.

Research has backed up the assertion that you will learn more material, learn more quickly, and understand
more of what you learn if you learn using active, rather than passive methods.

For this reason, pure theory pages are kept to an absolute minimum with most theory woven into the hands-
on lessons, either within the text or in sidebars.

This echoes the teaching method used in Smart Method classroom courses where snippets of pertinent
theory are woven into the lessons themselves so that interest and attention is maintained by hands-on
involvement, but all necessary theory is still covered.

Session Three: Advanced Functions . .
Whenever something can easily go
As Johnny scored 70% the result 1s FALSE (as 70% is not less . .
than 60%). If Johnny had a percentage score of less than 60%, Wl”Ol’lg, or When the SubJECt text 1s
e function would have retumed the texc“Fail’ L particularly important, you will see the
. Note that textual values must be placed in double quotation . .

L I_test1 <60%

ool ekl marks. If you omit to do this Excel will add them for you. lmportant 81debar' You ShOUId always

Value_if_truel “Fail” . .

o 4. Add Logical Test/Value pairs for the other grades (see si read important sidebars.

3t P g
Logical_test2 | B4<T0%
. 5. Click the OK button.

Value_if_true2 | "C

Logical_tests |B4<a0m Johnny Caine’s B grade is shown in cel

- 6. AutoFill cell C4 to the end of thy
Value if true |5 Hor e Ao Reendo & Each lesson models a real-world
" All grades are now corry . . .

) |k business problem. You'll immediately
Value_if_trued A" D E F | i

e | [P Percentage Grade Percentage Grade A// appreciate the value and relevance of

= 2= 70% 8 0% Fail .
Value_if_true5 | -a* 5 58% C 50% C each skill you learn.
6 Betty Anan 86% A 70% B

. / 7 Paris Winfrey 80% A 80% A
|mp0 rtant 8 |Ozzy Dickens 95% A* 90% A*

Excel recognizes text 3 USE the IFS function to calculate the grade for each student A goal of this book is not to waste your
as having a value in using the grade data defined in cells E3:F8. time by explaining any skill twice.
logical expressions ions i mn . .

gical exp b Delete the funcions in column & Sometimes you may forget something
If you try entering text into the 2. Add anew IFS function to cell C4. . .
oo sttrey e g 5 that has already been covered earlier in
surprised to find this result: 3. Enter the following pair of Logical Test/Value arguments: th

€ course.

e e ot Logical testt | B2 Sess *

[ cae_feacup " Value if_truet | “Fail z Cross-references are extensively used,
Excel has evaluated this logic MNotice the use of an absolute reference for cell E5. Thisis // pointing you baCk to the IESSOH in
expression: needed to make sure that the formula AutoFills correctly. : .

’ / which the relevant skills were learned.
="teacup”>90% 1f you do not understand absolute references see: Lesson 1-10:
__and has surprisingly Add percentage and running totals using Quick Analysis (sidebar). The CrOSS-references also help When
i TS 4. Add appropriate Logical Test/Value pairs for the other grades. you use this course as a reference book
This seems zling at first - . .
unti 52 xelized that (bebind 5. Click the OX button. but have forgotten the more basic skills
ihi sezves) el v cesgy 6. Autofill cell C4 down to the end of the :
e e utofill cell C4 down to the end of the range needed to complete each step.
implement alphabetical sorting, Exactly the same grade values are now shown. The difference

tnal v from the first approach is that the grades will change if the

almmef::‘;;m[ t;\:l::i:r:umher Percentage/Grade thresholds shown in cells E3:F8 change in
so that (in an A-Z sort} the future.
numbers will always come 4 Save your work as IFS Grades-2.
before text.
To work around this peculiarity

vou could add a new first
Logical Test/Value pair to ensure
that the value in column B was
numeric like this:

Logical_test! | ISNUMBER(B4)=FALSE

Value if_truet | “Eror
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We encourage you to print this free book

Unlike most e-books, this one isn’t locked to prevent printing (this is also true for all other Smart Method e-
Books. E-books can only be obtained and downloaded from https://thesmartmethod.com (the publisher).

For classroom use we recommend that you print this book

While this book is useful for self-instruction, it is also ideal for teaching structured, objective-led, and highly
effective classroom courses. Even though you can read this book on an iPad*, personal computer or e-Book
reader, some students find it easier to use if you print it onto paper. You may legally print copies of this
book (for yourself or your students) with only two conditions:

1. You must print the book exactly as it is published and may not add or remove any book content or
copyright notices.

2. You may not make any charge of any sort for the books that you print. It is permissible, however, to give
free copies of the book to students who attend a free (or paid for) class or course.

For classroom courses you can obtain a professional-looking result by printing on both sides of the paper.
You can then punch the pages and place them into a binder. Make sure that odd pages appear on the right-
hand side. This enables each two-page lesson to be viewed without turning the page.

For a professional touch you can also put a color insert onto the front cover. Here’s how it then looks:

Learn

Excel 2016
Basic Skills

With The Smart Method

‘than five hours
with this
FREE book

You can find full instructions for printing and binding this free e-book (along with the color front and back
cover pages) at: https://thesmartmethod.com/printing-the-basic-skills-course.

You can obtain printed books for under four dollars.

According to Lyra Research it costs between $0.05 and $0.08 cents per page to laser print a single black and
white page. This means that it will cost between $6.00 and $9.60 to print this book yourself on a laser
printer.

If you need five or more books you can save a considerable amount of money by ordering perfect-bound
paper printed books from ourselves using our not-for-profit printing service. At time of writing our cost
price (including free delivery to most world locations) was under $4.00 per book.

You can only order these not-for-profit books from: https://thesmartmethod.com/wholesale-printed-books.

These paper books are often used as free giveaways by employment agencies (for job applicants who need
Excel skills) and by employers (to empower their employees with basic Excel skills at minimal cost).

*If you are an iPad user you can add this e-book to your iBook library. The procedure for adding this e-book to your iBook library is detailed in a step-by-

step guide at: https://thesmartmethod.com/how-to-save-and-view-a-pdf-e-book-on-an-ipad.
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Introduction

Welcome to Learn Excel 2016 Basic Skills With The Smart Method®. This book has been designed to enable
students to master Excel 2016 fundamentals by self-study. The book is equally useful as courseware in order
to deliver courses using The Smart Method® teaching system.

Smart Method publications are continually evolving as we discover better ways of explaining or teaching the
concepts presented.

Feedback

At The Smart Method® we love feedback — both positive and negative. If you have any suggestions for
improvements to future versions of this book, or if you find content or typographical errors, the author
would always love to hear from you.

You can make suggestions for improvements to this book using the online form at:

https://thesmartmethod.com/contact

Future editions of this book will always incorporate your feedback so that there are never any known errors
at time of publication.

If you have any difficulty understanding or completing a lesson, or if you feel that anything could have been
more clearly explained, we’d also love to hear from you. We’ve made hundreds of detail improvements to
our books based upon reader’s feedback and continue to chase the impossible goal of 100% perfection.

Downloading the sample files

In order to use this book it is sometimes necessary to download free sample files from the Internet.

The process of downloading the free sample files is explained step-by-step in: Lesson 1-5: Download the sample
files and open/navigate a workbook.

Problem resolution

If you encounter any problem using any aspect of the course you can contact us using the online form at:

https://thesmartmethod.com/contact

We'll do everything possible to quickly resolve the problem.

The Excel versions that were used to write this book

This edition was written using both the Excel 2016 perpetual license (the one-time payment version) and
Excel 2016 for Office 365 subscribers (semi-annual version 1803, released on Jul 10 2018). You'll discover which
version your computer is running in: Lesson 1-2: Check that your Excel version is up to date. In this book, the
perpetual license version of Excel is referred to as: Excel 2016 and the subscription version as Excel 365.

If you are using Excel 2007, Excel 2010, Excel 2013 or Excel 2016 for Apple Mac we have a free Basic Skills e-
book that matches your version available from: https://thesmartmethod.com.

© 2018 The Smart Method® Ltd 11
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Typographical Conventions Used in This

Book

This guide consistently uses typographical conventions to differentiate parts of the text.

When you see this Here’s what it means

Click Line Color on the left-hand bar and then
click No line.

Italics are used to refer to text that appears in a
worksheet cell, an Excel dialog, on the Ribbon,
or elsewhere within the Excel application.
Italics may sometimes also be used for
emphasis or distinction.

Click: Home—~>Font->Underline.

Calibri -1

Font

Click on the Ribbon’s Home tab and then look
for the Font group. Click the Underline button
within this group (that’s the left-hand side of
the button, not the drop-down arrow next to
it).

Don’t worry if this doesn’t make sense yet. We
cover the Ribbon in depth in session one.

Click: Home->Font->
Underline Drop Down->Double Underline.

T EHES

Underline

=

D Double Underline

Click on the Ribbon’s Home tab and then look
for the Font group. Click the drop-down arrow
next to the Underline button (that’s the right-
hand side of the button) within this group and
then choose Double Underline from the drop-
down list.

Click:

File=>Options—>
Advanced>General >
Edit Custom Lists=>Import

This is a more involved example.

1. Click the File tab on the Ribbon, and then
click the Options button towards the
bottom of the left-hand pane.

The Excel Options dialog appears.

2. Choose the Advanced list item in the left-
hand pane and scroll down to the General
group in the right-hand pane.

3.  Click the Edit Custom Lists... button.
Yet another dialog pops up.
4.  Click the Import button.

Type: European Sales into the cell.

Whenever you are supposed to actually type
something on the keyboard it is shown in bold
faced text.

Press <Ctrl> + <Z>.

You should hold down the Ctrl key and then
press the Z key.

12
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When a lesson tells you to click a button, an
image of the relevant button will often be

2. AutoSum - shown either in the page margin or within the
text itself.
nOte If you want to read through the book as

In Excel 2007/2010/2013/2016
there are a possible 16,585
columns and 1,048,476 rows.
This is a great improvement on
earlier versions.

quickly as possible, you don’t have to read
notes.

Notes usually expand a little on the
information given in the lesson text.

important

Do not click the Delete button at
this point as to do so would
erase the entire table.

Whenever something can easily go wrong, or
when the subject text is particularly important,
you will see the important sidebar.

You should always read important sidebars.

tip
Moving between tabs
using the keyboard

You can also use the
<Ctrl>+<PgUp> and
<Ctrl>+<PgDn> keyboard
shortcuts to cycle through all of
the tabs in your workbook.

Tips add to the lesson text by showing you
shortcuts or time-saving techniques relevant
to the lesson.

The bold text at the top of the tip box enables
you to establish whether the tip is appropriate
to your needs without reading all the text.

In this example, you may not be interested in
keyboard shortcuts so do not need to read
further.

anecdote

I ran an Excel course for a small
company in London a couple of
years ago...

Sometimes I add an anecdote gathered over
the years from my Excel classes or from other
areas of life.

If you simply want to learn Excel as quickly as
possible you can ignore my anecdotes.

trivia
The feature that Excel uses to
help you out with function calls

first made an appearance in
Visual Basic 5 back in 1996 ...

Sometimes I indulge myself by adding a little
piece of trivia in the context of the skill being
taught.

Just like my anecdotes you can ignore these if
you want to. They won’t help you to learn
Excel any better!

The World’s Fastest
Cars

When there is a sample file (or files) to
accompany a lesson, the file name will be
shown in a folder icon. You can download the
sample file from:
https://thesmartmethod.com/sample-files.
Detailed instructions are given in: Lesson 1-5:
Download the sample files and open/navigate a
workbook.

© 2018 The Smart Method® Ltd
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How to use this course

This course utilizes some of the tried and tested techniques developed after teaching vast numbers of people
to learn Excel during many years teaching Smart Method classroom courses.

In order to master Excel as quickly and efficiently as possible you should use the recommended learning
method described below. If you do this there is absolutely no doubt that you will master the advanced Excel
skills taught in this book.

Three important rules

#1 - Complete the course from beginning to end

It is always tempting to jump around the course completing lessons in a haphazard way.
We strongly suggest that you start at the beginning and complete lessons sequentially.

That's because each lesson builds upon skills learned in the previous lessons and one of our goals is not to
waste your time by teaching the same skill twice. If you miss a skill by skipping a lesson you'll find the later
lessons more difficult, or even impossible to follow. This, in turn, may demoralize you and make you
abandon the course.

#2 If possible, complete a session in one sitting

The book is arranged into sessions and lessons.

You can complete as many, or as few, lessons as you have the time and energy for each day. Many learners
have developed Excel skills by setting aside just a few minutes each day to complete a single lesson.

If it is possible, the most effective way to learn is to lock yourself away, switch off your telephone, and
complete a full session, without interruption, except for a 15-minute break each hour. The memory process is
associative, and we've ensured that the lessons in each session are very closely coupled (contextually) with
the others. By learning the whole session in one sitting, you'll store all that information in the same part of
your memory and will find it easier to recall later.

The experience of being able to remember all of the words of a song as soon as somebody has got you
"started" with the first line is an example of the memory's associative system of data storage.

#3 Rest at least every hour

In our classroom courses we have often observed a phenomenon that we call "running into a wall". This
happens when a student becomes overloaded with new information to the point that they can no longer
follow the simplest instruction. If you find this happening to you, you've studied for too long without a rest.

You should take a 15-minute break every hour (or more often if you begin to feel overwhelmed) and spend it
relaxing rather than catching up with your e-mails. Ideally you should relax by lying down and closing your
eyes. This allows your brain to use all of its processing power to efficiently store and index the skills you've
learned. We've found that this hugely improves retention of skills learned.

14 https://TheSmartMethod.com
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How to work through the lessons

At the end of each session, complete the session exercise

Keep attempting the exercise at the end of each session until you can complete it without having to refer to
lessons in the session. Don't start the next session until you can complete the exercise from memory.

At the end of each session, review the objectives

The session objectives are stated at the beginning of each session.

Read each objective and ask yourself if you have truly mastered each skill. If you are not sure about any of
the skills listed, revise the relevant lesson(s) before moving on to the next session.

You will find it very frustrating if you move to a new session before you have truly mastered the skills
covered in the previous session. This may demoralize you and make you abandon the course.

How to best use the incremental sample files

Many lessons in this course use a sample file that is incrementally improved during each lesson. At the end
of each lesson an interim version is always saved. For example, a sample file called Sales-1 may provide the
starting point to a sequence of three lessons. After each lesson, interim versions called Sales-2, Sales-3 and
Sales-4 are saved by the student.

A complete set of sample files (including all incremental versions) are provided in the sample file set. This
provides three important benefits:

e If you have difficulty with a lesson it is useful to be able to study the completed workbook (at the
end of the lesson) by opening the finished version of the lesson's workbook.

e  When you have completed the book, you will want to use it as a reference. The sample files allow
you to work through any single lesson in isolation, as the workbook's state at the beginning of each
lesson is always available.

e  When teaching a class one student may corrupt their workbook by a series of errors (or by their
computer crashing). It is possible to quickly and easily move the class on to the next lesson by
instructing the student to open the next sample file in the set (instead of progressing with their own
corrupted file or copying a file from another student).

The time you spend learning Excel is hugely worthwhile

Excel is a huge and daunting application and you'll need to invest some time in learning the skills presented
in this course. This will be time well spent as you'll have a hugely marketable skill for life. With 1.2 billion
users worldwide, it is hard to imagine any organization of any size that does not value Excel skills.

If you persevere with this course there is no doubt that you will master Excel. A little time and effort is
needed but the skills you'll acquire will be hugely valuable for the rest of your life.

Enjoy the course.

© 2018 The Smart Method® Ltd 15
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A bad beginning makes a bad ending.
Euripides, Aegeus (484 BC - 406 BC).

Even if you are a seasoned Excel user, I urge you to take Euripides’
advice and complete this session. You'll fly through it if you already
know most of the skills covered.

In my classes I often teach professionals who have used Excel for over ten
years and they always get some nugget of fantastically useful information
from this session.

In this session, I teach you the absolute basics you need before you can
start to do useful work with Excel 2016.

I don’t assume that you have any previous exposure to Excel (in any
version) so I have to include some very basic skills.

Session Objectives

By the end of this session you will be able to:

Start Excel and open a new blank workbook

Check that your Excel version is up to date

Change the Office Theme

Maximize, minimize, re-size, move and close the Excel window
Download the sample files and open/navigate a workbook
Save a workbook to a local file

Understand common file formats

Pin a workbook and understand file organization

View, move, add, rename, delete and navigate worksheet tabs
Use the Versions feature to recover an unsaved Draft file

Use the Versions feature to recover an earlier version of a workbook
Use the Ribbon

Understand Ribbon components

Customize the Quick Access Toolbar and preview the printout
Use the Mini Toolbar, Key Tips and keyboard shortcuts
Understand views

Hide and show the Formula Bar and Ribbon

Use the Tell Me help system

Use other help features

© 2018 The Smart Method® Ltd
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note

Windows 8.1 Users

When Windows 10 was
released in July 2015, Microsoft
recommended that any
Windows 8.1 users update free
to the new version (the free
update offer ended in July
2016).

Mainstream support for
Windows 8.1 officially ended
on January 9, 2018.

For these reasons, by the time
that you read this book it is
unlikely that there will be
many Windows 8 users left in
the world.

. Google Chrome o
Google Earth
HTC

. 1570 Extensions

. Inno Setup 5

. InterVideo WinDVD

. Learn Excel 2007 Essential Skills with The
Learn Excel 2007 Expert Skills with The 51

Maintenance

MSmart
Documents

Pictures

. Microsoft Expression Music

. Microsoft Mouse

. Microsoft Office
@ Microsoft E =
|£—| Microsoft F =

(W] Micrasaft Troubleshoot compatibility

Computer

. Microsoft Sive @  Eraser [

. Microsoft Silve U P Taskb
. Microsoft Silve DT IR

| Microsoft SQL Lot 5% e

Limnsii, Restore previous versions
Microsoft Visu
. Microsoft Win Send to 3
. Microsoft Win cut
. Mozilla Firefox
| MVP Software P
NetWaiting Delete
QuickTime

Rename
. Real

. Replay AV & Properties
. Replay Converter

Windows 7 start menu

Lesson 1-1: Start Excel and
open a new blank workbook

If you are using Windows 8 see sidebar.

Startup in Windows 7

1 Click the Windows Start Button e at the bottom left of
your screen.

2 Click the All Programs item at the bottom of the pop-up
menu.

3 Scroll down the list and click on the Microsoft Office 2016
item.

4 Pin Microsoft Excel 2016 to the start menu.

You'll be using Excel a lot, so it makes sense to pin it to the start
menu. This will make it appear at the top of the list in future, so
you'll be able to start Excel with just two clicks.

To pin to the start menu, point to Microsoft Excel 2016 in the list,
right-click your mouse and then choose Pin to Start Menu from the
shortcut menu.

5 Left-click Microsoft Excel 2016 to start Excel.

Excel starts and is displayed on the screen.

Startup in Windows 10

1 Click the Start Button E in the bottom left corner of the
Windows 10 screen.

2 Drag the Excel icon to the top of the start menu.

= Suggested

You're almost there
Finish phone setup

&

( -" pTorrent

If you can’t find the Excel icon, see the facing-page sidebar for
instructions on how to locate it.

You'll be using Excel a lot, so it makes sense to move the icon to
the top of the Windows 10 start menu. You'll then be able to start
Excel without having to search for the icon.

1. Point to the Excel icon.
2. Click and hold down the left mouse button.

3. With the left button held down, move your mouse towards the
top of the start menu. The icon will move with the mouse
cursor.

18
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note

If you can’t find the
Excel icon in
Windows 10

When you install Excel 2016 on
a Windows 10 computer an
icon is automatically added to
the Start Menu. If you can’t find
the icon proceed as follows:

1. When the Windows 10 start
menu is displayed, type: excel
on the keyboard. You will then
see the Excel application icon
on the screen. If you don't,
Excel is not installed on this
computer.

2. Right-click the Excel
application icon and click: Pin
to Start from the shortcut menu:

Best match

Excel
X
Desk

Lo Run as administrator

Search su .

99 [0 Open file location
Poexcels o i o start

Documents ' 1 pin o taskbar

You will now be able to locate
the Excel icon on the start menu
(though you may have to scroll
down to the bottom of the icon
list to find it).

note

Potential problems
when using templates

Many of Microsoft’s templates
have been created using some
very advanced Excel skills and
techniques. If you make use of
them there’s a danger that you
may depend upon a workbook
you don’t understand and are
unable to maintain.

Templates you create yourself
are far more useful. Creating
your own custom templates is
beyond the scope of this Basic
Skills course but is covered in
depth in the Essential Skills
book in this series (in: Lesson 3-
15: Create a Template).

4. When you reach the top of the start menu, release the left
mouse button.

The Excel 2016 icon is now permanently positioned at the top
of the Windows 10 start menu.

3  Left-click Excel to start Excel.

After you’ve started Excel

Mike Smart
mikesmart@thesmartmethod.com
Switch account.

Excel

Recent

Yo pened any workbooks recently. To brox
pen Other Workbooks,

‘aworkbook, start by

(@ Open Other Workbooks A B 4

U = | My Cashflow

: Take a I
tour ol

Blank workbook Welcome to Excel Business analysis feature tour

Now that Excel has started, Excel needs to know whether you want to
create a new workbook, or whether you want to open a workbook that
was created earlier.

When creating a new workbook, Excel also offers to give you a “flying
start” by using a template. Templates are sample workbooks that you
can adapt and modify for your own needs. The idea is very good but, in
reality, templates are not usually a good choice as it can take longer to
adapt them to your true needs than to design from scratch (see sidebar).

In this lesson you'll create a blank workbook.

1 Create a new blank workbook.
Left-click the mouse button on the Blank workbook template.

Note that, from now onwards, I will simply use the term “click”
when I mean left-click (the mouse button you will use most of the
time) and “right-click” only when you need to click the (less-used)
right mouse button.

The Excel 2016 screen is displayed, showing a blank workbook:

Book1 - Excel

Insert  Pagelayout Formulas Data Review View @ Tellme.. MikeSmart QShare

6 Calibri -1 - % %Cunditiunal Formatting ~ El el
By- B I U- A A - [# Format as Table -
Paste B - e Number & ot as 1avie Cells  Editing
¥ e DA . [ Cell Styles ~ - -
Clipboard Font F] Alignment [F] Styles
Al & F
A B @ D E [F G H J
1
L L]
2

2 Leave the workbook open for the next lesson.

© 2018 The Smart Method® Ltd
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important Lesson 1-2: Check that your
Update Channels Excel version is up to date

Update channels determine
when users will receive the
latest Excel version.

Automatic Updates

Excel 2016 perpetual users Normally Excel will look after updates without you having to do
If you have a perpetual license anything. By default, automatic updates are enabled. This means that
(the pay-once version of Excel updates are downloaded from the Internet and installed automatically.

2016) you will not receive any
feature updates, so you do not
have an update channel.

Excel 365 home users

If you have a subscription
version of Excel 2016 (this is
referred to as Excel 365 in this 1
book) that is targeted at home

users, you are required to

receive monthly updates

This is called the Monthly
Channel.
2

You will potentially receive
new or improved features
every month.

Excel 365 business users

New features added in the
Monthly Channel may have
bugs, as they will not yet have
been extensively tested by real-
world use.

If you have an Excel 365
version that is targeted at
business users (usually called
Excel Pro Plus), you will (by
default) have a different update
channel (the Semi-annual
Channel).

The Semi-annual Channel allows
new features to be thoroughly
tested before use. It is possible
(though difficult) for Excel Pro-
Plus users to change their
update channel to the Monthly
Channel.

The Semi-annual Channel only
updates Excel twice each year
(in January and July).

This book was written using
the July 2018 Semi-Annual
Version 1803.

3

It is possible that automatic updates have been switched off on your
computer. In this case there is a danger that you may have an old,
buggy, unsupported and out of date version of Excel installed.

This lesson will show you how to make sure that you are using the latest
(most complete, and most reliable) version of Excel.

Start Excel and open a new blank workbook (if you have not
already done this).

You learned how to do this in: Lesson 1-1: Start Excel and open a new
blank workbook.

Make sure that automatic updates are enabled.

File

1. Click the File button at the top-left of the screen.

This takes you to Backstage View. Backstage View allows you
to complete an enormous range of common tasks from a single
window.

2. Click: Account in the left-hand list.

Your account details are displayed on screen. Notice the Office
Updates button displayed in the right-hand pane.

If all is well, and automatic updates are switched on, you will
see a button similar to this:

Office Updates
(] 5

Updates are automatically downloaded and installed.
Update
Options =

If automatic updates have been switched off, you will see a
similar button to this.

Office Updates
Ky :

This product will not be updated.
Update
Options ~

In this case you will need to switch automatic updates on (see
next step).

Switch on automatic updates if necessary.
Click: Update Options—>Enable Updates.

20
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note

Version number and
Build

A new Excel version is usually
released to the monthly update
channel every month.

Each new version may add new
features to Excel 365.

If bugs or security issues are
found in a new version,
Microsoft will fix them and
publish a new build of the same
version.

It is quite normal for there to be
several new builds of each new
version during the month that
it is released.

Office Updates
1] 5

This product will not be updated.
Update
Options =

T Enable updates
Autor;l'g%:ically receive the latest updates
for sectvity, performance, and reliability.

4 If there are updates waiting to install, apply them.

Sometimes Excel will download updates but will not install them
automatically.

In this case you will see an update button similar to the following;:

Office Updates
[ .

Updates for this product are ready to install.
Update
Options =

If you see this type of button you should apply the update.
Click: Update Options=>Apply Updates.

You may be asked to confirm that you want to apply the update,
and to close any open programs to apply the update.

5 Notice your version number and update channel.

Product A

Product Information
] Office

Product Activated
Microsoft Office Home and Student 2016

0 About Excel

Learn more about Excel, Support,

About Product ID, and Copyright
Excel information,

Version 1807 (Build 10325.20082

Click-to-Run)

Product B Product C
Product Information Product Information
SUbSCprtIOﬂ Product Subscription Product
Microsoft Office 365 ProPlus Microsoft Office 365
9 About Excel 9 About Excel
Learn more about Excel, Support, Learn more about Excel, Support,
About Praduct D, and Copyright About Product D, and Copyright
Excel information. Excel information.
Version 1803 (Build 9126.2259 Click- Version 1807 (Build 10325.20082
to-Run) Click-to-Run)
Semi-annual Channel Manthly Channel

note

Perpetual license
versions have
different features

Perpetual license holders still
receive monthly updates but
these only include security
updates and bug fixes (not new
features).

A perpetual license holder
running Version 1803 will thus
see less features than a
subscription license holder

running the same Excel version.

You will see product information section displayed. If you see the
number 365 or the words Subscription Product, you will know that
you are using the subscription version of Excel 2016 (this is the
case for products B and C above). Otherwise you are using the
perpetual license version (this is the case for product A above). In
this book, the perpetual license version will be referred to as Excel
2016 and the subscription version as Excel 365.

Notice also the update channel and version numbers (see sidebars).

6 Click the Back button to leave Backstage View and
return to the worksheet.

7 Click the Close button in the top-right corner of the Excel
screen to close Excel.

© 2018 The Smart Method® Ltd
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note

The new Excel 365
Black theme

The new Black theme was
introduced as part of the Feb
2016 version 1601 update.

The Black theme provides even
higher contrast than the Dark
Gray theme.

| b Se

Insert L

X Calibri -1 - = % %Conditional Formatting = El el
== Eg- B I U-~ sy 4 -
Calibri B - 55 & Alignment Number EFormat s Table Cells  Editing
¥ - &-A- - - | [ cell Styles - - .
A : X I Clipboard Font ] Styles A
% Format Painter
Al - Je Rank v
| A B c D -
1 |Rank Country GDP - per capita (PPP) Date of information
n ote 2 1 Qatar $137,200 2014 est.
3 2 Luxembourg 597,600 2014 est.
4 3 Liechtenstein 589,400 2009 est.
Themes and 5| 4macau 538,700 2013 est.

Backgrounds affect
every Office

Lesson 1-3: Change the Office

Theme

Excel allows you to change the colors of screen elements (such as the
menu bar and ribbon) by selecting a theme. Excel 2016 users have three
themes available: White, Dark Gray and Colorful, while Excel 365 users
have an additional Black theme also available (see sidebar).

Colorful

RGN Insert  Page Layout Formulas Data Review View

Q Tell me...

Mike Smart . Share

Excel 2016 uses the Colorful theme as the default. The previous version of

Excel (Excel 2013) used the White theme as the default. The colorful
theme makes it clear which of the Office applications you are using as
Word, Excel, PowerPoint, Outlook and other Office applications each
have their own unique color.

application on all of
your devices

When you set a theme or
background in Excel you are
actually changing the theme
and background for the entire
Office suite.

Th h h H s The Wealth Of Nations - Excel = - O X
is means that you will have a
. y Home Insert Pagelayout Formulas Data Review View Q Tell me.. Mike Smart
consistent experience when ¥ B
a g 5 g db Calibri -1 - = : Conditional F tting = =
using other Office applications I = % onditional Formatting™ | & | | o
. Eg- B I U~ A A [Z% Format as Table - "
such as Word and PowerPoint. | paste ' Alignment Number Cells  Editing
¥ DA~ - - [Bcellstyles- - -
Clipboard Font ] Styles e
Al &2 I Rank v
A B C ] -
1 Rank_countrv GDP - per capita (PPP) Date of information
2 1 Qatar $137,200 2014 est.
3 2 Luxembourg 497,600 2014 est.
4 3 Liechtenstein 389,400 2009 est.
5 4 Macau 588,700 2013 est. -
» GDP Life Expectancy Mabile F ... (F) [ r

White

Ready .lj

The White theme has very low contrast and shading. Some designers feel

that this gives Excel a modern and “minimalist” appearance but it was
widely criticized by some users of Excel 2013 for causing eye strain and
being difficult to work with.

https://TheSmartMethod.com

22



Session One: Basic Skills

note

You can also
personalize Excel by
changing the
background

Background customization can
only be done if you are
connected to the Internet and
logged into a Microsoft
Account.

If you are logged into your
Microsoft Account, you will see
an Office Background drop-down
list (above the Office Theme
setting) that enables
backgrounds to be set:

When you choose a
background a “tattoo” is added
to the area above the Ribbon
with your chosen design:

note

Audio cues

Audio Cues were introduced in
the July 27, 2017 Version 1707
update.

If you enable Audio Cues a
different sound will be played
whenever you complete
common Excel actions (such as
cut and paste).

The idea is that you will
subconsciously link sounds
with actions so that when you
make a mistake it will “sound
wrong”.

To enable Audio cues:

1. Click: File>Options—=>

Ease of Access—>

Feedback options=>

Provide Feedback with sound.

You are also able to choose
between two different Sound
Schemes.

Dark Gray

The Wealth Of Nations - Exce

View ';-‘ Tell me.. Mike Smart Q.Share

EZ Conditional Formatting ~ @

Format as Table ~
Alignment Number EX Format a5 Ta Cells  Editing
+ | [ cell Styles~
Styles

GDP - per capita (PPP) Date of information
1 Qatar $137,200 2014 est.
2 Luxembourg $97,600 2014 est.
3 Liechtenstein 489,400 2009 est.
4 Macau 488,700 2013 est.
Life Expectancy Mobile F ... (&)

H M -—F—+ 0%

The Dark Gray theme provides high contrast between different screen
elements. It has been suggested that this theme would be particularly
useful for users with impaired vision.

1 Open Excel and open a new blank Excel workbook.
2  Change the Office Theme.

1. Click the File button at the top-left of the screen.

.
2. Click the Options button near the bottom of the left-
hand menu bar.

The Excel Options dialog box appears.

In the Personalize your copy of Microsoft Office section, you'll see
an Office Theme drop-down list. Click the drop-down arrow to
see the different themes available.

Personalize your copy of Microsoft Office

User name: Mike Smart

[] Always use these values regardless of sign in to Office.

Office Background: | No Background 7

Office Theme: Colorful | hd

Colerful
Office intelligent sery , Gray

Intelligent services br the cloud to the Office ap
decument content. | White

3. Click the Dark Gray theme.

4. Click OK to return to the Excel screen.

Experiment with each theme until you discover the one you
prefer. All of the screen grabs in this book were done using
the Colorful theme. If you choose a different theme the screen
grabs in the book may look slightly different to what you see
on your computer screen.

3  Close Excel.

© 2018 The Smart Method® Ltd
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Lesson 1-4: Maximize,
minimize, re-size, move and
close the Excel window

The main Excel window has a dazzling array of buttons, switches and
other artifacts. By the end of this book they will all make sense to you
and you'll really feel really comfortable with Excel.

For now, you'll explore the big picture by looking at how the Excel
window can be sized and moved. The details will come later.

1
2

Open Excel.

Use the Blank workbook template to open a new blank
workbook.

You learned how to do this in: Lesson 1-1: Start Excel and open a new
blank workbook.

Understand the Maximize, Minimize, Close and Restore
Down buttons

At the top right corner of the Excel window you'll see three
buttons.

Minimize, Maximize and Close buttons

QULIGCN Insert  Page Layout Formulas Data Review  View Q Tellme.. MikeSmart P)r.Share

% Calibri 1o == = =3 % %Condit\onal Formatting = El p

gy~ B I U~ A A == - 7] o

e - 55 & - - = Number (X4 Format as Table Cells  Editing

¥ |- DA E3xE - - [ Cell Styles - - .
Clipboard & Font ] Alignment ] Styles ~
Al \ f v

A E C D E F G H J -
1 I

The buttons that you see will depend upon how the Excel window
was left last time the application closed down. Normally the Excel
screen is maximized to fill the screen and you'll see:

Restore Down
Minimize Close

But if you had reduced the size of the Excel window so that it
didn’t fill the screen you’d see this instead:

Maximize

Minimize Close
- 0 X

Try clicking the Maximize, Minimize and Restore Down buttons.

B Maximize makes the Excel window completely fill the screen.
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Other ways to close
down Excel

There are two other ways of
closing Excel.

1. Click File on the Ribbon
and then Close on the left-
hand menu bar.

2. Press the <Alt>+<F4> keys
on your keyboard.

B Minimize reduces Excel to a button on the bottom task bar.

Click this button again to restore the window to its previous size.

B Restore Down makes the Excel window smaller, allowing you
to re-size the window.

Re-size the Excel window.

After clicking the Restore Down button you are able to re-size the
Excel window. Hover over either the side of the window, or a
corner of the window, with your mouse cursor. The cursor shape
will change to a double-headed arrow.

When you see either cursor shape, hold down the left mouse
button and move the mouse (this is called click and drag) to re-size
the window.

Clicking and dragging a corner allows you to change both the
height and width of the window.

Clicking an edge allows you to change only one dimension.
Move the Excel window.

Click and drag the Title Bar (the bar at the very top of the window)
to move the Excel window around the screen.

Bookl - Excel k

Formulas Data Review View 2 Tell me...

Close Excel.

Click on the Close button at the top right of the Excel window.
This is the most common way to close down Excel

There are also two lesser known (and lesser used) methods of
closing Excel (see sidebar).

Excel often provides many different ways to do exactly the same
thing.

© 2018 The Smart Method® Ltd
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important

Organizing your
sample files folder

When you complete a lesson
that involves a sample file that
is changed, you will be
instructed to save the file with a
suffix.

By the time you’ve completed
the course you'll have sample
files such as:

Sales-1
Sales-2
Sales-3
Sales-4 ... etc

The first file is the sample file
that you downloaded and the
others (with the number suffix)
are interim versions as you
complete each lesson.

The sample file set includes the
starting sample file and all
interim versions.

The interim versions are
provided for three reasons:

1. If your work-in-progress
becomes unusable (for example
after a system crash) you can
continue without starting at the
beginning again.

2. If alesson doesn’t seem to
give the results described, you
can view the example to get
some clues about what has
gone wrong.

3. When you have completed
the course you will use this
book as a reference. The
interim versions allow you to
work through any of the
lessons in isolation if you need
to remind yourself how to use a
specific Excel feature.

It is a good idea to place the
sample files in a different folder
to your saved work. If you
don’t do this you'll be over-
writing the sample interim files
(such as Sales-1, Sales-2 etc)
with your own finished work.

’/The Wealth of Nations |

Lesson 1-5: Download the
sample files and open/navigate
a workbook

Excel uses the analogy of a book that has many pages. In Excel
terminology, the term: Workbook is used for the entire book and Worksheet
for each of the pages. You'll be learning more about worksheets later in
this session in: Lesson 1-9: View, move, add, rename, delete and navigate
worksheet tabs.

1 Download the sample files (if you haven't already done so).

1.

Open your web browser and type in the URL:

https://thesmartmethod.com

Click the Sample Files link on the top right of the home page.

Download the sample files for Excel 2016 Basic Skills.

If you have any difficulty downloading the sample files there
is a FAQ section at the bottom of the page detailing solutions
to common problems.

2 Open the sample workbook: The Wealth of Nations.

1.
2.

Open Excel.

Click Open Other Workbooks on at the bottom of the left-hand

menu bar.

Click: Browse in the list beneath Open.

Navigate to your sample files. If you downloaded using the
recommended option and didn’t change the normal file
location, you will find these in the C:/Practice folder.

Open the Excel 2016 Basic Skills folder.

Open the Session 1 folder.

Double click
workbook.

The Wealth of Nations to open the sample

3 Goto Cell ZZ3 using the Name Box.

Name Box Active Cell Formula Bar
The Wealth Of Nations - Excz|
REIE Insert Pagelaout Formulas Data Review View @ Tellme. Mike Smart P+ Share
"D d Calibri -1 - = % %CDndionalFormattmg' E' o]
k- B I U- AF G . -
Paste 3 - AR Alignrment Number EForma = Table Cells  Editing
N e Dve A - - [Eicenstfes- - °
Clipboard Font " Styles A
B3 2 f Luxembourg v
A E C D -
1 |Rank Country GDP - per capita (PPP) Date of information
2 1 Qatar $137,200 2014 est.
3| 2fLuxembourg I397,600 2014 est.
4 3 Liechtenstein 489,400 2009 est.
5 4 Macau 588,700 2013 est. -
» GDP Life Expectancy Mobile | ... (#) [] »
Ready %3 ] |- 1 + 1008
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Potential problem
when downloading
sample files

Protected View is a security
feature that was first
introduced in Excel 2010. It is
designed to protect you from
potential viruses by treating all
files downloaded from the
Internet as being suspicious.

Any workbooks that are
downloaded from the Internet,
or are sent by e-mail
attachment, will open in
Protected View by default.

Be careful—
to edit, it's s

0 PROTECTED VIEW

The user then has to click an
Enable Editing button to use the
file as normal:

Enable Editing

While some users may find it
useful to be reminded about the
origin of their files, others may
find this feature annoying.

To avoid seeing this message
whenever you open a sample
file, we provide the sample files
as a digitally-signed self-
extracting download. This
means that the sample files will
open.

We also offer an alternative zip
file method to download (the
link to this page is in the FAQ
section at the bottom of the web
page).

The alternative zip file has been
provided because some
companies (or anti-virus
products) block the download
of executable files.

If you download using the zip

file option, you'll have to click

the Enable Editing button every
time you open a sample file for
the first time.

4
5
6

Excel uses the letter of the column and the number of the row to
identify cells. This is called the cell address. In the above example,
the cell address of the active cell is B3.

In Excel 2016 there are a little over a million rows and a little over
sixteen thousand columns. You may wonder how it is possible to
name these columns with only 26 letters in the alphabet.

When Excel runs out of letters it starts using two: X, Y, Z and then
AA, AB, AC etc. But even two letters are not enough. When Excel
reaches column ZZ it starts using three letters: ZX, ZY, ZZ and
then AAA, AAB, AAC etc.

The currently selected cell is called the Active Cell and has a green
line around it. The Active Cell’s address is always displayed in the
Name Box and its contents are displayed in the Formula Bar.

You can also use the Name Box to move to a specific cell.

To see this in action, type ZZ3 into the Name Box and then press the
<Enter> key. You are teleported to cell ZZ3:

773 - 5

zs Fa ) v v 2w pad v z
1
2
2|  NameBox

Active Cell ==> |

Formula Bar

Return to Cell A1 by pressing <CtrI>+<Home>.

Go to the end of the worksheet by pressing <Ctrl>+<End>.
Use the scroll bars.

There are two scroll bars for the Excel window.

The vertical scroll bar runs from top to bottom of the window and
allows you to quickly move up and down the worksheet.

The horizontal scroll bar is at the bottom right hand side of the
window and allows you to move to the left and right in wide
worksheets. Here’s how the scroll bars work:

Click here to scroll one

onal Formatting = = o screen up or down.
as Table ~ . i
- L [Hing, Click here to scroll ___
) one cell up or down.
Styles A
v
D E
2014 est.
2014 est.
2014 est.
2004 est. Click and drag this button to quickly
2014 est. move up and down the worksheet. -
2015 est. T If you need more speed, hold down
2014 est. the <Shift> key as you drag.
2014 est.
2014 est.
2014 est.
2014 est.
»
|- 1 + 100
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You can also use the <Ctrl>+<S>
keyboard shortcut to save your
work.

note

You can also use the <F12> key
to instantly display the Save As
dialog.

’/The Wealth of Nations |

Lesson 1-6: Save a workbook
to a local file

1 Open The Wealth of Nations from your sample files folder (if
it isn’t already open).

2  Save the workbook.

When you are editing a workbook, the changes you make are only
held in the computer’s memory. If there is a power cut or your
computer crashes, you will lose any work that has been done since
the last save.

For this reason, you should get into the habit of regularly saving
your work.

Even though you haven’t changed this workbook, save it by
clicking the Save button on the Quick Access Toolbar at the top left of
the screen.

Quick Access
Toolbar

Save Button

3 Save the workbook with a different name.

1. Click the File button. at the top-left of the screen.

2. Click: Save As in the left-hand list.

Browse
3. Click Browse in the Save As menu.

The following dialog will appear if you are using Windows 10. The
dialog may be slightly different for Windows 7 or 8 users but you
should easily be able to figure out the differences:

Save As X

P < Excel 2016 Basic... » Session 1 v & Search Session 1 p-]

Organize Mew folder

MName
7 Quick access
B Mary
Microsoft Excel B The Wealth Of Nations Copy

2% Dropbox < §

FIEL RN The Wealth Of Nations] ~

Save as type: | Excel Workbook ~

Authors:  MSmart Tags: Add atag

[] Save Thumbnail

~ Hide Folders Tools - Cancel
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OneDrive and Cloud
Computing

You may have noticed that the
Save As dialog also has an
option to save your workbook
to a OneDrive:

.ﬁ OneDrive

A OneDrive can be thought of
as a “disk drive in the sky”.

It is just like the C:\ drive on
your computer but exists on a
Microsoft server many miles
away, accessed via the Internet.

The OneDrive can be very
useful when you need to access
your files from several different
computers.

A OneDrive also provides an
easier way to share files with
others.

The OneDrive is part of a
completely new way of
working called Cloud
Computing.

Support for Cloud Computing
was first added in the Excel
2013 release.

Because Cloud Computing is
such an involved (and
complex) subject it is beyond
the scope of this Basic Skills
book.

The Essential Skills book in this

series devotes an entire session
to Cloud Computing (in Session
Eight: Cloud Computing).

File name: | The Wealth Of Mations Copy

Save as type: | Excel Workbook

1.

Click the drop-down arrow to the right of the Save as type
drop-down list.

File name: |TheWeaIth Of Nations V|

Save as type: | Excel Workbook ~

A list appears showing a large number of different file types:

The Wealth Of Mations

Excel Workbook

Excel Macro-Enabled Workbook
Excel Binary Workbook

Excel 97-2003 Workbook

CSV UTF-8 (Comma delimited)
XML Data

Single File Web Page

Web Page

Excel Template

Excel Macro-Enabled Ternplate
Excel 97-2003 Template

Text (Tab delimited]

Unicode Text

AML Spreadsheet 2003
Microsoft Excel 5.0/95 Workbook
C5V (Comma delimited)
Formatted Text (Space delimited)
Text (Macintosh)

Text (M5-DOSE)

5V (Macintosh)

C5V (MS-DOS)

DIF (Data Interchange Format)
SYLE (Symbolic Link)

Excel Add-in

Excel 97-2003 Add-in

PDF

XPS Document

Strict Open XML Spreadsheet
OpenDocument Spreadsheet

Most of the time you'll want to use the default format: Excel
Workbook but there may be times when you’ll need to save in
one of the other formats. You’'ll learn all about the most
important formats (and when you should use them) in the next
lesson: Lesson 1-7: Understand common file formats. For now,
you'll stay with the default: Excel Workbook format.

Click inside the File name box.
Type: The Wealth of Nations Copy
Click the Save button.

Notice that the name of the workbook in the title bar (at the
top of the window) has now changed indicating that you are
now viewing the new workbook that you have just saved.

= The Wealth Of Mations Copy - Excel

Insert Page Layout Formulas Data eview  View ©Q Tellme.. MikeSmart P+ Share

= X Calibri -l == Ef Geng - %Cond\tional Formatting = El o
p By~ B I U- A& = - M o s [ZFormat as Table -
aste s R

- ¥ |H-|O-A- |EE | $ G 7 Cell Styles -

Clipboard & Font ] Alignment Gl Number & Styles -~

Cells  Editing
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The Wealth Of Mations

Excel Workbook

Excel Macro-Enabled Workbook
Excel Binary Workbook

Excel 97-2003 Workbook

CSV UTF-28 (Comma delimited)
XML Data

Single File Web Page

Web Page

Excel Template

Excel Macro-Enabled Termnplate
Excel 97-2003 Template

Text (Tab delimited)

Unicode Text

ZML Spreadsheet 2003
Microsoft Excel 5.0/95 Workbook
SV (Comma delimited)
Formatted Text (Space delimited)
Teut (Macintosh)

Text (M5-DOS)

5V (Macintozh)

C5V (M5-DOS)

DIF (Data Interchange Format)
SYLK (Symbolic Link)

Excel Add-in

Excel 97-2003 Add-in

PDF

XP5 Document

Strict Open XML Spreadsheet
OpenDocument Spreadsheet

Lesson 1-7: Understand
common file formats

1 Open a new blank workbook.

You learned how to do this in: Lesson 1-1: Start Excel and open a new
blank workbook.

2 View the file formats supported by Excel.

1. Click the File button at the top-left of the screen.
2. Click: Save As in the left-hand list.
3. Click Browse in the Save As menu.
The Save As dialog appears.
4. Click the drop-down arrow to the right of the Save as type list.

File name: | Bockl -

Save as type: | Excel Workbook ~
Authors: Excel Workbook
PN | Excel Macro-Enabled Workbook

A list appears showing all of the different file formats

supported by Excel (see sidebar).

3 Understand the most important file formats.

Excel Workbook (the Open XML format)

Before Office 2007 was released, every program stored its information on
the hard disk in a completely different way. These incompatible formats
are called binary formats. This made it very difficult to write applications
that could be used together.

All of this changed with a new format that was first introduced in Office
2007: Office Open XML .

Excel Macro-Enabled Workbook

An Excel Macro-Enabled Workbook is simply a workbook that has
program code (called VBA code) embedded within it. Macros are beyond
the scope of this book but are covered in the Excel Expert Skills book in
this series.

While macro code is very powerful it can also be destructive as it is
extremely simple to write damaging viruses within Excel macro code.

Macro programming (also called VBA programming) is a vast subject of
its own and is not useful to the vast majority of Excel users. The Smart
Method® run comprehensive classroom Excel VBA courses but they are
usually only taken by scientists and engineers who need to add very
advanced functionality to Excel.

Versions of Excel before Excel 2007 could potentially allow a workbook
to infect your machine with a macro virus because all Excel files were
capable of carrying macros. Because the formats are now separate, it is
easier to avoid opening potentially infected files.
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Sharing files using
Cloud Computing
features

You should be aware that Excel
2016 provides another way to
share files with users that do
not have Excel 2016 (or, indeed,
any version of Excel) installed
upon their computer. This is
done using Excel 2016’s built in
Cloud Computing features.

Cloud Computing also allows
users to open (and even edit)
Excel workbooks using devices
such as iPads, Android pads,
Apple Macs and Smartphones.

Support for Cloud Computing
was originally introduced in
the Excel 2013 release.

Because Cloud Computing is
such an involved (and
complex) subject it is beyond
the scope of this Basic Skills
book.

The Essential Skills book in this

series devotes an entire session
to Cloud Computing (in Session
Eight: Cloud Computing).

Excel 97-2003 Workbook

This is the old binary format that allows users with earlier versions of
Excel to open your workbooks. Some features won’t work in earlier
versions and if you've used those in your workbook, Excel will display a
warning when you save telling you which features will be lost.

Excel Binary Workbook

An oddity in Excel is a binary format called: Excel Binary Workbook. This is
a binary alternative to Open XML but it can’t be read by earlier versions
of Excel. The advantages of this format are that it generally results in
smaller file sizes and loads and saves more quickly than Open XML. You
will only notice a speed difference when working with very large
worksheets.

The Excel Binary Workbook format may also present a security threat as
(just like the Excel Macro-Enabled Workbook format) it can contain macros
that could infect your machine with a macro virus.

PDF

If you need to send a worksheet to a user who does not own a copy of
Excel, you can save it in PDF (Portable Document Format). This format
was invented by Adobe and is also sometimes called Adobe Acrobat or
simply Acrobat.

All major web browsers can open and display PDF files. In Windows 10
PDF files will, by default, open using the new Edge browser. If you send
a user a PDF file you can be confident that they will be able to read and
print (but not change) the worksheet.

If you are reading this book as an e-book you are using a PDF file right
now, as all Smart Method e-books are published using the PDF file
format.

Other formats

As you can see, there are several other less commonly used formats
supported by Excel 2016 but the above formats are the only ones you'll
normally encounter. The most important thing to remember is that,
unless there’s a good reason to use a different format, you should always
save documents in the default Excel Workbook format.

© 2018 The Smart Method® Ltd
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tip

Reducing the number
of items, or hiding
items, in the recent

workbooks or recent
folders lists

Excel remembers the fifty most
recently opened workbooks
and folders.

As you open more documents
the fiftieth oldest is removed
from the Recent list unless you
pin it.

If you'd like to reduce the
number of workbooks or
folders that Excel keeps track
of, here’s how it’s done:

1. Click the File button at the
top left of the screen.

2. Click the Options button at
the bottom of the left-hand
menu bar.

3. Choose Advanced from the
left-hand menu bar.

4.  Scroll down the right-hand
list until you find the
Display category. You'll see
Show this number of Recent
Workbooks: 50 and Show this
number of unpinned Recent
Folders: 50.

-

Becent Workbooks: | 30 -

is number of Recent Workbooks:

unpinned Recent Folders: | 50

5. Change the number to the
number of recently opened
workbooks/folders you’'d
prefer Excel to remember.

If you set the value to zero,
Excel will not show any
entries in the list.

The Wealth of Nations

Lesson 1-8: Pin a workbook
and understand file
organization

1 Close down and restart Excel.
2 Pin a workbook to the Recent Workbooks list.

Notice that there is a list of recently opened documents at the top
of the left-hand menu bar.

The list begins with the most recently opened workbook (probably
the Wealth of Nations Copy workbook saved in: Lesson 1-6: Save a
workbook).

Recent

Today

The Wealth Of Nations Copy
C: » Practice » Excel 2016 Essential Skills » Session 1

The Wealth Of Nations
C: » Practice » Excel 2016 Essential Skills » Session 1

1. Hover the mouse cursor over one of the files in the Recent list:

The Wealth Of Nations
C: » Practice » Excel 2016 Essential Skills ...

Note that a pin icon H has appeared next to the workbook
name.

When you hover the mouse cursor over the pin a tooltip is
displayed saying: Pin this item to the list.

This can be a great time saver as it enables any workbook that
you use a lot to always be at the top of the Recent list. You
won’t have to waste time looking for it on the hard drive.

2. Click the pin icon. The item moves to the top of the list and the

pin icon changes from unpinned u to pinned. n
Recent

Pinned

The Wealth Of Nations
C: » Practice » Excel 2016 Essential Skills ...

Today

The Wealth Of Nations Copy
C: = Practice » Excel 2016 Essential Skills ...

3. Click on The Wealth of Nations to open the workbook.
3 Understand file organization.

By default, Excel saves all workbooks into your Documents folder
along with other Office documents (such as Word and PowerPoint
files). This clearly is going to cause problems when you have a few
hundred files.
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Folders

4 Excel
Accommaodation
Accounts
Bank Reconciliations
Bank Staternents
Book Publishing
Budgets
Business and employment
Cars and motorcycles
Credit Cards
Currency
Diet
Inflation Figures RPT RPIX
Insurance
Miscellaneous
Personal
Recipes
Stationery Orders
Taxes
Training

Travel

Tutorials

note

How do | create a
subfolder?

The concept of folders,
subfolders and files is a very
fundamental Windows skill
rather than an Excel skill.

If you do not have basic
Windows skills (an
understanding of how
Windows organizes files) you
would get good value from a
Windows book to give you the
foundation skills you need to
use any Windows program.

Here’s how you create a new
subfolder:

1. Right-click on the Documents
folder.

2. Click: New—>Folder, from the
shortcut menu.

A new folder will appear called
New Folder.

3. You will now be able to type:
Excel in order to name the
folder.

If this doesn’t work for you,
right-click the new folder and
select Rename from the shortcut
menu. You'll then be able to
type: Excel to rename the
folder.

It is better to organize yourself from the start by setting up an
orderly filing system.

Create an Excel subfolder beneath your Documents folder.

I create a folder called Excel beneath the Documents folder. In this
folder, I create subfolders to store my work. You can see a screen
grab of my Excel folder in the sidebar (of course, your needs will
be different to mine).

See sidebar if you don’t know how to create a subfolder.
Set the default file location to point to the new Excel folder.

If you take my advice and create an Excel folder, you will waste a
mouse click every time you open a file because Excel will take you
to the Documents folder by default.

Here’s how to reset the default file location to your new Excel
folder:

1. Open Excel and click the Blank Workbook template to open a
new blank workbook.

2. Click the File button at the top left of the screen.

3. Click the Options button towards the bottom of the left-hand
list.

The Excel Options dialog appears.
4. Choose the Save category from the left-hand side of the dialog.

During the remainder of the book I'll explain the above three
steps like this:

Click: File>Options—>Save.
This will save a lot of time and forests!
5. Change the Default local file location.

Type: \Excel after the end of the current Default local file
location.

You have to actually type this manually. Microsoft seem to
have forgotten to add a browse button!

Excel Options
General _ .
Customize how workbooks are saved.
Formulas
Proofing Save workbooks
Save Save files in this format: Excel Workbook w
Language Save AutoRecover information every |10 | minutes
Advanced Keep |ast autosaved version if | close without saving

Customize Ribbon AutoRecover file ion: C:\Users\MSmart\AppDataiRoaming\M
[ Don't show the Ba ge when opening or saving files
Show additional places

Add-ins [ Saveto Computer by defau

Quick Access Toolbar . o .
ving, even if sign-in may be required.

Trust Center Default local file location: C:\Users\MSmart\Documents\Excel

Default personal templates location:

When you click File>Open->Browse in future you'll
automatically be taken to your Excel folder ready to choose a
category.

© 2018 The Smart Method® Ltd
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Changing the default
number of
worksheets created in
new workbooks

When you open a new blank
workbook in Excel 2016, one
new worksheet is automatically
created called Sheet1.

In older versions of Excel (Excel
2010 and earlier), three
worksheets were created called
Sheet1, Sheet2 and Sheet3.

This is a change for the better
as it keeps things neater. Most
of my workbooks only need
one worksheet.

But if you long for the “good

old days” here’s how you can
make Excel 2016 mimic Excel
2010 (and earlier versions) at

start-up:

1. Click:

File->Options>General>
When creating new workbooks
~Include this many sheets:

2. Enter the number of sheets
required:

Include this many sheets: 3

]

’/The Wealth of Nations |

Lesson 1-9: View, move, add,
rename, delete and navigate
worksheet tabs

When you save an Excel file onto your hard disk, you are saving a single
workbook containing one or more worksheets. You can add as many
worksheets as you need to a workbook.

There are two types of worksheet. Regular worksheets contain cells. Chart
sheets, as you would expect, each contain a single chart. If you progress
to the Essential Skills course in this series you'll exploring charts in depth.

1 Open The Wealth of Nations from your sample files folder (if
it isn’t already open).

2  Move between worksheets.
Look at the tabs in the bottom left corner of your screen. Notice

that this sample workbook contains three worksheets. Click on
each tab in turn to view each worksheet.

‘ GDP | Life Expectancy Mabile Phanes ()

3 Add a new worksheet and name it: Population
1. Click the New Sheet button (the circle with a plus sign inside it
next to Mobile Phones). A new tab appears named Sheet1.
2. Double-click the Sheet1 tab.
3. Type the word Population followed by the <Enter> key.

=

‘ GDP Population Life Expectancy Mobile Phones (O]

4 Move a worksheet's tab.
1. Click on the Population tab (you may have to do this twice).

2. Hold the mouse button down and drag to the left or right. As
you drag you'll notice an icon of a page and a black arrow
showing you where the tab will be placed.

3. Release the mouse button to move the tab to the location of
your choice.

GDP Population Life Expectancy M%ile Phones ®

5 Understand the tab scroll buttons.

Left Click
Left one tab
Right one tab

i
4 4

l <Ctrl> +Left Click

Scroll to last tab
Scroll to first tab
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Because this workbook only has four tabs, there’s no need to use
the tab scroll buttons (in fact, they don’t do anything and are
grayed out when all tabs are visible).

When there are more tabs than will fit on the screen the tab scroll
buttons are used to move between tabs.

Move between worksheets using the keyboard.

You can move between worksheets using only the keyboard by
pressing the <Ctrl>+<PgUp> and <Ctrl>+<PgDn> keyboard
shortcuts to cycle through all the tabs in your workbook.

Change tab colors.

1. Right-click on any of the tabs and choose Tab Color from the
shortcut menu.

2. Choose any color.

It is best practice to choose a color from the top block of Theme
Colors rather than one of the Standard Colors.

If you later progress to the Essential Skills course in this series
you'll learn to use Themes and will then understand why the
use of theme colors is best practice.

3. Repeat for the other tabs on the worksheet.
Delete a worksheet.

Right click on the Population tab and click Delete from the shortcut
menu.

Delete several worksheets at the same time.
1. Hold down the <Ctrl> key.

2. Click each tab that you want to delete in turn. Don’t select
them all as it isn’t possible to delete every worksheet in a
workbook.

3. Right click any of the selected tabs and select Delete from the
shortcut menu.

Don’t worry about the missing tabs. You're going to close the
workbook without saving it so you won’t overwrite the original
workbook.

Close the workbook without saving it.
1. Click: File>Close.
A dialog is displayed:

Microsoft Excel X

I ‘Want to save your changes to ‘The Wealth Of
Nations.xlsx'?

Don't Save Cancel

2. Click Don’t Save so that you don’t over-write the workbook.

Because you haven’t saved the workbook it will remain in its
original state when you next open it.

© 2018 The Smart Method® Ltd
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note

The versions feature
will not protect you
from a hard drive
failure

Carnegie Melon University
conducted a study of 100,000
hard drives in 2007. They
found that there’s a probability
of between 1 in 50 and 1 in 25
of your hard drive failing each
year.

In an office of 100 workers that
means that between two and
four unlucky workers will
suffer a hard drive failure every
year.

To insure against drive failure,
you need to back up your data
to a different hard drive (or
other media).

If your computer is part of an
office network, the normal
solution is to save your files to
a shared network drive. The IT
department are then
responsible for backing this up
every night.

For home users (or small
companies that only have one
computer) you should back up
all of your data to an external
hard drive (or a memory stick if
your files are not very large).

Cloud computing offers an
even better solution to prevent
potential file loss after hard
drive failure.

If you progress to the Essential
Skills book in this series you'll
learn how to use a OneDrive to
store a workbook in the cloud.

Lesson 1-10: Use the Versions
feature to recover an unsaved
Draft file

Excel 2010 introduced a major new feature called Versions. The Versions
feature is fantastically useful as it finally solves two common problems
that are as old as computing itself:

1.

Your computer crashes, there’s a power cut, or you close your work
without saving, and then discover that you've lost all of your work
since the last save.

You delete parts of your workbook and then save, only to realize that
you deleted something important before saving. Because saving
over-writes the old version of the file, you find that you've lost the
deleted work forever.

Microsoft has finally figured out how to solve both problems. The
Versions feature works like this:

1.

Every so often Excel saves a backup of your workbook (called a
Version) for you. The default time interval for these automatic
backups is every 10 minutes (but you can change this to any interval).
You'll see the Versions feature at work in the next lesson: Lesson 1-11:
Use the Versions feature to recover an earlier version of a workbook.

If you create a new workbook and then close it without saving, Excel
will still keep the last automatic backup it made. Excel calls this a
Draft version. Draft versions are automatically deleted after four
days. The Draft feature is the subject of this lesson.

You’'ll need a watch or clock with a second hand for this lesson.

1

Open a new blank workbook.

You learned how to do this in: Lesson 1-1: Start Excel and open a new
blank workbook.

Set the AutoSave interval to one minute and check that
AutoSave features are enabled

1. Click: File>Options—>Save.
2. Change the Save AutoRecover information every box to 1 minute.

3. Make sure that the other options are set in the same way as in
this screen grab (the two check boxes will already be checked
unless another user has changed them):

Save workbooks
Save files in this format: Excel Workbook EI
| Save AutoRecover information every |1 | minutes

| Keep the last autosaved version if I close without saving

4. Click: OK and check the time on your clock or watch. The first
AutoSave will happen one minute from now!
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note

RAID arrays are a
special super-reliable
type of disk drive

Many years ago, I implemented
an EDM (electronic document
management system) for the
world’s largest car
manufacturer.

It would have been a disaster
for them to lose even one
hours” work, so I specified a
special drive called a RAID
Array (Redundant Array of
Independent Disks) to store the
documents.

The simplest RAID array
consists of two hard drives and
automatically writes all data to
both drives (this is called
mirroring). If one drive fails,
the other will still have the data
meaning that any data loss is
very unlikely.

RAID arrays don't stop
workflow for even a moment.
If a disk fails, the users don’t
even notice as data continues to
be available from the other disk
(or disks).

When the faulty disk drive is
replaced, the files automatically
restore themselves from the
good disk (or disks) restoring
the reliability of the array.

note

The Versions feature
isn’t just for Excel

Microsoft has also included the
Versions feature in Word and
PowerlPoint.

Now that you've learned how
to use it in Excel, you should be
able to figure out the small
differences in the way it is
implemented in the other
Office applications.

Type the following into cells Al and A2, pressing the <Enter>
key after each line:

A B C
1 |Mary had a little lamb
2 lIts fleece was white as snow
3

Wait for at least one minute. (After one minute Excel will
automatically save your workbook).

After a little over a minute try to close the workbook. The
following dialog should appear:

Microsoft Excel ®
1 ‘Want to save your changes to 'Book1'?
H

If you click "Don't Save’, a recent copy of this file will be temporarily available.
Learn more

Don't Save Cancel

Excel is telling you that it has already saved a draft copy of the
workbook.

Click the Don’t Save button.

Even though you told Excel not to save, a draft copy has been
secretly saved just in case you made a mistake and may need
the file later.

Recover the draft document.

1.
2.
3.

Open Excel.
Click: Open Other Workbooks at the bottom of the menu bar.
Click: Recover Unsaved Workbooks.

You'll find this at the bottom center of the screen (you may
need to scroll down).

Recover Unsaved Workbooks |

A dialog appears showing the unsaved document that you
were working on:

Mame Date madified

8. Bookl({{Unsaved-306056443257458486))  20/07/2017 11:38

Double-click the document to open it.

The document is now shown on screen (even though you have
never saved it).

Recover the unsaved file.

Click the Save As button in the top information bar.

RECOVERED UMSAVED FILE This is a recovered file that is temporarily stored on your computer, Save As

M17 b e

A B C D E F G H
1 |Mary had a little lamb
2 |Its fleece was white as snow

Save the file in your sample files folder with the name: Mary.

© 2018 The Smart Method® Ltd
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Lesson 1-11: Use the Versions
feature to recover an earlier
version of a workbook

Excel’s ability to automatically backup your document at a chosen time
interval was explored in the previous lesson: Lesson 1-10: Use the Versions
feature to recover an unsaved Draft file.

This lesson will show you how to view the automatic backups and to
revert to an earlier version if you've messed up the current version.

You can even cut-and-paste sections from older versions of a workbook
and paste them into the current version.

You’ll need a watch or clock with a second hand for this lesson.

1 Open Mary from your sample files folder (if it isn’t already
open).

2 Cause Excel to automatically save a different version of the
workbook.

important

In the last lesson: Lesson 1-10: Use the Versions feature to recover an
unsaved Draft file, you set the time interval for automatic backups to
1 minute. If you are not completing this course sequentially, you

Version files don’t
stay around forever

As discussed in: Lesson 1-10:
Use the Versions feature to recover
an unsaved Draft file, draft
versions of unsaved files are
kept for four days.

But what about the regular
Version backups that Excel
makes? Obviously, Excel
would fill up your hard drive
with version files if it didn’t
have a mechanism for
automatically deleting them.

Excel uses two rules when
deciding whether version files
are still useful.

1/ While you are in the current

editing session, version files are 3

never deleted (even if you save
the current version).

2/ When you close the
workbook all version files are
deleted unless you close
without saving. If you close
without saving only the last
version is retained (as a draft
version).

™

will need to go back to this lesson and make sure that this setting is
set to 1 minute.

Add the following text to cells A4 and A5, pressing the <Enter>
key after each line:

A B C D
Mary had a little lamb
Its fleece was white as snow

and everywhere that Mary went
The lamb was sure to go

[= T ¥, R SR T B N

Look at your watch or clock and wait for a little over one minute.
Excel should have automatically saved a new version of the
workbook.

Make sure that Excel AutoSaved the new version.

Some users have reported that Excel sometimes takes as long as
ten minutes to AutoSave a file (even when the AutoSave interval is
set to one minute). Here’s how to check that it performed as it
should:

1. Click the File button.

You should see an AutoSave file version alongside the Manage
Workbook button.

’_L‘ Manage Workbook

Check out document or recover unsaved changes,
Manage

Workbook ~ £ Today, 11:36 (autorecovery)
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A B C
Mary had a little lamb
Its fleece was white as snow

and everywhere that Mary went
The lamb was sure to go

It followed her to school one day
It was against the rules

o = Wk WP =

If you don’t see the AutoSave version, click the Back button

wait another minute and then click the File tab again. Don’t move
on to the next step until it has appeared.

Further modify the file and then save it.

1. Add the following text to cells A7 and A8 pressing the <Enter>
key after each line:

A E C
7 |It followed her to school one day
8 |Itwas against the rules

2.  Save the workbook.

View the earlier version that Excel automatically saved.

1. Click the File button.

2. Click the earlier AutoSaved version.

B3 Today, 11:36 (autorecovery)

The earlier version opens in Excel.

AUTOSAVED

VERSION A newer version is available. Restare

G15 - e

A B C D E F
Mary had a little lamb
Its fleece was white as snow

and everywhere that Mary went
The lamb was sure to go

BN T N TE R R

Notice that Excel advises that there is a later version of your
workbook available should you need to go back to the version
that you have just replaced.

AUTORECOVERED VERSIOMN A newer version is available. Restore

Notice also that it would be possible to copy and paste sections
from the older version into the newer version if you needed to
do that.

Replace the current version of the workbook with the earlier
AutoSaved version.

1. Click the Restore button on the top information bar.
2. Click the OK button to confirm.
Reset the AutoSave interval to 10 minutes.

You learned how to do this in: Lesson 1-10: Use the Versions feature
to recover an unsaved Draft file.

© 2018 The Smart Method® Ltd

39



Learn Excel 2016 Basic Skills with The Smart Method

important

The Ribbon shows
more if you have a
wider screen

When I work with Excel I use a
32-inch monitor running at
2,560X1,440 pixels.

Excel uses all of the available
screen space to display
extended descriptions of each
feature on the Ribbon.

For example, the Styles pane on
the Home Ribbon shows ten
buttons for common cell styles
allowing them to be applied
with a single click rather than
two clicks.

Lesson 1-12: Use the Ribbon

The Ribbon provides fast access to hundreds of Excel features.

The sheer breadth of Excel features can seem overwhelming. This book
will gently introduce all of the most important features, one at a time.

By the end of the book you’ll be really comfortable and productive with
the Ribbon.

1 Start Excel and open a new blank workbook.

You learned how to do this in: Lesson 1-1: Start Excel and open a new
blank workbook.

2  Use Ribbon tabs.

Each Ribbon tab has its own toolkit available to you. By far the
most important tab is the Home tab which has buttons for all of the
most common and useful features.

Click each tab in turn and view the buttons. The screen grab below
has the Insert tab selected. Don’t worry if the buttons seem cryptic
at the moment. Most of them will make complete sense by the end
of this book. (And if you later go on to complete the Expert Skills
course, Excel will have no mysteries left at all)!

Quick Access Toolbar Ribbon

Page Layout

Formu'as

] = -] (RN SRR | 1 AT ] = == fisn] O
B B9 aw T IS EEE IO
: 2 ° M i v . . . - - 2
PivotTable Recommended Table llustrations o’ My Add-ins - E Recommended ) I PivotChart 3D Line Colwgpn Win/ Slicer Timeline Hyperlink Text  Symbols

PivotTables - Charts L AA T - Map = Loss - -
Tables Add-ins Charts o Tours Sparklines Filters Links ~
Al g F v
A E i D F G H | J K L M N o] [ Q -~

Ribbon Tabs Title Bar Formula Bar

Book1 - Excel

Mike Smart £, Share

Data Review View Q Tell me what you want to do..

3 Type the word Test into any blank cell and then press the
<Enter> key on the keyboard once.

Notice how the active cell moves to the cell beneath.

A B
1
Test

3 |

4 Make the cell with the word Test into the active cell.

Click once on the word Test or use the arrow keys on the keyboard
to navigate back to the cell. Be very careful not to double-click,
otherwise Excel will think that you want to edit the cell.

A B
1

2 | |Test _l

) Click the Home tab on the Ribbon and focus upon the Font
command group (it's the second panel from the left). Try
clicking each of the buttons and you will see the word Test
change to reflect your choices.
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important

If your Ribbon doesn’t
look like the
illustrations in this
book

If you have Excel 2016 (the one-
time purchase version) rather
than an Excel 365 subscription,
your Ribbon may have less (or
different) commands than are
found in the latest (Excel 365)
version.

The Ribbon will also look
different depending upon the
size of your screen (see
important sidebar on previous
page).

Excel 2016 also allows you to
customize the Ribbon.

Customizing the Ribbon is an
expert-level skill covered in the
Expert Skills book in this series.

If another user has been
playing with this feature, they
may have rendered Excel
unusable!

If you suspect this to be the
case, you can put things back to
normal like this:

1. Right-click in a blank area
of the Ribbon.

2. Click: Customize the
Ribbon... from the shortcut
menu.

3. Click: Customizations—>
Reset>
Reset all customizations.

| Forjt [F}
Click here once to make the

text Bold, Italic or Underlined
(or all three). Click again to
restore it to Normal.

This drop-down arrow allows
you to add a double underline.

This drop-down allows you
to change the size of the
font (measured in points).

This drop-down allows you to
change the font to something
different to the default Calibri.

T A A These buttons allow you to
& A- change the cell's background
and text color.

Calibri

w

~
=

B

Clicking here puts a single
underline along the entire
length of the bottom of the
cell. Try the drop-down arrow
too for more border options.

Reset + i

Reset all customizations %

4. Click: Yes.

Minimize the Ribbon.

1. Double-click any of the Ribbon tabs except the File tab (for
example the Home tab or the Insert tab).

Notice how the Ribbon is now minimized in order to save
screen space (though the Formula Bar is still visible).

= :

File Home Insert Page Layout Farmulas

2. Click once on any tab, except the File tab, to temporarily bring
the Ribbon back to full size.

Notice that as soon as you click back onto the worksheet the
Ribbon is minimized again.

Bring back the Ribbon.

Double-click on any tab except the File tab to permanently bring
back the Ribbon.

Close Excel without saving changes.

1. Click: File->Close or click the cross I:' in the top right corner.

2. When asked if you want to save your changes, click the Don’t
Save button.

© 2018 The Smart Method® Ltd
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Lesson 1-13: Understand
Ribbon components

The whole is more than the sum of its parts.
Aristotle, Greek critic, philosopher, physicist & zoologist
(384 BC - 322 BC)

The Ribbon is made up of several different controls.

Command group

General -
. Similar actions are grouped into a cluster. For example, every control
. !

Y. 0 .00 i . .
% o =0 relating to numbers is clustered into the Number group.

0

Mumber T

g | Normal button

Simply executes a command when clicked. The Bold button on the Home
tab is a good example.

0 Menu button

This type of button has a little down-arrow on it. It will display a list,
Insert menu or rich menu drop-down when clicked.

u -| Split button

This is the hardest button to understand because these buttons look
almost the same as the Menu button. When you hover the mouse cursor
over a split button, the icon and drop-down arrow highlight separately as
different “buttons within a button”.

A good example is the underline button on the Home toolbar.

Clicking the icon part of a split button (the U) will perform the default

1 action of the button (in this case a single underline). Clicking the arrow

D Double Underline part of the button will display a drop-down list of further choices (in this
* case the choice between a single and double underline).

U LUnderline

%D E}( = S ) Drop-down list
Insert Delete Farmat Fill 1 often shorten this' to simply ”Der—Down” in this book. A drop-down is
- - - ¢ (I asimple menu listing several choices.

£ |nsert Cells... If you see an ellipsis (...) after a drop-down list item, this means that a

- dialog will be displayed after you click, offering further choices.
€= Insert Sheet Rows

R |nsert Sheet Columns

1 Rich menu
Q Inzert Sheet

The rich menu is a drop-down list with added help text explaining what
each item will do.
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Freeze
Panes

&2
£
g5

Freeze Panes
Keep rows and columns visible while the rest of

the worksheet scrolls (based on current selection).

Freeze Top Row

Keep the top row visible while scrolling through
the rest of the worksheet.

Freeze First Column

Keep the first column visible while scrolling
through the rest of the worksheet

Gridlines
| View

Print

Drop-down gallery

This rich menu can be found at:
View>Window—>Freeze Panes

The Freeze Panes feature is not
covered in this Basic Skills book
but is covered in-depth in the
Essential Skills book in this series
(in: Lesson 3-19: Freeze Columns
and Rows).

This is a little like a drop-down list but has graphics to visually
demonstrate the effect of each choice.

=

Cell
Styles -,
Good, Bad and Neutral
MNormal Bad Good
Data and Model
||| | explanatory ...

Output Warning Text

Neutra

Note

Check box

A little square box that you can click to switch an option on or off.

In this example (from the Page Layout Ribbon tab) you are able to switch
the gridlines on and off for the screen display and/or the printout.

Dialog launcher

Dialog launchers appear on the bottom right-hand corner of some
command groups. Dialogs offer more choices than it is possible for the

Ribbon to express graphically.

General -
= &0 .00
~ 09 T Y

Mumber

m— -

Dialog Launcher

© 2018 The Smart Method® Ltd
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note

There are many more
commands available
in Excel 365 than
there are in Excel
2016

In this lesson, I have shown
screen grabs from the Excel
2016 Quick Access Toolbar, but
Excel 365 users (who have
touchscreen devices) may
notice an extra button (included
on the quick access toolbar by
default):

The Touch/Mouse Mode

button E

The new button adds more
space between commands to
make Excel easier to use with a
touch screen.

With the increasing availability
of touch screen computers
running Windows 10, this is a
very useful new Excel 365
feature if you use this type of
device.

If you are using Excel 2016 (the
pay once, use forever version of
Excel) you will not be able to
use this feature.

Customize Quick
Access Toolbar
Button

H =

Home Insert

’/The Wealth of Nations |

Lesson 1-14: Customize the
Quick Access Toolbar and
preview the printout

You can customize the Quick Access Toolbar to suit your own special
requirements. In this lesson, you'll add some useful buttons to the Quick
Access Toolbar to save a few clicks when accessing common commands.

The Quick Access Toolbar is one of the keys to being really productive with
Excel. This lesson will introduce you to the main features.

Open The Wealth of Nations from your sample files folder.

Preview how the Life Expectancy worksheet will look when
printed.

1. Click the Life Expectancy tab at the bottom of the worksheet.
2. Click: File->Print.
Backstage View is displayed.

Backstage view displays a huge number of print-related
features. A preview of how the page will look when it is
printed is displayed on the right-hand side of the screen.

3. Click the Next Page and Previous Page buttons to move through
the print preview.

Notice there’s a button to the bottom-left of the preview pane
that allows you to cycle through each page:

47 United States 78.14 2008 est.

48 Denmark 75.13 200 est.

43 |reland 75.07 2008 est.
Previous Page Zoom
Z \\ -
1 |ors »€=Next Page BE

4. Use the Zoom button to magnify the page for a clearer view.
(You may not notice much of a zoom if you have a large
screen).

5. Click the Back button at the top left of Backstage View to
return to the workbook.

3 Add a Print Preview button to the Quick Access Toolbar.

The quick Print Preview offered by the Backstage View is a very
useful feature and you'll probably use it a lot. Every time you use
it, however, it is going to take two clicks of the mouse. Wouldn't it
be better if you could show a print preview with just one click?

1. Click the Customize Quick Access Toolbar button (see sidebar).
2. Click the Print Preview and Print item in the drop-down list.

A new button appears on the Quick Access Toolbar. You are
now able to Print Preview your work with a single click of the
mouse.

44

https://TheSmartMethod.com



Session One: Basic Skills

note

Some amazing
“hidden” Excel
features cannot be
used at all without
customizing the

Quick Access Toolbar

or the Ribbon

One of my favourite “hidden”

features in Excel 2016 is its

ability to read the workbook to

me via its Text fo Voice facility.

When I need to input lots of

numbers from a sheet of paper

and want to check them, I get
Excel to read them to me as I
tick each off my list. This is
much faster and nicer than

continuously looking first at the

screen, then at the paper, for
each entry.

This feature is covered in depth

in the Expert Skills book in this

series.

You can’t use this feature at all

unless you either add some
custom buttons to the Quick
Access Toolbar or customize
the Ribbon.

tip
The Quick Access Toolbar is

one of the keys to being really
productive with Excel 2016.

Always try to minimize the

number of mouse clicks needed

to do common tasks.

If you find yourself forever
changing tabs to use a button,
change two clicks into one by

adding the button to the Quick

Access Toolbar.

All of those extra clicks add up

to a lot of time over the weeks
and years.

H @ -

Home

Insert Page Layout

Add a Font Color button to the Quick Access Toolbar.

A More Commands... option is available when you click the
Customize Quick Access Toolbar button. This enables you to add any
of Excel’s commands to the toolbar. But there’s an easier way!

1. Click the Home tab on the Ribbon (if it isn’t already selected).

2. Right-click on the Font Color button in the Font group.

A-l=== B .| =2,

Add to Quick Access Toolbar

%

‘Customize Quick Access Toolbar...

= 3= % s | <8

Show Quick Access Toolbar Below the Ribbon

Customize the Ribbon...

Collapse the Ribbon

3. Click Add to Quick Access Toolbar from the shortcut menu.
A Font Color button is added to the Quick Access Toolbar.

= @ A- -

Home Page Layout

Insert

Remove a button from the Quick Access Toolbar.

1. Right-click on the Font Color button that you’ve just added to
A -

the Quick Access Toolbar.

2. Click Remove from Quick Access Toolbar from the shortcut menu.

Add separators to make a heavily customized Quick Access
Toolbar more readable.

When you add many items to the Quick Access Toolbar it is a good
idea to use separators to split icons into logical groups.

1. Click the Customize Quick Access Toolbar button. E

2. Click More Commands... from the shortcut menu.

3. Click the item at the top of the Commands list.
4. Click the Add>> button.

5. Use the up I:l and down IZI buttons to move the
separator to the required location.

6. Click the OK button.

Here’s a screen grab of my own Quick Access Toolbar. I've added
buttons for all of the features I use most often. This means that I
can always access these features with a single click of the mouse:

H B & ™
Home Insert Page Layout

Formulas

Data

v 2 i TrT S
tN Separators /

B B 0 % 9+ W 8 s

Review e what you want to do
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note

Keyboard shortcuts
are one of the secrets
of maximizing
productivity with
Excel

Many years ago, I took my
mouse and stuck it to the back
of my monitor with sticky tape.

For a whole day, I struggled to
work without it.

The first few hours weren’t
much fun, but after that my
work became faster and faster.
It became a challenge to figure
out how to do things without
the mouse.

You will be far more
productive if you can get into
the same habit.

These days, there are some
things that you simply need the
mouse for, and some things
that are genuinely faster (or
easier) with the mouse.

For many common tasks,
however, you'll find it faster
and more efficient to work with
the keyboard.

’/The Wealth of Nations |

Lesson 1-15: Use the Mini
Toolbar, Key Tips and
keyboard shortcuts

1

2

Open the Wealth of Nations sample worksheet (if it isn’t
already open).

Select cell B2 (Qatar) on the GDP worksheet.
1. Click on the GDP tab.
2. Click on cell B2 (Qatar).

Make sure that you only click once, otherwise Excel will think
that you are trying to edit the cell.

A B C
1 |Rank Country GDP - per capita (PPP)
2|  1fqatar |$137,200

Make cell B2 (Qatar) bold, italicized and underlined.
1. Click: Home->Font->Bold.

2. Click: Home->Font->Italic.

3. Click: Home->Font->Underline.

A B C
1 |Rank Country GDP - per capita (PPP)
2| 1]qatar [$137,200
Display Key Tips.

Hold down the <Alt> key on the keyboard.

Notice how Key Tips are now displayed on the Ribbon and the
Quick Access Toolbar:

— A - =
BB a
Home Insert Page Layout Formulas
! b
b Cut Calibri e KA
ER Copy ~
Paste = L. - -
- ¥ Format Painter B Il - & L
Clipboard IF} Fant IF}

Use the Key Tips to show a print preview using only the
keyboard.

The key tips reveal the key you need to press to simulate clicking
any of the Ribbon and Quick Access Toolbar icons.

Hold down the <Alt> key and press the relevant number to show a
print preview (in the above example this is 4).

NB: Your toolbar, and the number you need to press, may look
different to the screen grab above. Note that the print preview
button will not be on the Quick Access Toolbar unless you added it
during: Lesson 1-14: Customize the Quick Access Toolbar and preview
the printout.
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note

If you don’t like the
Mini Toolbar you can
switch it off

Personally, I really like the mini
toolbar and wouldn’t dream of
switching it off but if you are
used to an early version of
Excel and find that it annoys
you, here is how it’s done:

1. Click:
File->Options->General

2. In the User Interface options
section, uncheck the Show
Mini Toolbar on selection
item.

3. Click the OK button.

note

The shortcut menu

If you right-click on a cell, a
shortcut menu is displayed.

The shortcut menu doesn’t
display everything that you can
do to a cell but Excel’s best
guesses at the most likely things
you might want to do.

Because Excel is guessing at the
actions you might want to take
in the context of what you are
doing, the shortcut menu is also
sometimes referred to as the
contextual menu.

B [
Country Calibri ~[11 ~| g A" CO7~ 05 » E
Qatar BT =&~ A0
Luxembourg I,,W,JW
Bermuda ¥ cu
Jersey o
Malta 2 Copy

Font ]
Underline (Ctrl+U)

Underline your text.

7

11

Click the Back button to leave Backstage View and
return to the worksheet.

Use the mouse to select the text Qatar in cell B2.
1. Double-click the cell containing the text.

You'll see the cursor flashing in the cell. This means that you

have entered Edit Mode, enabling you to change the contents of

the cell

2. Position the cursor just after the word Qatar and hold down
the left mouse button.

3. Drag the mouse across the complete word until it is
highlighted like this:

4. Release the mouse button but do not move it away from the
text.

Observe the Mini Toolbar.

Provided you didn’t move the mouse cursor away from cell B2 you

will now see the mini toolbar above the cell:

—_— =~ i Qatar
Calibri 11 -

B I A-A a

....... B
[qatar |

Use the Mini Toolbar to restore the text to non-bold and non-

italic.

Click on the Bold and Italic buttons to remove the bold

and italic attributes from the text.

Qatar

Show a bigger Mini Toolbar with a right-click.

Right-click on Bermuda (Cell B6). Notice that, as well as the
shortcut menu (see sidebar), you now get an even better Mini
Toolbar with a few extra buttons.

Remove the underline from Qatar using a shortcut key.
1. Click once on Qatar (cell B2).

2. Press the <Ctrl>+<U> keys on the keyboard to remove the
underline.

But how can you remember cryptic keyboard shortcuts like
<Ctrl>+<U>? Fortunately, ﬁou don’t have to. Hover the mouse

over the underline button (on the Home tab of the Ribbon)
and you’ll see the keyboard shortcut listed in the tooltip.

© 2018 The Smart Method® Ltd
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Lesson 1-16: Understand
views

Views provide different ways to look at your worksheet.

Excel 2016 has three main views. They are:

View

Normal

‘ Icon

H

What it is used for ‘

This is the view you’ve been using until
now. It’s the view most users use all of the
time when they are working with Excel.

Page Layout

This view allows you to see (almost) exactly
what the printout will look like.

Unlike running a Print Preview, you are able
to edit cells just as you can in Normal view.

Page Break
Preview

A page break indicates when the printer
should advance onto a new sheet of paper.

If you progress to the Essential Skills course
in this series, you'll use this view in: Lesson
7 5: Insert, delete and preview page breaks, to
make sure that the page breaks in the right
place.

Open the Wealth of Nations sample workbook (if it isn’t

already open).

B ©- 53 The Wesith Of Nations - Excel m - 0O X
Home | Inset  Pagelayout  Formulss  Data  Review  View @ Tellme.. Mike Smart
e X |Calibri 11 - === B (Genel - [ ConditionalFormattings EFlnsert - X v 4r-
— By~ B I U- Aa ===E- F-9% » [FromatasTable- EXDelete - [ P~
LW e DA~ == H- e [7 Cell Styles - (&9 Format ~

Clip

B2

1
2
3
4
5
6
7

board Font N Alignment G Number Styles Cells Editing

|| Qatar

A
Rank Country

B C D

GDP - per capita (PPP) Date of information

1[qatar |3137,200 2014 est.
2 Luxembourg $97,600 2014 est.
3 Liechtenstein 389,400 2009 est.
4 Macau 388,700 2013 est.
5 Bermuda $85,700 2013 est.
6 Isle of Man 383,100 2007 est. -

GDP

Life Expectancy Mobile Phones 4

H M -————+ 100

View Buttons

You can change views in two ways:

1.

By clicking one of the View buttons at the bottom of the
window (see above).

By clicking one of the buttons in the Workbook Views group on
the Ribbon'’s View tab (see below).

i [ENEE

Mormal Page Break Page Customn

Preview Layout Views
Workbook Views

The Wealth of Nations
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ElENE =

Maormal Page Break Page Custorn
Preview | Layout Views

Waorkbook Views

2 View the GDP worksheet in Page Layout view.
1. Click on the GDP tab to select it.
2. Click: View>Workbook Views—>Page Layout.

3 4 5 6 7 g g 1 iz i
A B T
1 Rank Country GDP - per capita (PPP)
2 1 Qatar £137,200
- 3 2 Luxembourg 597,600

The worksheet is displayed in Page Layout view. You are able
to see (almost) exactly what will be printed. Headers, footers
and margins are all shown.

You are also able to edit the worksheet.

You may wonder why Excel users don't use Page Layout view
all of the time when editing worksheets. While some users
may prefer to do this, most will want to see the maximum
amount of data possible on screen and so will prefer the
Normal view.

3 Select Page Break Preview view.
Click: View>Workbook Views->Page Break Preview.

The worksheet is displayed in Page Break Preview view (you may
also see a help dialog first).

This view shows each page with a watermark to indicate which
sheet of paper it will be printed on:

B € D E
22 |Ireland $51,300 2014 est.
23 |Bahrain 549,000 2014 est.
24 |Netherlands 348,000 2014 est.
25 |Austria 546,600, 2014 est.
26 | Australia 16,600 2014 est.
27 |Sweden ©46,200 2014 est.
28 |Germany 546,200 2014 est.
28 |Taiwan 346,000 2014 est.

This view also shows the break between each page as a dotted line:

A B T D E
49| 48 Korea, South $35,400 2014 est,
50 49 New Zealand 535,300 2014 est.
st sowely _____________________$S00 ______ooaest
52 51 Saint Pierre and Miquelon 534,900 2006 est.
53 52 Spain $33,800 2014 est.
54| 53 Malta $33,200 2014 est,
55 54 Israel 533,100 2014 est.
56 55 Trinidad and Tobago $32,200 2014 est.

It is possible to click and drag the dotted line to change the place
where the page breaks.

This view is not covered in this Basic Skills book but is covered in
depth in the Essential Skills book in this series (Session Seven:
Printing Your Work).

4  Select Normal view.
Click: View>Workbook Views—>Normal.

© 2018 The Smart Method® Ltd
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The Wealth of Nations

Lesson 1-17: Hide and Show
the Formula Bar and Ribbon

Most desktop computers have large display screens. The space taken by
the Ribbon and Formula Bar isn't usually a problem.

If you progress to the Essential Skills course in this series, you'll discover
in: Session Eight: Cloud Computing that it is now possible to run Excel 2016
on tablet computers (and even on Smartphones). These devices often
have a very small display screen, meaning that the Ribbon and Formula
Bar take up too much valuable screen space.

When screen space is limited, you may wish to hide the Formula Bar,
Ribbon, or even both, to maximize the number of cells visible on the
screen.

1 Open The Wealth of Nations from your sample files folder (if
it isn’t already open) and click the Life Expectancy tab.

Notice that the Ribbon and Formula Bar are taking up space that
could be used to display the contents of the worksheet.

Consider the screen below:

Ribbon \ Formula Bar
H aN a - The Weslth OFf fations - Excel m= - 0O X
Home Insert Npage Layout Formulas Data | Review View =@ Tellme.. Mike Smart
T - = A .
l:l B G I:E) Q = New Window [ EEJ D
) E Arrange All —
Mormal Page Break IE Show  Zoof 100% Zoom to Switch Macros
Preview - Selection ¥ Freeze Panes - Windows ~ -
Workbook Views Zoom Window Macros -
LS - fe A J v
A E C D -
1 Rank Country GDP - per capita (PPP) Date of information
2 1 Qatar $137,200 2014 est.
3 2 Luxembourg 597,600 2014 est.
4 3 Liechtenstein 589,400 2009 est.
5 4 Macau 588,700 2013 est. -
» GDP Life Expectancy Mobile ... &) 4 3

This is the type of smaller screen you might see on a small tablet
device or Smartphone.

Only five rows are visible, making the worksheet difficult to work
with. Hiding the Ribbon, Formula Bar, or both, will free up some
valuable screen space.

1 Hide the Formula Bar.
Click: View>Show—=>Formula Bar.

The Formula Bar vanishes:

- @ -
Home Insert Pagelayout Formulas Data Review View Q@ Tellme.. MikeSmart

i — = F Wi ;
Flme s Q3@ Swe2 B O
= B arangean :
Mormal Page Break I@ Show  Zoom 100% Zoomto Switch Macros
Preview M Selection =l Freeze Panes - Windows - -
Workbook Views Zoom Window Macros A~
A B C D -

1 |Rank Country GDP - per capita (PPP) Date of information
2 1 Qatar $137,200 2014 est.
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[ ------ Auto-hide Ribbon
T Hide the Ribbon. Click at the top

of the application to show it.

F Show Tabs
Show Ribbon tabs only. Click a

tab to show the commands.

— | Show Tabs and Commands

=—— | Show Ribbon tabz and
commands all the time.

Use the Ribbon Display Options to reduce the Ribbon
display to only show tabs.

In: Lesson 1-12: Use the Ribbon, you learned how to hide the Ribbon
by double-clicking any of the Ribbon tabs (except the File tab).

In this lesson, you'll do the same thing in a different way by using
the Ribbon Display Options button.

1. Click the Ribbon Display Options button at the top right of
the Excel window.

A Rich Menu is displayed showing three different ways to hide
the Ribbon.

2. Click Show Tabs to reduce the Ribbon to a row of tabs.

The Ribbon now reduces in size to only show tabs. You can
still access the Ribbon. It now pops up when you click on any
tab and disappears when you click back onto the worksheet.

=3 - @ -
Home Insert Pagelayout Formulas Data Review View Q@ Tellme.. MikeSmart
A B C D
1 |Rank Country GDP - per capita (PPP) Date of information
2 1 Qatar $137,200 2014 est.

-

Completely hide both the Ribbon and Ribbon tabs.

1. Click the Ribbon Display Options button at the top right of
the Excel window.

2. Click Auto-hide Ribbon from the rich menu.

This time both the Ribbon, and Ribbon tabs disappear. The
worksheet also fills the entire screen. This is called Full Screen

View.
A B C D
1 |Rank Country GDP - per capita (PPP) Date of information
2 1 Qatar $137,200 2014 est.

When you are in Full Screen View you can temporarily bring
back the Ribbon by clicking at the very top of the screen. The
Ribbon then re-appears but vanishes once again when you
click back into the body of the worksheet.

Restore the Ribbon and the Formula Bar.

1. Click the Ribbon Display Options button at the top right of
the Excel window.

2. Click: Show Tabs and Commands from the rich menu.
The Ribbon is restored.

3. Click: View>Show—>Formula Bar.

The Formula Bar is restored.

© 2018 The Smart Method® Ltd
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note

You need an Internet
connection to use
Excel 2016’s help
features

In previous versions of Excel, it
was possible to access offline
help when no Internet
connection was available.

Lesson 1-18: Use the Tell Me
help system

Microsoft have completely redesigned the help system for Excel 2016 and
they really have done a wonderful job. Help is now delivered in a far
more sophisticated way than in any previous Excel version. Microsoft
call this new feature: Tell Me help.

Tell Me help is novel because it not only provides information about
Excel features but also enables you to execute Ribbon commands directly

from inside the help system. This can be a huge time saver.

Support for offline help has

been dropped from Excel 2016. 1
If you have no Internet

connection, you will not be able 2
to access Excel’s help features.

note

You can also use the <Alt>+<Q>
shortcut keys to instantly move

the cursor into the Tell Me help 3
box.

note

The screen grabs
shown in this lesson
may differ from those
you see on your
screen

The Excel 2016 help system is
delivered online. This means
that Microsoft are able to
constantly correct and update
help topics.

For this reason, the information
you see on your screen may
differ from the screen grabs
shown in this lesson.

’/The Wealth of Nations |

Open the Wealth of Nations from your sample files folder (if it
isn’t already open).

Click inside the Tell Me help box located on the right-hand
side of the Ribbon tabs.

2 Tell me what you want to do...
When you click inside the Tell Me help box, a flashing cursor
appears and you can type a question.

9]

Ask Excel how you can save a file.

You learned how to save a file in: Lesson 1-6: Save a workbook to a
local file. In that lesson, you clicked the Save button on the Quick
Access Toolbar.
Imagine that you have forgotten how to save a file.
Type: Save into the Tell Me help box:

Q

W Save

Excel displays a menu of choices.

E Save
Excel commands
k4 savens (these can be executed directly
F,"‘ Save As Other Format 3
@ GetHelp on "Save” + . == A regular help topsic you can read
O Smart Lookup on "Save" =— Research the word “Save” on the Internet

Notice that the list is delineated into three sections. The first
section contains commands. The second has the type of regular
help topic that you are used to reading in traditional help systems,
and the third allows you to research the topic using a wider
Internet search.

Note that the help features will only work if you are connected to
the Internet (see facing page sidebar).

Execute the Save command directly from Tell Me help.

Click the Save command at the top of the menu:
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E Save

Ei Savehs

E} Save As Other Format 2
'A'I
e Get Help on "save" 14

ﬁ) Smart Lookup on "save”

ES@W’E

E¢ Savefs

In a traditional help system, you would have expected to see some
text explaining how the Save command works. Instead Tell Me
help executes the command. The workbook is saved in the same
way it would have been if you had clicked the Save button on the
Quick Access Toolbar.

You can see how useful Tell Me help is when you can’t remember
where a command is situated on the Ribbon and want to execute
the command as quickly as possible.

You can also see that it could be dangerous to execute commands
that you don’t understand.

Understand the other Tell Me help options.

Tell Me help also allows you to execute two other commands and
to access regular help that you can read as a reference:

e Sgve As. You learned how to use the Save As command in:
Lesson 1-6: Save a workbook to a local file.

e Save As Other Format. You learned about different file
formats in: Lesson 1-7: Understand common file formats.

e Save Custom View. Custom Views is an expert-level skill
that isn’t used by most Excel users but is covered in depth
in the Expert Skills book in this series.

e Themes. Themes are not covered in depth in this Basic
Skills book. The Essential Skills book in this series covers
the Themes feature in depth (in Session Four: Making Your
Worksheets Look Professional).

Read the Excel help topic relating to the Save command.

Click: Get Help on “Save”.

Save a workbook as a template
In the Save as type box, click Excel Template, or click Excel

Macro-Enabled Template if the workbook contains macros th...

Save a worksheet
When you have multiple worksheets in an Excel workbook, you

might want to save only one worksheet as its own workbook. ...

Save a chart as a picture
You can quickly copy your chart to another application by
saving it as a picture. This also prevents people from editin...

e More Results for "save"

e Get Help on "Save” %
Q Smart Leckup on "Save"

Links to several topics from the Excel 2016 reference manual are
shown. You can click on any of these links to read any of
Microsoft’s help topics about Save related features.

© 2018 The Smart Method® Ltd
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note

The screen grabs
shown in this lesson
may differ from those
you see on your
screen

The Excel 2016 help system is
delivered online. This means
that Microsoft can constantly
correct and update help topics.

For this reason, the information
you see on your screen may
differ from the screen grabs
shown in this lesson.

Help M

€ - | Save l}

Save a workbook as a template

In the Save as type box, click Excel Template, or click
Excel Macro-Enabled Template if the workbook
contains macros that you want to make available in the
template. Click Save. The template is automatically
placed in the Templates folder to ensure that it will be
available when you want to use it to create a new
workbook.

Save a worksheet

When you have multiple worksheets in an Excel
workbook, you might want to save only one worksheet
as its own workbook. Use the Move or Copy function to
save one worksheet in Excel 2013 or Excel 2016.

Save a chart as a picture

You can quickly copy your chart to another application
by saving it as a picture. This also prevents people from
editing your chart. Tip: You can also copy an Excel chart
to another Office application. Follow these steps to
save a chart as a picture: Click the chart that you want
tosave asa..

Lesson 1-19: Use other help
features

Tell Me help (discussed in: Lesson 1-18: Use the Tell Me help system) is a
fantastic brand-new feature for Excel 2016. You'll probably use this most
of the time as your help system of first choice.

You can also access the same help topics that are available in Tell Me Help
directly from their associated Ribbon commands. This can be useful
when exploring new and unfamiliar features you may discover on
Excel’s many Ribbon tabs.

Later, in: Lesson 2-13: Create functions using Formula AutoComplete, you’'ll
learn how to access and use Excel’s vast function library (that contains
over 300 functions such as SUM and AVERAGE). You'll also learn how
to access a special Excel help feature that documents the use of each
function.

1

2

Access help using the Help task pane.

1. Press the <F1>key. A Help task p
screen.

ane appears at the right of the

2. Type: Save into the text box at the top of the page:

Es o . 7 &

Text to What-If Forecast
Columns =& 7 Analysis~  Sheet
Data Tools Forecast

AC |~
Help

'
[
1]

(

] Group -

GE Ungroup ~

E Subtotal
Outline

ul

x P

3. Click the magnifying glass icon or press the <Enter> key.

A list of help topics relating to Save topics appears (see

sidebar). Note that this list is ser
constantly updated.

description.

Get help directly from the Ribbon.

ved from the Internet and is

Click on any of the help topics displayed to read a detailed

1. Close the Help task pane by clicking the close button I:I in the

top right corner of the help pane.

over the drop down arrow to the
the Number group.

up providing a short description
for:

Click the Home tab on the Ribbon and hover the mouse cursor

right of the word General in

3. If you keep the mouse still, after a short delay a screen tip pops

of what the drop-down list is
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note

Why can’t you learn
Excel using the Help
system?

Excel’s Help system is designed
as a reference work and not as a
structured tutorial.

Try reading the detailed help
about any of the topics. You'll
usually find that to make sense
of the help topic you will
already need to have learned to
use Excel. This is because the
writer assumes that you
already know how to use Excel.

Many Excel books are also
written in this way (as
reference books).

This book is a carefully
structured tutorial. The book is
carefully structured to teach
Excel by building new skills
upon existing skills so that each
lesson is easy to understand.

Once you have learned Excel
(using Smart Method tutorials)
you will find Excel’s reference
topics easy to understand.

MNumber Format

Choose the format for your cells,
such as percentage, currency, date
or time.

e Tell me more

A Tell me more hyperlink is also provided offering more

detailed help. This will only work if you are connected to the

Internet.

4. Click the Tell me more hyperlink.

0 Tell me more

The Help task pane re-appears displaying a list of help topics

relating to Number Format topics.

Format numbers as currency

Display numbers as currency in your worksheet, and then read about
differences between the Currency and Accounting formats.

Available number formats
Format numbers in Excel. This topic lists the formats and provides
brief descriptions.

Format numbers as dates or times

Diate and time formats let you control the way dates and times
appear in cells. For example, you can display 4/2/12 instead of 2-Apr
or 7:00 instead of 7:00 AM.

Help v X%

5. Click on any of the help topics displayed to read a detailed
description.

© 2018 The Smart Method® Ltd
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In this exercise you'll try to remember the name of each of the Excel screen elements. The answers are on the
next page so you might want to recap by turning the page for a little revision before you start.

Keep trying until you are able to name each of the screen elements from memory. You'll be seeing this
terminology during the remainder of the book, so it’s important that you can correctly identify each element.

A

W = R Pa =

| [y B i S i i B st i S vty
=0 WD 0~ LA WN - O

PR3 pa [
| B

Re aIy

&

Insert

Firmulas

Page Layout

Sheetl |

Jata

Review

Book1 - Excel

View Q Tell me what you want to do...

General -

G Format as Table ~
=,
o4 (7 Cell Styles -

=0 00
6o &0

Number ] Styles

% Conditional Formatting ~

c_

Mike Smart P+ Share

Z A

3. 27 £
Sort & Find 8
Filter~ Select~

E‘I‘Inser‘t =

E" Delete -

EI Format -~
Cells

Editing

M)

Q

If you need help
slide the page to
the left
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Ribbon

Name Box
Quick Access
Toolbar

Active Cell

3 4 F

File button (this opens the Backstage View)

Formula Bar

Column
Header

E

-Ep- =

Title bar

E==E= BE- E-%1 4

Minimize, Maximize
and Close buttons =

Ribbon Display Options
button

Tell Me Help

Boak - Excel

View Q Tell me what you want to do...

Mike Smart {Qr Share

2 4y O

E‘I' Insert -~

B Delete - T
& B~ i finda
B Format~ | & * Fijter~ Select~

Editing

E % Conditional Formatting =
D Format as Table -
[57 Cell Styles -

Styles

General

Mumber T Cells

4 »
1 I B B [ - 1 + 1005

Sheet Tab
Row Header

Tab Scroll Buttons

New Sheet
button

|
Status Bar I .
View buttons
Scroll Bars
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Session Two: Doing Useful
Work with Excel

Only those who have the patience to do simple things perfectly ever
acquire the skill to do difficult things easily.

Unknown author

Now that you’ve mastered the basics, you are ready to do really useful
work with this amazing tool. In this session, you will learn to use all of
Excel’s basic features properly. This will put you far ahead of anybody
that hasn’t been formally trained in Excel best practice. You'll be doing
simple things, but you'll be doing them perfectly!

Even after years of daily use, many users are unable to properly use
Excel’s fundamental features. They often reach their goal, but get there in
a very inefficient way, simply because they were never taught how to do
things correctly. By the end of this session you'll be astonished with how
well you are working with Excel.

Session Objectives

By the end of this session you will be able to:

Enter text and numbers into a worksheet

Create a new workbook and view two workbooks at the same time
Use AutoSum to quickly calculate totals

Select a range of cells and understand Smart Tags

Enter data into a range and copy data across a range

Select adjacent and non-adjacent rows and columns

Select non-contiguous cell ranges and view summary information
AutoSelect a range of cells

Re-size rows and columns

Use AutoSum to sum a non-contiguous range

Use AutoSum to calculate average and maximum values

Create your own formulas

Create functions using Formula AutoComplete

Use AutoFill for text and numeric series

Use AutoFill to adjust formulas and use AutoFill options

Speed up your AutoFills and create a custom fill series
Understand linear and exponential series

Use Flash Fill to split and concatenate text

Use the zoom control

Print out a worksheet

© 2018 The Smart Method® Ltd
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tip
Entering numbers as
text

Sometimes you need Excel to
recognize a number as text.

If you type an apostrophe (*)
before the number, Excel won’t
display the apostrophe but will
format the cell as text. You'll
notice that the number is then
left justified to reflect this.

When a number is formatted as
text you cannot perform any

mathematical calculation with it.

First Quarter Sales and
Profit

Lesson 2-1: Enter text and
numbers into a worksheet

Excel beginners tend to reach for the mouse far too often. One of the keys
to productivity with Excel is to avoid using the mouse when entering
data. In this lesson, you'll quickly populate a worksheet without using
the mouse at all.

1 Open First Quarter Sales and Profit from your sample files
folder.

A E < D
Sales and Profit Report - First Quarter 2016

1
2

3 Jan Feb Mar

4 |New York 22,000 29,000 19,000
5 |Los Angeles
6 |London

7 |Paris

8 |Munich

2 Notice the difference between values and text.

Cells can contain values or text. Values can be numbers, dates or
formulas (more on formulas later).

Excel usually does a great job of recognizing when there are values
in a cell and when there is text. The giveaway is that text is always
(by default) left aligned in the cell and values are right aligned.

Look at the numbers on this worksheet. Notice how they are all
right aligned. This lets you know that Excel has correctly
recognized them as values and will happily perform mathematical
operations using them.

3  Save a value into a cell.

1. Type the value 42000 into cell B5. Notice that the mouse cursor
is still flashing in the cell.

42000

At this stage, the value has not been saved into the cell.

If you change your mind, you can still undo the value by
pressing the <ESC> key at the top left of your keyboard or by

clicking the Cancel button on the left-hand side of the
Formula Bar.

2. Decide that you want to keep this value in the cell by either
pressing the <Enter>, <Tab> or an <Arrow> key on the

keyboard, or by clicking the Enter button | on the left-hand
side of the Formula Bar.

4 Enter a column of data without using the mouse.

When you enter data into a column, there’s no need to use the
mouse. Press the <Enter> key after each entry and the active cell
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important

The many ways of
entering numbers

Negative numbers

-123.56
(123.56)

Currency prefixes

Excel is quite happy for you to
prefix a number with a currency
symbol. The currency symbol it
will accept depends upon how
you defined the regional options
in your operating system.

$123.56 (works in USA)
£123.56 (works in UK)

If you progress to the Essential
Skills course in this series you'll
learn an easy method of setting
$, £ and € currency prefixes
whatever your locale (in: Lesson
4-3: Format numbers using built-in
number formats).

Commas

12,234,567.78

Fractions

You must leave a space between
a number and a fraction for this
to work.

61/4
(six, space, one, /, four)

The above will appear on the
worksheet as 6.25 after you
enter it in this way.

01/4
(zero, space, one,/,four)

The above will appear on the
worksheet as 0.25. The leading
zero is needed to prevent Excel
from assuming that you are
entering a date.

Formula Bar

fe || January I

B C
fit Report - First Quarter 2008

| January _l Feb Mar

22,000 29,000
42,000 35,000

5

moves to the cell beneath. Try this now with the following January
sales data:

1. Type 18,000 into cell Bé6.
2. Press the <Enter> key to move to cell B7.

3. Do the same to enter the following values into the next two

cells.
A B C ]

3 Jan Feb Mar

4 New York 22,000 29,000 19,000
5 |Los Angeles 42,000

6 |[London 18,000

7 |Paris 35,000

8 Munich 12,000

Enter a row of data without using the mouse.

You can also enter a row of data without using the mouse.

1. Clickin cell C5.

2. Type 39,000 and then press the <Tab> key on your keyboard.

The <Tab> key is on the left-hand side of the keyboard above
the <Caps Lock> key. Notice how pressing the <T'ab> key saves
the value into the cell and then moves one cell to the right.

3. Type 43,000 into cell D5 and press the <Enter> key.

You magically move to cell C6, as Excel guesses that you
probably want to begin entering data into the next row.

Complete the table without using the mouse.

By using the <Tab> or <Enter> key in the right places you should
be able to complete the table now without using the mouse:

A B C D
3 Jan Feb Mar
4 |New York 22,000 29,000 15,000
5 |Los Angeles 42,000 39,000 43,000
6 |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 |Munich 12,000 15,000 13,000

Change the text in cell B3 to January.

1. Double-click cell B3. Notice that there is now a flashing cursor
in the cell.

Jan

2. Type: uary on the keyboard to change Jan to January.
3. DPress the <Enter> key.
Change the text in cell B3 back to Jan using the formula bar.

Click once in cell B3 and then change the text in the formula bar
back to Jan (see sidebar).

Save your work as First Quarter Sales and Profit-2.

© 2018 The Smart Method® Ltd
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tip
Other ways of

creating a new
workbook

e  Use the keyboard shortcut
<Ctrl>+<N>.

e Add a button to the Quick
Access Toolbar.

You learned now to add a
button to the Quick Access
Toolbar in: Lesson 1-14:
Customize the Quick Access
Toolbar and preview the printout.

Lesson 2-2: Create a new
workbook and view two
workbooks at the same time

1 Create a new workbook by opening Excel.
1. Open Excel.
2. Click the Blank workbook template to create a new workbook.

Excel helpfully creates a workbook, unimaginatively named
Book1. If you already have a workbook open called Book1, the
new workbook will be called Book2... and so on.

Notice that Bookl — Excel is displayed on the Title Bar.

H s - 53 *  Bookl - Excel &= — O *
Hom  Inser Page Form Data View @ Tellme.. Mike Smart
"D & A = E[%Conditional Formatting = iil o)
- [ Format as Table -
Paste umber % ormat as fable Cells  Editing
. - [P cellstyles~ - .
Clipboard ra Styles -
Al _ft hd
A D E F G H [«
]
2 -
Sheet1 ) [ 5

Ready

2  Create another new workbook.

1. Click the File button at the top left of the screen and
click the New button in the left-hand menu.

You are presented with the same familiar dialog that you see
when you start up Excel.

2. Click the Blank workbook template. A new blank workbook
called Book2 is displayed in the workbook window.

You could be forgiven for thinking that nothing has happened,
but you can see that the Title Bar now says: Book2 — Excel,
showing that you are looking at a different workbook.

Book2 - Excel

Formulas Data Rewview

3 Use the taskbar to move between workbooks.

You should see an Excel icon with two right-hand borders at the
very bottom-left of the screen (this area is called the Windows
taskbar). Hover over this icon with your mouse. A gallery pops
up showing two workbooks: Bookl and Book2.
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note

Finding a workbook
when many are open

An alternative way to quickly
find a workbook when many

are open is to click:

View>Window—>
Switch Windows

This presents you with a list of

all open workbooks.

= =
Switch Macr
Windows ~ -

+ 1BookZ

2 Bookl

You can also use the
<Ctrl>+<Tab> keyboard

shortcut to cycle through all

open workbooks.

Arrange Freeze
All %F'anes e

Arrange All

- g =] Split LIy

Window

Stack your open windows so you
can see all of thern at once.

Arrange Windows 7

Arrange
@ Tileg:
() Harizontal
() vertical
Ogascade

|:| Windows of active workbook

pud

Cancel

X§ Bookl - Excel X3 Book2 - Excel

Hover over each item in the pop-up gallery to display each
workbook. The only difference you will see is the Title Bar
changing from Book1 to Book2 because both workbooks are empty.

See sidebar for other methods of switching windows.
Display both Book1 and BookZ2 at the same time.
1. Click: View>Window-> Arrange All.
The Arrange Windows dialog is displayed.
2. Choose the Horizontal arrangement and click the OK button.

Both workbooks are now shown, one above the other. Each
window occupies exactly half of your screen:

H @ - Book1 - Excel = - O X
Homi Insert Page Formi Data Revie View @ Tellme.. Mike Smart

B & Q [3 =2
2 & E
Workbook Show  Zoom 100% Zoomto Window Macros
Views = - Selection T M
Zoom Macros ~
Al 7 Fe v
A B C D E F G H -
1
2
Sheetl ()] [ v

File Homi Insert Page Formi Data Revie View Q Tell me.. Mike Smart

'n'D X% ﬁ = % %Conditional Formatting = E' o)
B -~ [% Format as Table -
Paste B Font  Alignment Number & Format as lable Cells  Editing
I - - - [ cellStyles~ - -
Clipboard Styles ~
- I v
A B C D E F G H -
2 -
Sheet1 () [ v

Notice that as you click each workbook window the Title Bar
and the Close/Minimize/Restore Down buttons light up, to show
that this is the active window.

Close Book2 and maximize Book1 to restore the display to a
single workbook.

If you've forgotten how to do this, refer back to: Lesson 1-4:
Maximize, minimize, re-size, move and close the Excel window.
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anecdote

I ran an Excel course for a small
company in London a few years
ago.

The boss had sent his two office
staff to learn a little more about
Excel.

Before the course began I asked
the delegates how long they had
been using Excel. They told me
that they’d been using it for two
years to do all of their office
reports.

When I showed them AutoSum
they gasped in delight. “This
will save us hours” they told
me.

I was curious how they had
been doing their reports before.

Believe it or not, they had been
adding up all of the figures in
each column with a calculator
and then manually typing the
totals at the bottom of each
column.

In this case the boss had given
them Excel as he had heard it
was a very good tool.
Unfortunately, he had not
initially seen the need to train
the staff in its use.

With no training, it seemed
quite logical to them to use it
like a word processor and the
boss had still been delighted
that his staff were using such
impressive technology.

First Quarter Sales and
Profit-2

Lesson 2-3: Use AutoSum to
quickly calculate totals

Excel’s AutoSum feature is a really useful and fast way to add the values
in a range of cells together.

1 Open First Quarter Sales and Profit-2 from your sample files
folder.

2 In cell A9 type the word Total followed by the <Tab> key.

The active cell moves to the right and is now in cell B9:

A B < D
7 |Paris 35,000 26,000 31,000
8 |Munich 12,000 15,000 13,000

9 |T0ta|

3 Click: Home~>Editing> (this is the AutoSum button).

AutoSum
Button
> AutoSum - p
Find &
= Clear~ Select -
Editing

Something interesting has happened to the worksheet:

A B C D
3 Jan Feb Mar
4 |New York 22,000 29,000 135,000
5 |Los Angeles 42,000 39,000 43,000
6 London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 |Munich F_____lg,.EID_D [ 15,000 13,000
9 |T0ta| =SUM{B4:BSE
10 SUM(number1, [number2], ...)

Excel has placed a marquee around the number range that
AutoSum has guessed you want to work with. The dots that mark
the boundary of the marquee are called the marching ants.

The marching ants surround all the numbers in the column above,
up to the first blank cell or text cell (in this case, up to the word:

Jan).

=SUM(B4:B8) is your first glimpse of an Excel Formula. Formulas
always begin with an equal sign. This formula is using the SUM
function to compute the Sum (or total) of the values in cells B4 to
B8. You'll learn more about functions later, in: Lesson 2-13: Create
functions using Formula AutoComplete.

4 Press the <Enter> key or click the AutoSum button once
more to display the total January sales:
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tip
Entering an AutoSum

using only the
keyboard

You can also execute an
AutoSum using the keyboard
shortcut:

<Alt>+<=>

note

You can also add an
AutoSum formula
using the Quick
Analysis button

Later, in: Lesson 2-4: Select a
range of cells and understand
Smart Tags, you'll learn how to
select a range of cells.

Whenever you select a range of
cells, a Quick Analysis button
appears just outside the
bottom-right corner of the
selected range.

Jan Feb
22,000
42,000
18,000
35,000
12,000

A

When you click the Quick
Analysis button, the Quick
Analysis dialog appears.

One of the menu options on
this dialog is Totals.

The Totals dialog allows you to
add an AutoSum beneath a
selected range (in a similar way
to the AutoSum button method
described in this lesson).

=

Oy

Sum

7

[T RN T R Y]

A B C ]

Jan Feb Mar
MNew York 22,000 25,000 19,000
Los Angeles 42,000 39,000 43,000
London 18,000 20,000 22,000
Paris 35,000 26,000 31,000
Munich 12,000 15,000 13,000
Total 123,000

Type the word Total into cell E3 and press the <Enter> key
once.

The active cell moves down one row and is now in cell E4.

A B C D E
3 Jan Feb Mar Total
4 |NEW Yaork 22,000 29,000 19,000 i
5 |Los Angeles 42,000 39,000 43,000

Use AutoSum to calculate the total sales for New York.

Click: Home->Editing> AutoSum.

1.
This time AutoSum correctly guesses that you want to sum the
values to the left of cell E4:
B C D E F [«
3 | Jan Feb Mar Total
4] 2000 29,000 19,000 1=sum(B4:04) |
5 42,000 39,000 43,000 SUM(number1, [number2], ...)
2. Press the <Enter> key, or click the AutoSum button once more.
A B C D E
1 |Sales and Profit Report - First Quarter 2016
2
3 lan Feb Mar Total
4 |New York 22,000 29,000 19,000 70,000
5 |Los Angeles 42,000 39,000 43,000
& |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
2 |Munich 12,000 15,000 13,000
g |Total 129,000
10

Save your work as First Quarter Sales and Profit-3.

© 2018 The Smart Method® Ltd
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Lesson 2-4: Select a range of
cells and understand Smart
Tags

1 Open First Quarter Sales and Profit-3 from your sample files
folder (if it isn’t already open).

2 Observe the formula behind the value in cell B9.

Click once on cell B9 or move to it with the arrow keys on your
keyboard.

Look at the formula bar at the top of the screen. Notice that the cell
displays the value of a calculation and the formula bar shows the
formula used to calculate the value:

B9 - Je =SUM(B4:B8)
note . - ) )
You can also delete 8 Munich 12,000 15,000 13,000
cell contents using the 9 |TD‘EE| | 129,000 _|
mouse 10

1 Value Formula
Pressing the <Delete> key is the
fastest way to delete cell 3 Delete the contents of cell B9.

contents.

You can also delete the contents Press the <Delete> key on your keyboard.

of a cell using the mouse. Todo 4 Change the word Total in cell A9 to USA Sales and press the

this: <Tab> key once.

1. Right-click the cell.
The cursor moves to cell B9.

2. Click Clear Contents from
the shortcut menu. 8 |Munich 12,000
9 |usa sales

5  Select cells B4:B5 with your mouse.

When the mouse cursor is hovered over a selected cell there are
three possible cursor shapes:

Cursor ‘ What it does ‘

E:}u.ﬁ_

The white cross (Select) cursor appears when
you hover over the center of the active cell.
You can then click and drag to select a range of
cells.

1.6 The black cross (AutoFill) cursor appears

' when you hover over the bottom right-hand
corner of the active cell. You'll be covering
AutoFill later in this session.

1.6 The four-headed arrow (Move) cursor appears

=i when you hover over one of the edges of the
active cell (but not the bottom right corner).

First Quarter Sales and
Profit-3
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note

Selecting cells with
the keyboard

To select cells with the keyboard
hold down the <Shift> key and
then use the <Arrow> keys to
select the range needed.

note

Selecting a large
range of cells with the
<Shift>-click
technique

If you need to select a very large
range of cells it is sometimes
useful to use this technique:

1. Click the cell in the top left
corner of the required
range.

2. If necessary, use the scroll
bars to make the bottom
right corner of the required
range visible.

3. Hold down the <Shift> key.

4. Click in the bottom right
corner of the required
range.

v 54,000_|

Formula Omits Adjacent Cells
Update Formula to Include Cells
Help on this error

lgnore Error

Edit in Formula Bar

Error Checking Options...

Beginners often have difficulty selecting cells and end up moving
them or AutoFilling them by mistake.

Carefully position the mouse at the center of cell B4 so that you see
the white cross (Select) cursor. When you see the white cross, hold
down the left mouse button and drag down to cell B5. You have
now selected cells B4 and B5 (in Excel terminology you’d say that
you have selected the range B4:B5).

A B
3 Jan
4 |New York 22,000
5 |Los Angeles | op 42,000

Display total USA sales in cell B9.

Because you have selected only the cells containing USA sales,
(cells B4:B5), AutoSum can be used to show the value of the
selected cells.

Click the AutoSum button to display the total value of the
selected cells.

USA sales are shown in cell B9.

| g |usasales | 64,000 |

Notice the small green triangle at the top left of cell B9. This is

”

Excel’s way of saying: “I think you may have made a mistake”.

Inspect a potential error using a Smart Tag.

1. Click once on cell B9 to make it the active cell.

An Exclamation Mark icon appears I:‘ This is called a Smart
Tag.

2. Hover the mouse cursor over the Smart Tag.

A tip box pops up telling you what Excel thinks you may have
done wrong (see below). Of course, in this case, everything is
fine.

USA Sale @ «| 64,000_|

The formula in this cell refers to a range that has additional numbers adjacent to it.

The Smart Tag thinks that perhaps you didn’t want to total just
the USA sales — but, in this case, the Smart Tag is wrong.

Examine the remedial actions suggested by the Smart Tag.

1. Hover the mouse cursor over the Smart Tag icon D
2. Click the drop-down arrow that appears.

A list of possible remedial actions is displayed. In this case you
can choose Ignore Error to remove the green triangle from the
corner of the cell.

Save your work as First Quarter Sales and Profit-4.
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Lesson 2-5: Enter data into a
range and copy data across a
range

Now that you have mastered the technique of selecting cells, you can use
it to speed up data entry.

When you select a range of cells prior to entering data, Excel knows that
all data entered belongs in that range. Several key combinations are then
available to greatly speed up data entry.

1 Open a new workbook and save it as Data Range Test.
2  Select cells B2:D4.

You learned how to do this in: Lesson 2-4: Select a range of cells and
understand Smart Tags.

A B c D E

L9, BN S TR K

3  Type: London
The text appears in cell B2: the top left cell in the range selected.
4 Press the <Enter> Key.
The cursor moves to cell B3 as it normally would.
5 Type: Paris followed by the <Enter> key.
The cursor moves to cell B4 as it normally would.
6 Type: New York followed by the <Enter> key.

This time something new happens. The cursor doesn’t move to cell
B5 as you might expect but jumps to cell C2 instead.

A B c D E

London
Paris
MNew York

N ks W R =

7 Type: 150,000 followed by the <Enter> key.

The value appears in C2 and Excel moves down the column again

to cell C3.
A B c D E
1
2 London 150,000
3 Paris
4 MNew York
5
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8 Press the <Enter> key without entering a value to leave C3
blank.

Excel moves down the column to cell C4.
9  Type 225,000 followed by the <Enter> key.
The cursor jumps to cell D2.

10 Press <Shift>+<Enter> twice to change your mind about
leaving the value for Paris blank.

1. Press <Shift>+<Enter> to move backwards to the value for

New York.
2. Press <Shift>+<Enter> a second time and you are back to the
Paris cell.
A B C D E

London 150,000
Paris
New York 225,000

ok W R =

11  Type 180,000 followed by the <Tab> key.

<Tab> moves you across the range, to cell D3.

A B C D E

London 150,000
Paris 180,000
MNew York 225,000

oo W B =

You can now appreciate how to use the technique of <Enter>,
<Tab>, <Shift>+<Tab> and <Shift>+<Enter> to save a lot of time
when entering a whole table of data.

12 Select cells D2:D4.
13 Type 50% but don't press the <Enter> or <Tab> keys.

The challenge this time is to place the same value into cells D3 and
D4 without having to type the value two more times.

14 Press <CtrI>+<Enter>.

The value is replicated into all of the other cells in the selected

range.
A B C D E
1
2 London 150,000 50%
3 Paris 180,000 50%
4 MNew York 225,000 50%
5

15 Click the Save button to save the Data Range Test
workbook.

The Save button is at the left of the Quick Access Toolbar at the top
left of your screen. E
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First Quarter Sales and
Profit-4

Lesson 2-6: Select adjacent
and non-adjacent rows and
columns

1

2

Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

Select all of column A.

1. Hover the mouse cursor over the letter A at the top of the
column. The column header lights up and the mouse cursor
changes to a black down arrow:

Al B C
1 |Sa|es and Pro [it Report - First Quarter 2016

2. Click to select the entire column. The column becomes slightly
shaded and a green line surrounds all of the cells.

A E C D
1 |Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar
4 |New York 22,000 29,000 13,000

Bold face all of the contents of column A.

Click: Home—~>Font>Bold

Because the whole column was selected, all of the values become
bold faced.

A E C D
1 |Sales and Profit Report - First Quarter 2016
2
& Jan Feb Mar
4 |New York 22,000 29,000 15,000
5 |Los Angeles 42,000 39,000 43,000
& |London 18,000 20,000 22,000

Click: Home->Font->Bold L once more to change the type in
column A back to normal.

Select all of row 4.

1. Hover the mouse cursor over the number on the left-hand side
of row 4. The number button lights up and the mouse cursor
changes to a black arrow pointing across the row:

3 Jan
=+ |New York 22,000
42,000

5 |Los Angeles

2. Click to select the row.

Select columns B and C.
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Hover the mouse cursor over the letter at the top of column B until
you see the black down arrow. When you see the arrow, click and
drag to the right to select columns B and C.

A B i D
1 |Sales and Profit Report - First Quarter 201€
2
3 Jan Feb Mar
4 |New York 22,000 29,000 19,000

Select rows 6 and 7.

1. Hover over the number at the left of row 6 until you see the
black arrow pointing across the row.

2. When you see the arrow, click and drag down to row 7 to
select both rows.

5 |Los Angeles 42,000 39,000
6 |London 13,000 20,000
T |Paris 35,000 26,000

Select columns A, B, C, D and E without dragging the
mouse.

Sometimes you will need to select a large number of adjacent
columns or rows. You could drag across them, but it is often easier
to use the following technique:

1. Select column A.
2. Hold down the <Shift> key.
3. Select column E.

Columns A to E are selected.

A B C D E
1 |Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar Total
4 |New York 22,000 25,000 15,000 70,000

Select rows 4 and 6.

Perhaps you need to perform an operation on two non-adjacent
rows. To select rows 4 and 6 you need to:

1. Select row 4.
2. Hold down the <Ctrl> key on the keyboard.

3. Select row 6.

3 Jan Feb Mar

4 |New York 22,000 29,000 19,000
5 |Los Angeles 42,000 39,000 43,000
6 | 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000

© 2018 The Smart Method® Ltd
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important Lesson 2-7: Select non-

You canalso Deselect CONtiguous cell ranges and

cells using Ctrl-Click . . .
view summary information

Excel 365 Version 1801
(released in February 2018) . . . . .
e Non-contiguous is a very impressive word! It simply means a range of
added the ability add or . . T
remove cells from a selection cells that is split across two or more blocks of cells in different parts of the
using <Ctrl>+<Click>. worksheet.
Here’s an example of how you Non-contiguous ranges can be selected using both the mouse and
can use this (fantastically keyboard. The keyboard method may seem a little involved at first but
useful) new feature: some users prefer it.
L. Select cells B4:B5. 1 Open First Quarter Sales and Profit-4 from your sample files
A B folder (if it isn’t already open).

: dan 2  Select the contiguous range B4:D8 with the keyboard.

4 |New York 22,000

5 |Los Angeles 42,000 When you need to select a contiguous range with the keyboard

& |London 18,000 here’s how it’s done:
2. Hold down the <Ctrl> key 1. Use the arrow keys on the keyboard to navigate to cell B4.

d th lect cells B6:B7.
and Then select et 2. Hold down the <Shift> key on the keyboard

The selected cells are added to

the selection: 3. Still holding the <Shift> key down, use the arrow keys on the

keyboard to navigate to cell D8

A B

3 Jan The contiguous range B4:D8 is selected.

4 |New York 22,000 A B s D E

5 |Los Angeles 42,000 1 |Sales and Profit Report - First Quarter 2016

6 |London 2

7 |Paris 35,000 3 lan Feb Mar Total

8 |Munich 12,000 4 |New York 22,000 29,000 19,000 70,000
3. Hold down the <Ctrl> key ; Il:os jngeles :;’g ;3’m :2’£
and then click on cell B4. Gn_ en : e ?

7 |Paris 35,000 26,000 31,000
Cell B4 is removed from the 2 |Munich 12,000 15,000 13,000
selection: 9 |USA Sales 64,000
= El
i LB | . .

3 Jan 3  Select the non-contiguous range B4:B8,D4:D8 using the

4 |New York 22,000 mouse.

3 |LosAngeles | 42,000 | 1. Select the range B4:B8 using the mouse.

6 [London

7 |paris 35,000 2. Hold down the <Ctrl> key and select the range D4:D8 using

8 |Munich 12,000 the mouse.

The non-contiguous range B4:B8,D4:D8 is selected:

A B C D E
3 Jan Feb Mar Total
4 |New York 22,000 29,000 70,000
5 |Los Angeles 42,000 39,000 43,000
& |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
g |Munich 12,000 15,000 13,000
First Quarter Sales and 9 |USA Sales 64,000

Profit-4
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note

“Extend Selection”
mode and “Add to
Selection” mode

In this lesson, you use Excel’s
Add to Selection mode.

There’s also an Extend Selection
mode that can be used instead
of the <Shift> key (in this lesson)
but it is not recommended as it
is less efficient.

Extend Selection Mode

The <F8> key switches Extend
Selection Mode on and off.

Try pressing the <F8> key once.
You'll see the words Extend
Selection appear at the bottom
left of the screen:

56

Sheetl 5

Ready

Extend Selection

When you press the <F8> key
once again, the words: Extend
Selection disappear, showing
that you have switched this
mode off.

In this lesson, you could have
selected cells B4:B8 using Extend
Selection mode like this:

1. Navigate to cell B4.

2. Press the <F8> key to enter
Extend Selection mode.

3. Use the <Down Arrow> key
to move down the column to
cell B8.

4. Press the <F8> key to switch
Extend Selection mode off.

Add to Selection mode

This mode is far more useful
and is switched on and off by
pressing the <Shift>+<F8> key
combination.

Add to Selection mode keeps any
selected cells selected as you
navigate to a new position on
the worksheet using the
keyboard.

You don’t need to explicitly turn
this mode off as Excel will do
this for you.

7

Select the same non-contiguous range with the keyboard.

This is a little more involved than using the simple
<Shift>+<Arrow keys> method used earlier.

Here’s how it’s done:

1. Use the arrow keys on the keyboard to navigate to cell B4

2. Hold down the <Shift> key and then use the <Down Arrow>
key to move down the column to cell BS.

3. Press: <Shift>+<F8> to enter Add to Selection mode (see

sidebar).

4. Use the arrow keys to navigate to cell D4.

5. Hold down the <Shift> key and then use the <Down Arrow>
key to move down the column to cell D8.

The non-contiguous range B4:B8,D4:D8 is selected:

A B
3 Jan Feb
4 |New York 22,000
5 |Los Angeles 42,000
6 |London 18,000
7 |Paris 35,000
& |Munich 12,000
9 |USA Sales 64,000

C

D
Mar

25,000 19,000

39,000
20,000
26,000
15,000

43,000
22,000
31,000
13,000

E
Total
70,000

Obtain a total sales figures for January and March using the

status bar.

The status bar contains summary information for the currently

selected range.

Look at the bottom right of your screen. You can see the average

sales and total sales (sum of sales) for January and March:

|A1rerage: 25700 Count 10 Sum: 257,000

View the maximum and minimum sales for January and

March using the status bar.

Right-click the status bar and click Maximum and Minimum on the

shortcut menu.

W Average
W Count

Mumerical Count

v Minimum
v Maximum
W Sum

The status bar now also displays maximum and minimum values.

| Average: 25700 Count 10 Min: 12,00

000

Max: 43,00

]

0

Sum: 257,00

(]

0

Close the workbook without saving.
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Lesson 2-8: AutoSelect a
range of cells

1 Open Sales Report from your sample files folder.

A B T D E
1 |Weekly Sales Report
2
3 |Invoice No |Date Customer Country  Total
4 10918 10 March 2016 Bottom-Dollar Markets Canada 1,700.81
5 10917 10 March 2016 Romero y tomillo Spain 439.92
6 10926 10 March 2016 Ana Trujillo Emparedados y helados  Mexico 604.42
7 10929 11 March 2016 Frankenversand Germany  1,380.33
8 10934 11 March 2016 Lehmanns Marktstand Germany 587.50
9 10939 11 March 2016 Magazzini Alimentari Riuniti Italy 749.05
10 10939 11 March 2016 Magazzini Alimentari Riuniti Italy - 745.05
1 10925 12 March 2016 Hanari Carnes Brazil 558.29
12 10944 12 March 2016 Bottom-Dollar Markets Canada 1,204.75
13 10923 12 March 2016 La maison d'Asie France B79.83
14 10937 13 March 2016 Cactus Comidas para llevar Argentina 757.64
15 10947 13 March 2016 B's Beverages UK 258.50
16 10933 13 March 2016 Island Trading UK 1,081.71
17 10938 14 March 2016 QUICK-Stop Germany = 3,209.95
18 10949 14 March 2016 Bottom-Dollar Markets Canada 5,195.85
19 10945 14 March 2016 Morgenstern Gesundkost Germany 287.33
20
21 |This report excludes sales to Asia and South Africa. \ Range

This report contains a single block of cells in the range A3 to E19.
When data is arranged in this way it is referred to as a Range.

You will often want to select a row or column of cells within a
range, or even the entire range.

You can select ranges by using any of the techniques covered so far
but this could be very time consuming if the range encompassed
hundreds, or even thousands, of rows and columns.

In this lesson, you'll learn how to select range rows, range columns
and entire ranges with a few clicks of the mouse.

2 Select all cells within the range to the right of cell A7.
1. Clickin cell A7 to make it the active cell.

2. Hover over the right-hand border of cell A7 until you see the
four-headed arrow cursor shape.

| 1092“'%1 March 2016

10934 11 March 2016

3. When you see this cursor shape, hold down the <Shift> key
and double-click.

All cells to the right of A7, but within the range, are selected.

| 7 | 10929 11 March 2016 Frankenversand Germany = 1,380.33 |

3 Select all cells within the range except the header row.

1. Click in cell A4 to make it the active cell.

Sales Report 2. Hover over the right-hand border of cell A4 until you see the

four-headed arrow cursor shape.
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note 4 1091&%0

5 10917 10
Other ways to 3. When you see this cursor shape, hold down the <Shift> key
AutoSelect a range and double-click.
Using the keyboard All cells to the right of cell A4, but within the range, are
selected.
Here’s how you would select 4. Hover over the bottom border of the selected cells until you

the entire range in the Weekly
Sales Report (excluding the
header row) using the keyboard

see the four-headed arrow cursor shape.

thod Date Customer
method. 10 March 2016 Bottom-Dollar Markets o
Make cell A4 the active cell by 10 March 2016 Romero y tomillo e

navigating to it with the

<Arrow> keys. 5. When you see this cursor shape, hold down the <Shift> key

and double-click.
1. Press: <Ctrl>+<Shift>+

<DownArrow> The entire range (except the header row) is selected.
Cells A4:A19 are selected. &) B - 2 E
1 |\weekly Sales Report
2. Press: <Ctrl>+<Shift>+ 2
<RightArrow> 3 |Invoice No Date Customer Country _ Total
Th " ludi 4 10918 10 March 2016 Bottom-Dollar Markets Canada 1,700.81
SACIUIGIan o€ .(eXC LS 5 10917 10 March 2016 Romero y tomillo Spain 429.92
the header row) is selected. & 10926 10 March 2016 Ana Trujillo Emparedados y helados Mexico 604.42
= 7 10929 11 March 2016 Frankenversand Germany  1,380.33
USIng ShortCUt keys 8 10934 11 March 2016 Lehmanns Marktstand Germany 587.50
he sh K hod is th 9 10939 11 March 2016 Magazzini Alimentari Riuniti Italy 749.05
The shortcut keys metho L e 10 10939 11 March 2016 Magazzini Alimentari Riuniti Italy - 749.05
fastest way to select the entire 11 10925 12 March 2016 Hanari Carnes Brazil 558.29
range including the header row. 12 10944 12 March 2016 Bottom-Dollar Markets Canada  1,204.75
. o0 13 10923 12 March 2016 La maison d'Asie France B879.83
1. Click anywhere inside the - -
14 10937 13 March 2016 Cactus Comidas para llevar Argentina 757.64
range. 15 10947 13 March 2016 B's Beverages UK 258.50
2.  Press: <Ctrl>+<A> 16 10933 13 March 2016 Island Trading UK 1,081.71
17 10938 14 March 2016 QUICK-Stop Germany = 3,209.95
The entire range (including 18 10949 14 March 2016 Bottom-Dollar Markets Canada | 5,195.85
the header row) is selected. 19 10945 14 March 2016 Morgenstern Gesundkost Germany = 287.88
20
From the Rlbbon 21 |Thsi report excludes sales to Asia and South Africa.
You can select the entire range You can also use this technique to select cells to the left of the
including the header row active cell or above the active cell.
(described as the Current region ) )
in the dialog) using the Ribbon. 4 Close the workbook without saving.

This method is the least efficient
way to select an entire range.

Make sure that the active cell is
within the range.

1. Click:

Home->Editing>
Find & Select>
Go To Special...

The Go To Special dialog is
displayed.

2. Click the Current Region
option button and then
click the OK button.

The entire range (including the
header row) is selected.
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note

Why are you calling
the pound sign a
hash?

In the USA and Canada, the
hash symbol is called the
pound sign or the number
sign.

In different USA/Canada
regions the single symbol has
different names because it can
be used to denote a number (as
in contestant #5) or as a weight
(as in 34 of butter).

Throughout this book I will
refer to the # as a hash because
that is the term used in most
other English-speaking
countries.

note

Excel column widths
are expressed in
characters and pixels

In this lesson Excel displays the
default column width as:

8.43 characters is Excel’s default
column size (meaning that 8.43
characters can be displayed in
each cell using the default
Calibri font).

Pixels are the tiny dots that
make up a computer display.

With 64 pixels to each column,
a computer screen with a
resolution of 1680X1050 (the
norm for a 22 inch display)
should display about
1680/64=26.25 Excel columns.

Row heights are displayed in
points (a point is approximately
1/72 inch or 0.035cm).

First Quarter Sales and
Profit-4

Lesson 2-9: Re-size rows and
columns

1

Open First Quarter Sales and Profit-4 from your sample files
folder.

Notice that columns B, C, D and E are far too wide for their
contents. It would be useful to make them narrower to keep the
worksheet compact.

Re-size column B so that it is just wide enough to contain the
January sales figures.

1. Hover the mouse cursor over the line separating the letters B
and C until you see the re-size cursor shape:

B <+ ¢

2. When you see the re-size cursor shape, keep the mouse still and
then click and drag to the left. Column B will re-size as you
drag. Make it narrower so that the values just fit in the column.
Notice that the column width is displayed in characters and
pixels (see sidebar) as you drag.

F35 - YT
A B C D
1 |Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar
4 |New York 22,000 25,000 15,000

Re-size column B so that it is too narrow to contain the
January sales figures.

Notice that when the column isn’t wide enough to contain the
contents, hash signs are shown instead of values (if you're used to
hashes being called pound signs or number signs see the sidebar).

A B C D E
1 |Sales and Profit Report - First Quarter 2016
2
3 Jan  Feb Mar Total
4 |New York i 25,000 15,000 70,000

Automatically re-size column B so that it is a perfect fit for
the widest cell in the column.

1. Hover over the line separating the letters B and C until you see
the re-size cursor shape:

| B+
2. When you see this shape, double-click to automatically re-size
column B.

Automatically re-size every column in the worksheet in one
operation.
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note

Other ways to re-size
rows and columns

You can also re-size rows and
columns using the Ribbon.

Click: Home—>Cells>Format.

A drop-down menu appears.

=2 > AutoSum + A
] = A
[&] Fill -
Format Sort §
Y| & Clear~ Filter
Cell Size

IC Row Height..
AutoFit Row Height
1 Column Width..,
AutoFit Column Width

Default Width...

You can use the Row Height and
Column Width options to set the
row or column to a specific
number of characters (for
column widths) or points (for
row height).

You can also use the AutoFit
Row Height and AutoFit Column
Width options to automatically
re-size the row or column (you
achieved this more efficiently
with a double-click in the
lesson).

Default Width... allows you to
set a new width for all columns
but will not affect columns that
have already been manually
resized.

note

Making several
columns or rows the
same size

Select the columns that you
want to resize and then click
and drag the intersection of any
of the selected columns.

When the mouse button is
released, this will make each of
the selected columns exactly
the same width.

Select every cell in the worksheet by clicking the Select All button
in the top left corner of the worksheet (you can also do this by
clicking in any blank cell and then pressing <Ctrl>+<A>).

o A

1 |Sales and Prof

Hover over the intersection of any two columns until you see the
re-size cursor shape and then double-click.
Every column is now perfectly sized.

Notice that AutoFit has done its job rather too well. Column A is
now wide enough to accommodate all of the text in cell Al.

A A B
1 |Sales and Profit Report - First Quarter 2016

Automatically re-size column A so that it is only wide enough
to contain the longest city name (Los Angeles).

1. Select cells A4:A9.
2. Click: Home=>Cells>Format—=> AutoFit Column Width.

This time the column is automatically sized so that it is wide
enough to contain all of the text in the selected cells.

A B i€ D E
1 |Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar Total
4 |New York 22,000 29,000 15,000 70,000
5 |Los Angeles 42,000 35,000 43,000

Notice that the text has spilled over from cell Al into the adjoining
columns B, C, D and E. This always happens when a cell contains
text and the adjacent cells are empty.

Manually re-size row 3 so that it is about twice as tall as the
other rows.

Do this in the same way you re-sized the column but, this time,
hover between the intersection of rows 3 and 4 until you see the re-
size cursor shape, and then click and drag downwards.

1 |Sales and Profit Report - First Quarter 2016

o

T Height: 30.00 (40 pixels)

3_ Jan Feb Mar Total
New York 22,000 29,000 19,000 70,000

5 |LosAngeles 42,000 39,000 43,000

Auto-resize row 3 so that it is the same size as the other
rows again.

1. Hover over the line separating the numbers 3 and 4 until you
see the re-size cursor shape.

2. When you see this shape, double-click to automatically re-size
row 3.

Close Excel without saving.

© 2018 The Smart Method® Ltd
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First Quarter Sales and
Profit-4

Lesson 2-10: Use AutoSum to
sum a non-contiguous range

In: Lesson 2-7: Select non-contiguous cell ranges and view summary
information, you learned how to view the sum of January and March sales
using the status bar. But how can you put that value onto the worksheet?

Now that you have the hang of selecting non-contiguous ranges, you can
use this skill in conjunction with your AutoSum skills to create a formula
that will calculate the total of a non-contiguous range.

1 Open First Quarter Sales and Profit-4 from your sample files

folder.

2 Enter the text: Jan/Mar Sales in cell A10 and press the

<Tab> key.

The active cell moves to cell B10.

3 Re-size column A so that it is wide enough to contain the

text.

1. Hover over the line separating the letters A and B until you see
the re-size cursor shape:

A+

s |

2. When you see this shape, keep the mouse still and then click
and drag to the right. Column A will re-size as you drag. Make
it wider so that the words Jan/Mar Sales comfortably fit in the

column:
A B C ]

1 |Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar
4 |New York 22,000 29,000 19,000
5 |Los Angeles 42,000 39,000 43,000
6 |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 |Munich 12,000 15,000 13,000
9 |USA Sales 64,000
‘IDlJan;"Mar Sales ]

4 Use AutoSum to calculate the total sales for January and

March in cell B10.

1. Click Home%Editing% (the AutoSum button).

An AutoSum appears in cell B10 but it isn’t the formula you
need. AutoSum guesses that you simply want to repeat the
value in the USA Sales cell.

8 |Munich

9 |USA Sales
10|Jan;"MarSales
11

12,000

=SUM(BS)

15,000

SUM{number1, [number2], ...)

13,000

2. Select the range B4:B8 with the mouse.
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5

3. Hold down the <Ctrl> key and select the range D4:D8 with the

mouse.

Notice that the non-contiguous range B4:B8,D4:D8 is shown in
the AutoSum’s formula:

A

Mew York
Los Angeles
London
Paris
Munich
USA Sales

W00 LN ke WP =

11

Sales and Profit Report - First Quarter 2016

B & D

Jan Feb Mar
22,000 29,000 19,000
42,000 39,000 43,000
18,000 20,000 22,000
35,000 26,000 31,000
120000 15000} 13,000
64,000

‘IDlJan,fMarSales |=SUM{B4:BS,D4:D8}

SUM

(number1, [number?], ...}

4. Press the <Enter> key or click the AutoSum button again to
show the sales for January and March in cell B10.

A

1

2

2

4 |New York

5 |Los Angeles
6 |London

7 |Paris

8 |Munich

9 |USA Sales

10 [Jan/Mar Sales

Jan

B

Sales and Profit Report - First Quarter 2016

22,000
42,000
18,000
35,000
12,000
64,000
257,000

C D E

Feb Mar Total
29,000 15,000 70,000
39,000 43,000
20,000 22,000
26,000 31,000
15,000 13,000

Save your work as First Quarter Sales and Profit-5.

© 2018 The Smart Method® Ltd
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> AutoSum *'L\\S&W
> sum
Average
Count Numbers
Max
Min

More Functions...

First Quarter Sales and
Profit-5

Lesson 2-11: Use AutoSum to
calculate average and
maximum values

1 Open First Quarter Sales and Profit-5 from your sample files
folder (if it isn’t already open).

2  Delete cells E3:E4.

Select cells E3 and E4 and press the <Delete> key on your
keyboard.

3 Type the word Average in cell E3 and press the <Enter>
key.

The cursor moves to cell E4:

A E < D E

3 lan Feb Mar Average
4 |NEW York 22,000 29,000 19,000 | .I

4 Use AutoSum to create a formula that will show the average
New York sales in cell E4.

1. Click: Home->Editing> AutoSum->Drop-down arrow
(see sidebar).

A drop-down menu is displayed showing different ways in
which AutoSum can operate upon a range of cells:

2. Click Average.

Excel generates an AVERAGE function and inserts the cell
range B4:D4. This is exactly what you want:

E F G

| Average
=AVERAGE(E4:D4)
AVERAGE(number1, [number2], ...)

3. DPress the <Enter> key or click the AutoSum button again to
see the average sales for New York:

3 Jan Feb Mar Average
4 |New York 22,000 29,000 15,000 23,333

) Type the word: Maximum into cell F3 and then press the
<Enter> key.

6 Use AutoSum to create a formula in cell F4 that will show the
Maximum New York Sales for this period.

1. Place an AutoSum in cell F4 but this time, choose Max from the
drop-down menu.

This time you have a small problem. AutoSum is including the
average value (23,333) in the calculation.
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tip
Another way to bring back the
blue box showing a range is to

click the range in the Formula
Bar.

are included in the Sales total.

Notice that there is a small blue spot on each corner of the range.
These are called sizing handles.

1.

Hover the mouse cursor over the bottom right (or bottom left)
sizing handle until the cursor shape changes to a double-
headed arrow. It is really important that you see the double-
headed arrow and not the four-headed arrow or white cross.

[ ] [ ]

4 |New York | 22,000'
5 |Los Angeles 1 42,000

. ——

When you see the double headed arrow click and drag with
the mouse down to cell BS.

Release the mouse button.

Press the <Enter> key or click the AutoSum button again.

A B

3 Jan

4 New York 22,000
5 |Los Angeles 42,000
6 |London 18,000
7 |Paris 35,000
8 |Munich 12,000
g |Sales 125,000
10 |Jan/Mar Sales 257,000

10 Save your work as First Quarter Sales and Profit-6.

B C D E F
Jan Feb Mar Average Maximum
H 22,000 29,000 13,000 23,323 i=MAX(E2E4)

2. Select cells B4:D4 with the mouse
The marquee now covers the correct cells.

3 _Jan Feb Mar Average Maximum

4 |newvork | 22,000 29,000 15,000 | 23,333 [=MAX(B2:D4)
Notice that the MAX function is now working with the
(correct) range B4:D4.

3. Press the <Enter> key or click the AutoSum button once
more to see the maximum sales the New York office managed
during the first quarter of the year:

3 Jan Feb Mar Average Maximum
4 |New York 22,000 29,000 19,000 23,333 29,000
7 Change the words USA Sales in cell A9 back to Sales and
press the <Tab> key.
8 Press the <F2> key on the keyboard (or double-click cell B9)
to bring back the marquee (shown as a blue box).
9 Adjust the marquee using click and drag so that all offices

© 2018 The Smart Method® Ltd
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Lesson 2-12: Create your own
formulas

The AutoSum tool is very useful for quickly inserting SUM(),
AVERAGE(), COUNT(), MAX() and MIN() formulas into cells. Many
Excel users never get any further with their formulas than this.

In this session, you'll create your own formulas without the use of
AutoSum. You'll be amazed at how easy it is.

1
2
3
4
5

iIimportant

Formulas automatically

recalculate whenever any of the

cells in the formula change.

For example: If you were to 6

change the Paris sales to 45,000
this would cause cell B9 to re-
calculate to 139,000.

Because B9 has changed this
would, in turn, cause the profit
to recalculate to 56,000.

First Quarter Sales and
Profit-6

Open First Quarter Sales and Profit-6 from your sample files
folder (if it isn’t already open).

Select cells A10:B10 and press the <Delete> key once.
The previous contents of cells A10:B10 are removed.
Type the word Costs into cell A11 and Profit into cell A12.

Type the value 83,000 into cell B11 and press the <Enter>
key to move down to cell B12.

11 |Costs
12 | profit

83,000

Enter a formula into cell B12 to compute the profit made in
January.

1. Type: =B9-B11 into cell B12.
2. Press the <Enter> key.
The profit for January is displayed:

8 Sales 125,000
10

11 |Costs 83,000
12 |Profit 46,000

Enter the formula again using the mouse to select cell
references.

The method that you have just used to enter the formula works
just fine but it isn’t the best method. Eventually you will make a
mistake. For example, you could easily type =B8-B11 resulting in
an incorrect answer.

To eliminate such errors, you should always select cell references
visually rather than simply typing them in. You can visually select
cells using either the mouse or the keyboard. First, you'll use the
mouse method.

1. Clickin cell B12 and press the <Delete> key on the keyboard to
clear the old formula.

2. Press the equals <=> key on the keyboard.
3. Click once on the value 129,000 in cell B9.

4. Press the minus <-> key on the keyboard.
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+

E'S

important

Addition
Subtraction
Multiplication
Division
Percent

Exponentiation

The Excel Operators

Name Example

1+2
7-5
6*3
15/5
25%
472

5. Click once on the value 83,000 in cell B11.
6. Press the <Enter> key on the keyboard.

If you followed the above steps carefully you will see that you
have created the same formula but with a much lower possibility
of making a mistake.

Enter the formula again using the visual keyboard technique.

The very best Excel experts hardly use the mouse. You waste
valuable seconds every time you reach for the mouse.

Here’s the expert technique of visual selection via keyboard:

1. Use the arrow keys to navigate to cell B12 and then press the
<Delete> key on the keyboard to clear the old formula.

2. Press the <=> key on the keyboard.

3. Press the <Up Arrow> key three times to move to cell B9.
4. Press the <-> key on the keyboard.

5. Press the <Up Arrow> key once to move to cell B11.

6. Press the <Enter> key on the keyboard.

Enter a formula that uses the multiplication operator to
calculate a 10% bonus paid upon profits.

This employer is very generous and pays the staff ten percent of all
profits as an incentive bonus.

In cell A13 type the words: 10% Bonus and then press the <Tab>
key on the keyboard to move to cell B13.

The multiplication operator is not an X as you might expect but an
asterisk (¥). The other Excel operators are shown in the sidebar.

You need to press <Shift>+<8> to enter an asterisk. If you are using
a full size keyboard with a numeric keypad at the right-hand side
you can also use the numeric keypad’s <*> key.

Whichever key you use you'll still see an asterisk in the formula.

Use either the mouse selection technique or the visual keyboard
technique to enter the formula shown below into cell B13 and then
press the <Enter> key to see how much bonus was earned:

A B
11 |Costs 83,000
12 | profit 46,000
13]10% Bonus  [=812*0.1]

Note that multiplying a value by 0.1 calculates ten percent of the
value. If you progress to the Essential Skills course in this series,
you'll learn more about calculating percentages in: Lesson 4-3:
Format numbers using built-in number formats.

11 |Costs 83,000
12 |Profit 46,000
13 [10% Bonus 4,600

Save your work as First Quarter Sales and Profit-7.

© 2018 The Smart Method® Ltd
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trivia

The feature that Excel uses to
help you out with function calls
first made an appearance in 1
Visual Basic 5 back in 1996 and

had the wonderful name:

IntelliSense. The Excel 2
implementation is called

Formula AutoComplete.

In 1996 I was working in 3
Switzerland (as a programmer

and analyst) developing a ski-

school management

application. I was extremely

impressed by how easy

IntelliSense made my job. I

didn’t have to remember

hundreds of function names

any more. 4

I was even slightly worried that
just about anybody could now
program (but, of course, I was
wrong).

Recently I was in London being
driven by a Hackney cab driver
(Hackney cab drivers know
every shortcut and back street
in London). He was worried
that Satellite Navigation would
now mean that anybody could
become a London cabbie.

Of course, he really had
nothing to worry about either.

note

Excel automatically
adds closing brackets
to functions

If you type:

=SUM(B4:B5

... and then press the <Enter>
key, Excel will automatically

add the closing bracket for you
resulting in:

=SUM(B4:B5)

First Quarter Sales and
Profit-7

Lesson 2-13: Create functions
using Formula AutoComplete

Open First Quarter Sales and Profit-7 from your sample files
folder (if it isn’t already open).

Type the words USA Sales into cell A15 and European
Sales into cell A16.

If necessary, re-size column A so that it is wide enough for
the words European Sales to fit within the column.

You learned how to do this in: Lesson 2-9: Re-size rows and columns.

A
15 |USA Sales
16 |European Sales

Click into cell B15 and type =S into the cell.

Something amazing happens:

15 |usa sales =S |

16 |European Sales _M
17 ) sEC

18 () SECH

(%) SECOND

A0

A list appears showing every function in the Excel function library
beginning with S. This feature is called Formula AutoComplete (if
AutoComplete didn’t display as expected see the facing-page
sidebar).

You've already encountered the SUM, AVERAGE and MAX
functions courtesy of AutoSum.

You may be pleased (or dismayed) to know that there are over 450
functions in the Excel function library. The good news is that most
untrained Excel users only ever get to understand SUM and
AVERAGE.

When you typed =S Excel listed all functions beginning with S.
Continue typing: =SU

Notice that the list now only shows functions beginning with SU
and look... there’s the SUM() function you need three down in the
list.

You could simply click on the Sum() function with the mouse but
let’s work like an Excel pro and use the keyboard.

Press the <Down Arrow> key twice to move the cursor over
the SUM function.

The SUM function now has a tip telling you what the function
does:
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note

Enabling and
disabling
AutoComplete

As with so many other features,
Microsoft allows you to turn
this very useful feature off.

You’d never want to do this but
you may work on a machine
that has had Formula
AutoComplete switched off
and you need to turn it on
again.

Click: File>Options->Formulas
and make sure that the Formula
AutoComplete box is checked.

note

The syntax box

The Syntax box tells you which
arguments (sometimes called
parameters) the function needs.

SUM(number1, [number2], ...) |

The first argument has no
square brackets meaning that
you can’t leave it out.

The second argument (shown
in square brackets) is optional.

The third argument is an
ellipsis (a row of three dots).
This means that you could
continue with more arguments
such as [number3], [number4]
etc.

For such a simple function as
SUM the syntax box is hardly
needed but later you'll
encounter functions that
require several arguments and
then the syntax box will be
invaluable.

13 |USA Sales
16 |European Sales

64,000
65,000

8

10

11

15 [usa sales [=su |

16 |European Sales | | (&) SUBSTITUTE
17 %) SUBTOTAL
13 ®
Adds all the numbers in a range of cells

Display Excel’s help topic for the SUM function.

The tip tells you a little about the SUM function but to get the full
story press the <F1> key while SUM is still highlighted in the
dropdown list.

The Excel help system opens showing detailed help for the SUM
function.

Read the help text if you are interested and then close the help
window.

Notice that Excel has now left you with only =SU in the cell.
Complete the formula by typing: M(

SUM{number1, [number], ...}

15 |usa sales
16 |European Sales

Notice that a little box has appeared beneath the function. This box
displays the Syntax of the SUM function (see sidebar for more
information).

Select the cells that you need to sum (cells B4:B5) with the
mouse or keyboard.

If you want to be a real pro you should select them with the
keyboard. To do this:

1. Press the <Up Arrow> key repeatedly until you reach cell B4.

2. Hold down the <Shift> key and press the <Down Arrow> key
once to select cells B4:B5.

Type a closing bracket to complete the formula and then
press the <Enter> key.

The total USA sales are displayed in cell B15.

Use the same technique to create a SUM() function in cell
B16 to show the total European sales (cells B6:B8).

1. Click in cell B16.
2. Type=SU

3. DPress the <Down Arrow> key twice to move the cursor over
the SUM function.

4. Press the <Tab> key to automatically enter the SUM function
into cell B16.

5. Select the range B6:B8.

6. Type the closing bracket (this isn't actually necessary — see
sidebar facing page).

7. Press the <Enter> key.
The formula should now be: =SUM(B6:B8)

12 Save your work as First Quarter Sales and Profit-8.

© 2018 The Smart Method® Ltd
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Lesson 2-14: Use AutoFill for
text and numeric series

1

2

note

If you don’t see the
AutoFill handle
somebody has
disabled AutoFill

It's almost certain that AutoFill

will be enabled on any

computer that you work on. It 4
is such a useful feature that you
wouldn’t want to disable it.

If you don’t see the AutoFill
handle (the black spot on the
bottom right hand corner of the
active cell) it’s because
somebody has switched
AutoFill off.

To bring it back click:
File->Options—=>Advanced

In the first section (Editing
Options) check the box next to
Enable fill handle and cell drag-
and-drop.

First Quarter Sales and
Profit-8

Open First Quarter Sales and Profit-8 from your sample files
folder (if it isn’t already open).

Delete the text Feb and Mar from cells C3:D3.

Select cells C3:D3 and then press the <Delete> key on your
keyboard.

Make B3 the active cell

Click once inside cell B3. Notice that there is a green border
around the cell and a spot on the bottom right-hand corner. This is
the AutoFill handle. If you don't see it, refer to the sidebar.

Autofill
[ 1 Handle

Hover over the AutoFill handle with your mouse until the
cursor shape changes to a black cross.

Many of my students have great difficulty with this when they try
it for the first time.

e You don’t want the four-headed arrow: + — that would move
the cell.

e  You don’t want the white cross: E‘I}l — that would select the
cell.

e You want the black cross: + — the AutoFill cursor.

Jan

When the black cross cursor is visible, hold down the mouse
button and drag your mouse to the right to AutoFill the other
months: Feb and Mar.

| Jan | .!+

22,000 29,000 ,.,19,000°

Notice the tip that appears as you drag, previewing the month that
will appear in each cell.

When you release the mouse button, the name of each month
appears in cells C3 and D3.

B C D
3 | Jan Feb Mar |

Type: Monday into cell A18 and AutoFill down to cell A24 to
show the days of the week.

(If you are not using an English language version of Excel you will
need to type Monday in your own language).
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tip
You don’t have to enter two

numbers if you want to create a
numeric range.

If you simply type a number
into a cell and then AutoFill
while holding down the <Ctrl>
key, you will automatically
generate sequential numbers.

10
11

12

13

14

15

In cell B18 type the number 1 and in cell B19 type the
number 2.

Select cells B18 and B19.

1
g 2
AutoFill down to B24 to create sequential numbers:
A E
18 |Monday 1
19 |Tuesday 2
20 |\Wednesday 3

In cell C18 type 9 and in cell C19 type 18.
Select cells C18 and C19.

o]

AutoFill down to cell B24 to create the nine times table.

A E C
18 |Monday 1 9
18 |Tuesday 2 18
20 |\Wednesday 3 27

These are both examples of linear series. You'll learn more about
linear series later, in: Lesson 2-18: Understand linear and exponential .

Use AutoFill to create sequential dates.

1. Type: 01-Jan-16 into cell D18.

2. Type: 02-Jan-16 into cell D19.

3. Select cells D18:D19.

4. AutoFill down to D24 to create sequential dates.
Use AutoFill to quickly copy text.

Sometimes you will want to duplicate the value from one cell into

many others to the right of, left of, beneath, or above the active cell.

When a cell containing text is the active cell and it isn’t defined as a

fill series (the built-in fill series are days of the week and months of
the year), AutoFill will simply duplicate the contents of the cell.

Type the text Adjusted into cell E18 and then AutoFill it down as
far as cell E24. The same text is now shown in each of the cells:

A B C D E
18 |Monday 1 9 01-Jan-16 Adjusted
19 | Tuesday 2 18 02-Jan-16 Adjusted
20 'Wednesday 3 27 03-Jan-16 Adjusted
21 | Thursday 4 36 04-Jan-16 Adjusted
22 Friday 5 45 05-Jan-16 Adjusted
23 |Saturday 6 54 06-Jan-16 Adjusted
24 |Sunday 7 83 07-Jan-16 Adjusted

Save your work as First Quarter Sales and Profit-9.

© 2018 The Smart Method® Ltd
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First Quarter Sales and
Profit-9

Lesson 2-15: Use AutofFill to
adjust formulas

AutoFill can save you a lot of time when extending or copying text and
number sequences. But the story’s not over yet.

AutoFill’s ability to copy and adjust formulas is one of the most powerful
tools in Excel’s impressive armory.

1 Open First Quarter Sales and Profit-9 from your sample files
folder (If it isn’t already open).

2 Consider the formula in cell B9.

Click onto cell B9 and view the formula displayed in the formula
bar (the formula bar is at the top right of the screen grab below).

BS - 5 =SUM(B4:B8)
A B i D E
1 |Sales and Profit Report - First Quarter 2016
2 Formula Bar
3 Jan Feb Mar Average
4 |New York 22,000 29,000 19,000 23,333
5 |Los Angeles 42,000 33,000 43,000
& |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
& |Munich 12,000 15,000 13,000
9 [sales [ 129,000

The formula is =SUM(B4:B8). AutoSum created it for you in:
Lesson 2-3: Use AutoSum to quickly calculate totals. The formula uses
the SUM function to add together the values in the range B4:B8.

Think about the formula that would work in cell C9 (the total sales
for February). It would be: =SUM(C4:C8). Similarly the formula
that would work in cell D9 (the total sales for March) would be
=SUM(D4:DS8).

As you move to the right, all that is needed is to increment the
letter for each cell reference in the formula and you’ll get the right
answer every time.

AutoFill is very clever and realizes this. When you AutoFill a cell
containing a formula to the right, AutoFill increments the letters in
each cell reference.

Most of the time that is exactly what you want.

There’s also a way to fine-tune the way in which AutoFill adjusts
cell references, allowing you to implement some more advanced
AutoFill techniques. While this is beyond the scope of this Basic
Skills book, it is covered in-depth in the Essential Skills book in this
series (in Lesson 3 12: Understand absolute and relative cell references,
and Lesson 3 13: Understand mixed cell references).

3 AutoFill cell B9 to the right as far as cell D9.

You learned how to do this in: Lesson 2-14: Use AutoFill for text and
numeric series.
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E
Average
23,333
41,333
20,000
30,667
13,333

F
Maximum
29,000
43,000
22,000
35,000
15,000

You may see a row of hashes in cell C9 and/or D9. This is because
the value may be too wide to fit in the cell. If this is the case,
AutoFit the column using the skills learned in: Lesson 2-9: Re-size
rows and columns.

The correct answers for Feb and Mar sales are shown on the
worksheet. Click on the Feb total cell (C9) and look at the formula
in the formula bar.

C9 - F =SUM(C4:C8)

A B C D
1 |Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar
4 |New York 22,000 25,000 15,000
5 |Los Angeles 42,000 39,000 43,000
& |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 |Munich 12,000 15,000 13,000
9 |Sa|es 129,000 | 125,000 | 128,000

You can see that AutoFill has done its job perfectly, creating the
sum of the values in cells C4:C8. Our five branches have sold
exactly the same amount in both January and February, but a little
less in March.

Consider the formula in cell E4.

Click onto cell E4 and view the formula displayed in the formula
bar.

E4 - 5 =AVERAGE(B4:D4)

A B C D E
1 |Sales and Profit Report - First Quarter 2016
2

3 Jan Feb Mar Average
4 |New York 22,000 29,000 19,000 | 23,333 .l

5 |Los Angeles 42,000 39,000 43,000
& |London 18,000 20,000 22,000

The formula is =AVERAGE(B4:D4). AutoSum created it for you
in:

Lesson 2-11: Use AutoSum to calculate average and maximum values.

Think about the formula that would work in cell E5 (the average
sales for Los Angeles). It would be: =AVERAGE(B5:D5). Similarly
the formula that would work in cell E6 (the average sales for
London) would be =AVERAGE(B6:D6).

As you move downward, all that is needed is to increment the
number for each cell reference in the formula. This is exactly what
AutoFill will do.

AutoFill cell E4 down to E8 to see the average sales for each
branch.

AutoFill cell F4 down to F8 to view the maximum sales for
each branch.

Save your work as First Quarter Sales and Profit-10.

© 2018 The Smart Method® Ltd
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First Quarter Sales and
Profit-10

Lesson 2-16: Use AutofFill
options
Sometimes AutoFill begins to misbehave and actually gets in the way of

efficient work by wrongly anticipating what you need.

1 Open First Quarter Sales and Profit-10 from your sample
files folder (If it isn’t already open).

2 Populate cells F18 to F24 with sequential dates beginning
with 1-Jan-16 using AutoFill.

1. In cell F18 type the date: 1-Jan-16
2. AutoFill cell F18 down as far as cell F24.

The cells are populated with sequential dates:

A B C D E F
18 Monday 1 9 01-Jan-16 Adjusted 01-lJan-16
19 | Tuesday 2 18 02-Jan-16 Adjusted 02-lJan-16
20 |Wednesday 3 27 03-Jan-16 Adjusted 03-Jan-16
21 |Thursday 4 36 04-Jan-16 Adjusted 04-Jan-16
22 |Friday 5 45 05-Jan-16 Adjusted 05-Jan-16
23 |Saturday 6 54 06-Jan-16 Adjusted 06-Jan-16
24 |Sunday 7 63 07-Jan-16 Adjusted 07-Jan-16

3 Populate cells G18 to G24 with the date 37-Mar-16 using the
AutoFill Smart Tag.

1. In cell G18 type the date: 31-Mar-16.
2. AutoFill down as far as cell G24.

At some time, you'll need to add transaction dates to a
worksheet and will have four or five entries with the same
date.

AutoFill is perfect for eliminating the need to re-type the date
for each transaction, but its insistence upon incrementing the
date every time could be very frustrating.

Fortunately, you can change the default behavior.

=

3. Click the Auto Fill Options Smart Tag
corner of the filled cells.

at the bottom right

04-Apr-16
05-Apr-16
06-Apr-16

O Copy Cells %
B Fin series

O Fill Eormatting Only

O Fill Without Formatting
O Fill Days

O Fill Weekdays

O Fill Months

O Fill Years

O Elash Fill
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4. Click Copy Cells to tell AutoFill not to increment the date.
4 Understand AutoFill options.

The Fill Formatting option is beyond the scope of this Basic Skills
book but is covered in-depth in the Essential Skills book in this
series (in Session Four: Making Your Worksheets Look Professional).

Flash Fill will be introduced later in: Lesson 2-19: Use automatic Flash
Fill to split delimited text. Here’s what the other options will do:

Copy Cells

Fill Series

Fill Days

Fill Weekdays

Fill Months

Fill Years

This is what The default | The date Because 1+t April | Normally this would | The same
we just did. for dates that | increments 2016 is a Friday | show the same day calendar day
. . | include the by one day at | the weekend number for each is shown for
The first cell is ) ] ]
. day. a time. days are omitted | month. In this each
copied to the .
and the series example, there are subsequent
other cells. The date ) .
increments jumps from 1st only 30 days in three | year.
April to 4t of the months so 30t
by one day at , . .
. April. is shown instead of
a time.
31st.
31-Mar-16 31-Mar-16 31-Mar-16 31-Mar-16 31-Mar-16 31-Mar-16
31-Mar-16 01-Apr-16 01-Apr-16 01-Apr-16 30-Apr-16 31-Mar-17
31-Mar-16 02-Apr-16 02-Apr-16 04-Apr-16 31-May-16 31-Mar-18
31-Mar-16 03-Apr-16 03-Apr-16 05-Apr-16 30-Jun-16 31-Mar-19
31-Mar-16 04-Apr-16 04-Apr-16 06-Apr-16 31-Jul-16 31-Mar-20
31-Mar-16 05-Apr-16 05-Apr-16 07-Apr-16 31-Aug-16 31-Mar-21
31-Mar-16 06-Apr-16 06-Apr-16 08-Apr-16 30-5ep-16 31-Mar-22
5 Populate cells F18 to F24 with sequential dates using a right-
click AutoFill.
1. Click on cell F18 to make it the active cell.
Conv Cells 2. AutoFill down to cell F24, but this time hold down the right
= mouse button instead of the left.
Fill Series

Fill Formatting Cnly

Fill Without Formatting

Fill Days

Fill Weekdays

When you release the mouse button you are instantly
presented with the AutoFill options (see sidebar).

There are two new options here: Linear Trend and Growth
Trend.

You'll learn how these can be used later, in: Lesson 2-18:
Understand linear and exponential series.

Fill Months
o This method is preferred to the Smart Tag method because it is
Fill Years faster (one click instead of two).
3. Click: Fill Series or Fill Days.
In this example Fill Series and Fill Days produce exactly the
Flach Fill same result.
Series... 6  Save your work as First Quarter Sales and Profit-11.

© 2018 The Smart Method® Ltd

93



Learn Excel 2016 Basic Skills with The Smart Method

Lesson 2-17: Speed up your
AutoFills and create a custom
fill series

In this lesson, you're going to learn some advanced AutoFill techniques
that will massively speed up your efficient use of the AutoFill feature.

1 Open First Quarter Sales and Profit-11 (if it isn’t already
open).

2 Use an AutoFill double-click to populate cells G19:G24 with
sequential dates.

1. Delete the contents of cells G18:G24.
2. Type: 31-Mar-16 into cell G18.

A B e D E F G

17

18 |I\.-'I0nda\,-r 1 9 01-Jan-16 Adjusted Dl-Jan-lﬁl 31-I\-"Iar—16_|
19 | Tuesday 2 18 02-Jan-16 Adjusted 02-Jan-16

20 \Wednesday 3 27 03-lan-16 Adjusted 03-Jan-16

21 |Thursday 4 36 04-Jan-16 Adjusted 04-Jan-16

22 |Friday 5 45 05-Jan-16 Adjusted 05-Jan-16

23 |Saturday 6 54 06-Jan-16 Adjusted 06-Jan-16

24 |Sunday 7 63 07-Jan-16 Adjusted 07-Jan-16

3. Double click the AutoFill handle to automatically fill cells
G19:G24.

Hover over the AutoFill handle (the black spot at the bottom
right hand corner of cell G18). When you are sure that you
have the correct black cross cursor shape, double click to
automatically fill down to the end of the range.

3 Use an AutoFill <Ctrl>-Drag to copy the value in cell G18 to
cells G19:G24.

1. Delete all of the dates from cells G19:G24 leaving only the date
31-Mar-16 in cell G18.

2. Click in cell G18 to make it the active cell.

3. Hold down the <Ctrl> key and AutoFill cell G18 down as far as
cell G24 by dragging the AutoFill handle down with the
mouse.

4. Release the mouse button.

Because you held the <Ctrl> key down, AutoFill simply copied
the cell instead of creating a series of values.

A B T D E F G

17

18 |Monday 1 9 0l-Jan-16 Adjusted 01-Jan-16 31-Mar-16

19 | Tuesday 2 18 02-Jan-16 Adjusted 02-Jan-16 31-Mar-16

20 \Wednesday 3 27 03-Jan-16 Adjusted 03-Jan-16 31-Mar-16

21 |Thursday L] 36 04-Jan-16 Adjusted 04-Jan-16 31-Mar-16

22 |Friday 5 45 05-Jan-16 Adjusted 05-Jan-16 31-Mar-16

23 |Saturday 6 54 06-Jan-16 Adjusted 06-Jan-16 31-Mar-16
First Quarter Sales and 24 |Sunday 7 63 07-Jan-16 Adjusted 07-Jan-16 31-Mar-16

Profit-11
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MNorth
South
East
West
Morth
South
East
West

This is even faster than using the right-click method when you

want to prevent the date (or a number) from incrementing.

Create a custom list containing the values: North, South,
East and West.

1. Click: File>Options—> Advanced.

2. Scroll down to the General category and click the Edit Custom

Lists... button.

Edit Custom Lists...

The Custom Lists dialog appears.

3. Click in the List entries window and add four custom list

entries: North, South, East and West (pressing the <Enter> key

after each entry).

Custom Lists ?
Custaom Lists
Custom Jists: List entries:
MEW LIST MNarth Add
Mon, Tue, Wed, Thu, Fri, Sat, 5 South
Monday, Tuesday, Wednesday, East
Jan, Feb, Mar, Apr, May, Jun, It West
January, February, March, Apri
Press Enter to separate list entries.
Import list from cells: 5G518:5G524 Rz Import

4. Click the OK button and OK again to close the dialogs.
Use the newly created custom list.

Type North in any cell and AutoFill down.

As you AutoFill, the custom list entries appear in the worksheet
(see sidebar).

Delete the North, South, East, West... cells from the
worksheet.

Save your work as First Quarter Sales and Profit-12.

© 2018 The Smart Method® Ltd
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important

A synonym is a word you use
when you can'’t spell the other one.

Baltasar Gracidin
(Philsopher 1601-1658)

Excel uses different
terminology in various menus,
dialog boxes and task panes
that mean the same thing (in
the context of this lesson):

Series, Forecast and Trend mean
the same thing.

Growth and Exponential also
mean the same thing.

In this lesson I'll consistently
use the terminology Series and
Exponential.

note

Excel can calculate a
linear series when the
step values of cells
are not equal

Excel calculates a linear series
(AutokFill also calls this a fill
series) using this formula:

Start Value + Step Value

Sometimes you may need to
produce linear series values
from a series of numbers that
have different step values. For
example, consider this range:

A B
2 |Value Step Value
2 1
4 2.1 1.1
5 2.9 0.8
6 4.1 1.2

In this case Excel will use a
more complex mathematical
operation (called the least-
squares algorithm) to determine
the correct step value to use. In
the above example, Excel
would calculate a step value of
1.01.

’/Rabbit Population |

Lesson 2-18: Understand
linear and exponential series

Linear series

In: Lesson 2-14: Use AutoFill for text and numeric series, you used AutoFill’s
Fill Series method to automatically create these numeric series:

A E <
18 |Monday 1 9
18 |Tuesday 2 18
20 |\Wednesday 3 27

These are both examples of Linear series.

Imagine that you had originally selected cells B1:B2 before AutoFilling
column B:

B
1 9
2 18
3

To calculate a linear series Excel first identifies the step value. The linear
series in column B has a step value of nine (18-9=9).

When you use AutoFill to Fill Series, Excel adds the step value to the start
value (the number shown in the previous cell).

After you have AutoFilled down to cell B3, the value shown in cell B3
will thus be twenty-seven (18 (the start value) +9 (the step value) = 27)

This is an example of a very simple linear series. Excel is also able to
calculate a linear series even when the step values of the selected cells are
not equal (see sidebar).

Exponential (or Growth) series

An exponential series is calculated by multiplying (rather than adding) the
start value by the step value. This type of series is usually referred to as an
exponential (rather than linear) series. Excel also uses the term growth
series as a synonym for exponential series (see sidebar).

Here’s an example:

e A truly excellent restaurant opens in town. On the first day they only
have one customer, but the customer is so delighted by the food,
service and value that the customer tells two friends.

e The next day the two friends eat there, and the restaurant has two
diners.

e The two friends are also so pleased with their experience that they
each tell two friends. On the third day the restaurant has four diners.

You can see that the restaurant owner might expect that this trend will
continue and that each day the number of diners will double (in Excel’s
terminology, the step value is 2). Eventually, of course, the restaurant will
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note

Here’s how you could have
used the Ribbon to complete
this lesson:

1. Enter the value 200 into cell
B4.

2. Select cells B4:B51.

3. Click: Home->Editing—>
Fill>Series...

The Series dialog appears.

4. Enter the following values
into the Series dialog;:

Series ? hat

Series in Type Date unit

) Rows () Linear Day

(® Columns ®) Growth Weekday
() Date Month
() autaFill Year

Stepvalue: | 1.2 Stop value:

Cancel

Note that the value: 1.2 is used
because an exponential
(growth) series multiplies each
start value by the step value.

trivia

According to an old legend, the
inventor of the game of Chess
presented his new game to a
powerful king. The king was
so pleased with the game that
he offered the inventor any
reasonable reward.

The inventor asked for one
grain of rice for the first square
on the chessboard, two for the
second, four for the third... and
so on for each square on the
chessboard.

The king thought the inventor
was foolish to ask for such a
simple gift. Much later he
found that there was not
enough rice in the entire world
to fulfil the inventor’s request.

With the Excel skills you have
learned in this lesson, you
should easily be able to model
the King’s dilemma and
discover exactly how many
grains of rice would have been
needed (about 18.5 Quintillion).

become full and the trend will have to end (in Excel’s terminology the
number of seats in the restaurant is the stop value).

In this lesson you will model this type of exponential series.

1
2

3

Open Rabbit Population from your sample files folder.

If the rabbit population of an island increases at the rate of
20% per month, use an exponential progression to calculate
how a newly introduced community of 200 rabbits will grow
in four years.

1. Type the value: 200 into cell B4 to set the rabbit population at
the beginning of the period.

2. Type the value: 240 into cell B5 to set the rabbit population
after one month.

3. Select the range B4:B5.

4. Hold down the right-click mouse button on the AutoFill
handle at the bottom-right of the selected range and drag
down to AutoFill to cell B51.

A

Month

B LD P =

= |h LA

B

Rabbit Population

Population
200
240

1
2
2 3
4

q

5. Click Growth Trend on the shortcut menu. Note that this is the
shortcut menu’s synonym for: Exponential Series.

I
37

38
39
40
41
42
43
44
45
46
47
48
49
50
31

Copy Cells
Fill Series
Fill Eormatting Only

Fill Without Formatting

Linear Trend
ﬁrowit}Trend
FElash Fill

Series...

After four years (48 months) the 200 rabbits will have grown to
a population of a little over a million.

A

B
46 731,452
47 877,743
48 1,053,291

Save your work as Rabbit Population-1.

© 2018 The Smart Method® Ltd
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note

If Flash Fill doesn’t
work for you,
somebody has
switched it off

It’s almost certain that Flash Fill
will be enabled on any
computer that you work on. It
is such a useful feature that you
wouldn’t want to disable it.

If Flash Fill doesn’t work, there
are two possible explanations:

1. You are using an earlier
version of Excel. Flash Fill is a
relatively new feature
introduced in Excel 2013.

2. Somebody has switched
Flash Fill off.

To switch it back on click:
File->Options—>Advanced

In the first section (Editing
Options) make sure that the
Automatically Flash Fill check
box is checked.

note

Help Flash Fill to work
correctly by
formatting header
rows differently

You will notice that, in this
lesson’s sample file, I have
bold-faced the header row:

B C
3 |First Name Last Name
4 |lessica Sagan
5 |Stephen  Bell
6 |John Jennings

When Flash Fill sees different
formatting in the first row, it
will treat this row (correctly) as
a header row. Flash Fill then
excludes the values in this row
from its logic, providing more
reliable results.

Employee Names-1

Lesson 2-19: Use automatic
Flash Fill to split delimited text

When you place data in cells it is useful to observe an important rule:
“Keep data atomic”

If you strictly observe this rule, you'll avoid an enormous number of
potential problems.

The rule means that, in the same way that the atom is the smallest basic
unit you can divide matter into, each worksheet cell should contain the
smallest possible amount of data.

Here’s a simple example to illustrate the concept:

A B
Name

AW

Jessica Sagan
Stephen Bell
John Jennings

o Ln

Imagine that you want to use the worksheet above to create a mail merge
in Word. In this case you'd need the first names in a cell of their own.
This would enable you to personalize the mail merge with an
introduction such as: Dear Jessica.

If you had observed the keep data atomic rule, you would have split your
data into multiple columns like this:

B i€
3 |First Name Last Name
4 |lessica Sagan
5 Stephen  Bell
6 |John Jennings

Excel 2013 added a wonderful new feature called Flash Fill. This feature
enables you quickly and simply split delimited text (such as the above)
into separate cells. The term delimited text means text that is split using a
separator. In this case the separator is a space (see facing page sidebar).

Automatic Flash Fill will only work for very simple text splitting tasks
such as the one described above. In the lessons that follow you'll learn
more complex Flash Fill techniques that will enable you to perform some
very advanced text splitting tasks.

1 Open Employee Names-1 from your sample files folder.

2 Add column headings for First Name and Last Name in cells
B3 and C3.

1. Clickin cell B3.
Type: First Name

2
3. Press the <Tab> key to move to cell C3.
4. Type: Last Name

5

Press the <Tab> key to save the value into the cell and move to
cell D3.

3 Bold face the text in cells B3 and C3.
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note

Limitations of
automatic Flash Fill

Automatic Flash Fill always
works perfectly when the
source data column has the
same type of separators.

In this lesson’s example, space
separators are used. The
following example (using
comma separators) would also
work perfectly:

Sting, Musician
Kingdom Brunel, Engineer

Billie Jean King, Tennis Player

You can see that, without the
commas, Flash Fill wouldn’t
know where the name ended
and the occupation began.

Sometimes you will need to
extract data that does not have
separators.

You’ll discover how to solve
this type of problem later, in:
Lesson 2-20: Use manual Flash
Fill to split text.

note

Use automatic Flash
Fill to extract initials

You can often save a lot of
space by showing initials
instead of full names.
Automatic Flash Fill is well
suited to this task.

Try this (at the end of the
lesson, after populating
columns B and C with first and
last names).

1. Type:]S (for Jessica Sagan)
in cell D4.

2. Type S (Stephen Bell’s first
initial) into cell D5.

3. Press the <Enter> key to

You learned how to do this in: Lesson 1-15: Use the Mini Toolbar, Key
Tips and keyboard shortcuts.

A B C
3 Name First Name Last Name

Use Flash Fill to extract the First Name values from column
A into column B.

1. Type: Jessica into cell B4. Be careful to type it exactly as it is
spelled in cell A4. Be careful not to leave any leading or
trailing spaces.

2. Press the <Enter> key to move to cell B5.
3. Type: S (the first letter of Stephen) into cell B5.

Notice that something interesting has happened. Flash Fill has
figured out that you possibly want to extract all the first names
from column A and has displayed them all as grayed out
names in the cells below:

A B C
3 |Name First Name Last Name
4 |Jessica Sagan Jessica

5 |Stephen Bell |Stephen -l
& |John Jennings
7 |Meryl Simpson

8 Alfred Hawking

4. Press the <Enter> key to instruct Flash Fill to enter all the
remaining First Name values.

All the first names appear in column B.

accept the Flash Fill.
B i3 D
4 |lessica Sagan 15
5 |Stephen  Bell SB
6 |lohn lennings 1)

A B c
3 Name First Name Last Name
4 |Jessica Sagan Jessica
5 |Stephen Bell Stephen
6 |JohnJennings John
7 |Meryl Simpson Meryl
8 |Alfred Hawking Alfred

The status bar (at the bottom left of the screen) also confirms

how many cells were changed:

| Ready Flash Fill Changed Cells: 23 |

Use Flash Fill to extract the Last Name values from column

A into column C.

Follow the same procedure you used to extract the first names:

A
3 |Name
4 |lessica Sagan
5 |Stephen Bell
6 |JohnJennings
7 Meryl Simpson

B c
First Name Last Name
Jessica Sagan
Stephen |Be|l .l
John
Meryl

Save your work as

Employee Names-2.
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note

You can also Flash
Fill more quickly by
using the AutoFill
handle

The AutoFill handle is the small
black dot on the bottom-right
corner of the active cell (or
range of cells).

Autofill
fn 1 Handle

In: Lesson 2-16: Use AutoFill
options, you learned that if you
right-click and drag the
AutoFill handle you are
presented with AutoFill options:

Copy Cells

Fill Series

Fill Formatting Only
Fill Without Formatting
Fill Days

Fill Weekdays

Fill Months

Fill Years

Flazh Fill
Series...

You can use the Flash Fill item
on the AutoFill options list to
request a Flash Fill.

This will do the same as
clicking:

Home->Editing > Fill->
Flash Fill

You'll find that this method is
faster than using the Ribbon.

This method is also the
preferred way to provide Flash
Fill with more than one
example result for more
complex problems (you’ll do
this in: Lesson 2-21: Use multiple
example Flash Fill to concatenate
text).

Phone Book-1

Lesson 2-20: Use manual
Flash Fill to split text

Here are two examples of international telephone numbers.

+44 (0)113-4960227 (a UK telephone number)
+356 (0)2138-3393 (a Maltese telephone number)

The country code (or international dialing code) is shown as a + symbol
followed by one or more numbers. The NDD (National Direct Dialing
prefix) is shown in brackets. This is the access code used to make a call
within the relevant country but is omitted when calling from outside the
country. The Area Code consists of the numbers after the closing bracket
but before the hyphen.

In this lesson, you'll use Manual Flash Fill to split telephone numbers into
the Country Code, Area Code and Phone Number like this:

A E < D E
Country Phone
3 [Company Telephone Code  Area Code Mumber
4 |Books A Million +44 (0)113-4960227 +44 113 4560227
5 |Maltese Books +356 (0)2138-3393  +356 2138 3393
6 |Bargain Bookstore +44 (0)115-4960438 +44 115 4960498

In Excel versions prior to Excel 2013 you had to use some very complex
formulas to split this type of text. With the new Flash Fill feature, you can
achieve the same result in seconds.

1 Open Phone Book-1 from your sample files folder.

2 Extract the Country Code from the telephone number in
column B and place it into column C.

If you were to type +44 into cell C4, Excel would interpret it as a
positive number and display the result as 44 (without the plus

sign).
In order to signal to Excel that you want the plus sign to be

displayed, you will need to indicate that +44 should be regarded as
text rather than as a number.

You discovered the technique for doing this in: Lesson 2-1: Enter
text and numbers into a worksheet.

If an apostrophe is placed before a number, Excel will regard it as
text.

1. Type: ‘+44 into cell C4 (an apostrophe followed by +44).
2. Press: <Enter>

3. Making sure that the active cell is in one of the cells that will be
Flash Filled (ie anywhere in the range C3:C18), click:

Home->Editing->Fill->Flash Fill

(Alternatively, you could also use the shortcut keys:
<Ctrl>+<E> to flash fill).

The country code is extracted into the remaining cells in
column C.
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The difference
between Flash Fill
and a formula-based
solution

There are two ways to solve the
problem posed in this lesson:

1. Use Flash Fill

This is the method used in this
lesson. Flash Fill provides a
fast and simple solution.

2. Use complex formulas

Only expert Excel users could
construct the complex formulas
required to split the telephone
numbers contained in the
sample file without the use of
Flash Fill.

In the Expert Skills book in this
series you will solve exactly the
same problem presented in this
lesson without Flash Fill.

Complex formulas are used
instead, to provide a formula-
based solution.

Advantage of a
formula-based
solution

The results of a Flash Fill do not
automatically update when the
source data changes.

This means that if you changed
the telephone number in
column B you would then need
to Flash Fill three times to
update columns C, D and E.

Formula results automatically
update whenever the source
cells change.

This means that if you changed
the telephone number in the
formula-based solution, the
Country Code, Area Code and
Phone Number would
automatically update.

A E C
Country
Company Telephone Code

+44 (0)113-4960227 +44
+356 (0)2138-3393 4356
+44 (0)115-4960498 +44

Maltese Books
Bargain Bookstore

3
4 Books A Million
5
i)

Notice that Excel has placed a green triangle in the top-left

corner of each cell. Excel thinks you may have made an error

but, of course, the value is fine. If you want to remove the
green triangles, use the method you learned in: Lesson 2-4:
Select a range of cells and understand Smart Tags.

Extract the Area Code from the telephone number in column

B and place it into column D.

Use the same method as you did for the country code. The first
area code you need to type is: ‘113

Even though there is no plus sign, it is still useful to include the
apostrophe as it will prevent Excel from re-formatting numbers
(see next step for more on this).

Extract the Phone Number from the telephone number in
column B and place it into column E.

Use the same method as you did for the country code. The first
telephone number is: ‘4960227

In this case you must use a leading apostrophe to prevent Excel
from re-formatting large numbers. For example, the telephone
number: 20180948 would be displayed as 2E+07 if you didn’t
include the apostrophe.

The Country Code, Area Code and Phone Number are now extracted

for every international telephone number:

A B C D E
Country Phone
3 |Company Telephone Code  AreaCode Number
4 |Books A Million +44 (0)113-4960227 +44 113 4960227
5 |Maltese Books +356 (0)2138-3393 +356 2138 3393
& |Bargain Bookstore +14 (0)115-4960498 +44 115 4960498

Save your work as Phone Book-2.

© 2018 The Smart Method® Ltd
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Flash Fill doesn’t
understand
mathematics

Consider this problem:
A B

100 101
1120 1121

180

145

3 pa

You could be forgiven for
thinking that Flash Fill could
populate cells B3 and B4 with
the numbers 181 and 150. In
order to produce this result
Flash Fill would have to detect
a mathematical relationship
between the numbers in
columns A and B.

Because Flash Fill doesn’t
understand mathematics, it will
always see the problem as a
textual one and will produce
this result:

A B
1 100 101
2 1120 1121
3 180 181
4 145 141

Flash Fill has used the logic
“replace the last character
displayed in column A with 17
and not “Add one to the value
displayed in column A”.

Client Names-1

Lesson 2-21: Use multiple
example Flash Fill to
concatenate text

Understand concatenation

In: Lesson 2-19: Use automatic Flash Fill to split delimited text, you learned
how to split text with this example:

A B C
3 |Name First Name Last Name
4 |lessica Sagan lessica Sagan
5 | Stephen Bell Stephen  Bell

In the above example, the text: Jessica Sagan was split into two separate
words: Jessica and Sagan.

Concatenation is exactly the opposite of splitting. The two separate
words Jessica and Sagan can be concatenated to produce the single word:
Jessica Sagan. This is an example of very simple concatenation.

In this lesson, you'll perform some very advanced concatenation using
Flash Fill.

1 Open Client Names-1 from your sample files folder.

This workbook contains a list of very inconsistently formatted
client names:

A B C D
3 |Last Middle First
4 |Sagan Elizabeth Jessica
5 |Bell p Stephen
6 |Jennings John

You want to clean up this data so that client names are consistently
formatted like this:

A B C D
Last Middle  First Formatted Name
Sagan Elizabeth lessica  Sagan, Jessica E.
Bell p Stephen Bell, Stephen P.

[T RN T R Y]

jennings John Jennings, John
Simpson Jane Meryl Simpson, Meryl J.
hawking Alfred Hawking, Alfred
Ashe m Lucille Ashe, Lucille M.

For Flash Fill to automate this task you will need to tell Flash Fill
what is needed by providing more than one example.

2 Type: Formatted Name into cell D3 and bold face the text.
(Excel will probably bold-face the text automatically).

It is important that the header text in row 3 is bold faced.
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A B C D
3 Last Middle First Formatted Name
4 |Sagan Elizabeth lJessica  Sagan, Jessica E.
5 [Bell p Stephen Bell, StephenT.
6 |jennings John jennings, John O.
7 |Simpson Jane Meryl Simpson, Meryl E.
8 |hawking Alfred hawking, Alfred L.
9 |Ashe m Lucille Ashe, Lucille U.
5
6
A B C D
3 |Last Middle  First Formatted Name
4 |Sagan Elizabeth Jessica  Sagan, JessicaE.
5 |Bell P Stephen Bell, Stephen P.
6 |jennings John
7 |Simpson Jane Meryl Simpson, Meryl J.
8 |hawking Alfred
g |Ashe m Lucille Ashe, Lucille M.
7
A B C D
3 |Last Middle  First Formatted Name
4 |Sagan Elizabeth Jessica  Sagan, Jessica E.
5 |Bell p Stephen Bell, Stephen P.
6 |jennings John Jennings, John
7 |Simpson Jane Meryl Simpson, Meryl J.
8 |hawking Alfred Hawking, Alfred
9 Ashe m Lucille Ashe, Lucille M.

8

When Flash Fill sees different formatting in the first row the row is
assumed to be a header row. Flash Fill then excludes the value in
the header row from its logic, providing more reliable results.

Provide a single example result in cell D4.
Type: Sagan, Jessica E. into cell D4.

Flash Fill cells D5:D9 based upon the example result in cell
D4.

You learned how to do this in: Lesson 2-20: Use manual Flash Fill to
split text.

Excel completes the task but the results are not what you wanted
(see sidebar).

With only one example, Flash Fill has completely misunderstood
the requirement.

Provide two example results in cells D4 and D5.
1. Delete the names in cells D5:D9.

2. Provide another example of the correct result (in cell D5).

A B C D
3 |Last Middle  First Formatted Name
4 |Sagan Elizabeth lessica  Sagan, Jessica E.
5 |Bell p Stephen Bell, Stephen P.
6 |Jennings John

Flash Fill cells D6:D9 based upon the example results in
cells D4 and D5.

1. Select cells D4:D9.
2. Click: Home->Editing>Fill->Flash Fill.
This time Flash Fill has done a better job (see sidebar).

Notice the two blank results (for John Jennings and Alfred
Hawking).

Flash Fill doesn’t yet understand how to treat clients without a
middle name. The blank spaces are Flash Fill's way of asking
you for yet another example.

Provide another example result in cell D6.
1. Type: Jennings, John into cell Dé6.
2. Press the <Enter> key.

Usually Flash Fill will instantly replace the value in cell D8. If
it doesn’t, you'll have to manually Flash Fill the entire list
based upon the three examples provided. Do this by
completing the following steps:

3. Select cells D4:D9.
4. Click: Home->Editing—>Fill->Flash Fill.

This time Flash Fill has completed the task successfully (see
sidebar).

Save your work as Client Names-2.

© 2018 The Smart Method® Ltd
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Flash Fill Examples

Lesson 2-22: Use Flash Fill to
solve common problems

Flash Fill (introduced in Excel 2013) is one of Excel’s most useful features.
It isn’t possible to over-state how useful this tool is. I find myself using
Flash Fill almost every day to solve a huge number of different problems.

This lesson gives examples of many everyday tasks that I have found can
be quickly and simply completed using Flash Fill. I've also included all
of the examples in the sample file: Flash Fill Examples.

In the following examples, Flash Fill filled the shaded cells.

Split text

Full Name First Name Last Name
Jessica Elizabeth Sagan Jessica Sagan
Stephen Bell Stephen Bell

John Paul Jennings John Jennings

Extract initials from names

MName Initials

Jessica Elizabeth Sagan JES
Stephen Bell SB
John Paul lennings JPJ

Remove title from names

Full Name Short Name
Miss Jessica Elizabeth Sagan |Jessica Sagan
Mr Stephen Bell Stephen Bell
Mr John Paul Jennings John Jennings

Add commas
(a useful name format for alphabetical sorting)

Name Sort Name
Jessica Elizabeth Sagan Sagan, Jessica
Stephen Bell Bell, Stephen
John Paul Jennings Jennings, John

Concatenate text

First Name Middle Name Last Mame Full Name

lessica Elizabeth Sagan lJessica Elizabeth Sagan
Stephen Bell Stephen Bell

John Paul Jennings |John Paul Jennings
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Concatenate text and insert extra text

First Name Middle Name Last Name Full Name

Jessica Elizabeth Sagan First Name: Jessica, Last Name: Sagan

Stephen Bell First Name: Stephen, Last Name: Bell

John Paul Jennings First Name: John, Last Name: Jennings

Change capitalization

Mixed Case Title Case

jessica elizabeth sagan  |Jessica Elizabeth Sagan
stephen Bell Stephen Bell

john Paul jennings John Paul Jennings

Extract the day, month or year from a date

In all the date-based examples note that the Date column is formatted as a
date. If you progress to the Essential Skills book in this series, you will
learn how to format cells as dates in: Lesson 4-1: Format Dates.

Date Day Date Month Date Year

19th January 2013 19| 19th January 2013 January 19th January 2013 2013
5th August 1967 5| 5th August 1967 August Sth August 1967 1967
20th September 1999 | 20| 20th September 19939 |September 20th September 1993 1999

Extract the day/month from a date

Date Day/Month
19th January 2013 19th January
5th August 1967 5th August

20th September 1999 20th September

Extract domain names from e-mail addresses

E-mail address Domain

Mary@QuiteContrary.com |QuiteContrary.com
Humpty@Dumpty.com Dumpty.com
Jack@Mimble.com Nimble.com

Format telephone numbers

Mame Tel {unformatted) Tel {formatted)
Books A Million 1134960227 (113) 496-0227
Bargain Bookstore 1154960498 (115) 496-0498
Books for Less 1164960593 (116) 496-0593

© 2018 The Smart Method® Ltd
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First Quarter Sales and
Profit-12

Lesson 2-23: Use the zoom
control

Zooming is used to magnify or reduce the worksheet. If you have a lot of
rows in a worksheet and have good eyes, you might want to zoom out
sometimes to see more of the worksheet on one screen.

1 Open First Quarter Sales and Profit-12 from your sample
files folder.

2 Zoom in and out of the worksheet using the mouse wheel.
The fastest way to zoom a worksheet is by using the mouse.

Most mice these days have a wheel in the middle of the buttons. To
zoom using this wheel hold down the <Ctrl> key on the keyboard
and roll the wheel to zoom in and out.

3 Zoom in and out of a worksheet using the zoom control.
The zoom control is at the bottom right of your screen.

Click and drag on the zoom control slider to zoom in and out of
your worksheet. You can also zoom by clicking the plus and minus
buttons on either side of the Zoom control.

Zoom Zoom
out in
Click and
drag to
Zoom Click here to
display the
<€— Zoom dialog

4 Use the Zoom dialog to make cells A3:D9 fill the screen.
1. Select cells A3:D9.

A B C D E
2
3 Jan Feb Mar Average
4 |New York 22,000 25,000 15,000 23,333
5 |Los Angeles 42,000 39,000 43,000 41,333
6 |London 18,000 20,000 22,000 20,000
7 |Paris 35,000 26,000 31,000 30,667
8 |Munich 12,000 15,000 13,000 13,333
9 |Sales 125,000 125,000 128,000

2. Click on the right-hand side of the zoom bar.

-

H B M - ] "WSL

Zoom level. Click te open the Zoom dialeg box.
i
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The Zoom dialog is displayed.

3. Select the Fit Selection option button.
4. Click the OK button.

Magnification
O 2009
O 100%
O 75%
O s0%

n
O Custom: | 400 %

Zoom ? *

The worksheet is zoomed so that the selected cells completely
fill the screen.

New York
Los Angeles
London
Paris
Munich
Sales

W 00 ~N O U1 M

B
22,000
42,000
18,000
35,000
12,000

129,000

C
29,000
39,000
20,000
26,000
15,000

129,000

D
19,000
43,000
22,000
31,000
13,000

128,000

Zoom back to 100% using the Ribbon.

You'll probably find the zoom bar to be the quickest and most
convenient way to zoom, but you can also zoom using the Ribbon.

Click: View—=>Zoom—>100%.

Q2 &

foom 100% ZFoomto
Selection

Zoom

The screen is restored to normal size.

© 2018 The Smart Method® Ltd
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Lesson 2-24: Print out a
worksheet

You aren’t going to explore every option for preparing and printing a
worksheet in this lesson. Printing is such a huge subject that a whole
session is dedicated to it in the Essential Skills book in this series (in
Session Seven: Printing Your Work).

This lesson only aims to teach you the bare minimum skills you need to
put your work onto paper.

1 Open First Quarter Sales and Profit-12 from your sample
files folder (if it isn’t already open).

A B e D E F G
1 |Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar Average Maximum
4 |New York 22,000 29,000 13,000 23,333 29,000
5 |Los Angeles 42,000 39,000 43,000 41,333 43,000
6 |London 18,000 20,000 22,000 20,000 22,000
7 |Paris 35,000 26,000 31,000 30,667 35,000
& |Munich 12,000 15,000 13,000 13,333 15,000
9 |Sales 125,000 125,000 128,000
10
11 |Costs 83,000
12 |Profit 46,000
13 |10% Bonus 4,600
14
15 |UsA sales " 64,000
16 |European Sales i 65,000
17
18 |Monday 1 9 01-Jan-16 Adjusted 01-Jan-16 31-Mar-16
19 |Tuesday 2 18 02-Jan-16 Adjusted 02-Jan-16 31-Mar-16
20 \Wednesday 3 27 03-Jan-16 Adjusted 03-Jan-16 31-Mar-16
21 |Thursday 4 36 04-Jan-16 Adjusted 04-Jan-16 31-Mar-16
22 |Friday 5 45 05-Jan-16 Adjusted 05-Jan-16 31-Mar-16
23 |Saturday 6 54 06-Jan-16 Adjusted 06-Jan-16 31-Mar-16
24 |Sunday 7 63 07-lan-16 Adjusted 07-Jan-16 31-Mar-16

2  Click File=>Print.

Backstage View appears offering many preview and print options:

First Quarter Sales and
Profit-12
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Send the worksheet Preview of how the page
to the printer Select printer will look when printed

First Quarter Sales and Profit-12 - Excel z - O X

@ Mike Smart
Print

New
v Copies: |1 s
= v
Dpen Salcaant Profl fcpodd - firal Cuaricr 2008
Print - .
Save o ot P
f— wme  asms
- d rara mme  ams
Save As Printer = iz
. hp LaserJetv?_C' UPD PCL& ce .m0
[t ‘% Ready o sms
Share Printer Properties e e
. sty : T Siaeis adais
Settl ngs Temday D s cnaess g
Expalt , , Troiee + % oruems e
lj__l Print Active Sheets e . -
- Taturday - 3 mEleiE dpatod
Publish Only print the active sheets Sumfay Hl a1 oTaeue aspates
Pages: : to :
Close - .
E Print One Sided
-
Only print on one side of th...
= Collated
Account E -
EE 123 123 123
Options D Portrait Orientation -
Feedback A4
[] -
21 emx 29.7 cm
@ Normal Margins
-
Left: 1.78 em  Right: 1.78 cm Show margins
[M™  MNoScaling
-
Dmo Print sheets at their actual size

Page Setup 401 |of1 ¥ @
i N 7 r

Print options Move to a different page Zoom preview

3 Click on the zoom button to see the zoom feature
working.

Each time you click on the button the page zooms in and out.

If you have a large screen you may not see a lot of difference when
you zoom.

4 Print the worksheet.
Click the Print button:

=

Print

The page is printed on the selected printer.
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1
2

10

11
12

Open a new blank workbook.
Use AutoFill to put the three months Jan, Feb, and Mar into cells A4:A6.

Using only the keyboard, add the following data:

A B C D E
1 |Profit Analysis
2
3 London  Paris New York Average
4 |lan 2,500 3,100 2,300
5 |Feb 2,200 2,700 2,600
& |Mar 2,100 2,600 2,800
7 |Total

Use AutoSum to compute London’s total profit for Jan/Feb/Mar in cell B7.
Use AutoSum to compute the average January profit in cell E4.

Use AutoFill to extend the London total in cell B7 to the Paris and New York totals in cells C7 and
D7.

Use AutoFill to extend the January average profit in cell E4 to the February and March average
profits in cells E5 and E6.

Select all of column A and all of column E (at the same time) and bold face the values in them.

Select row 3 and row 7 (at the same time) and bold face the values in them.

A E < D E
1 | Profit Analysis
2
3 London  Paris New York Average
4 |Jan 2,500 3,100 2,300 2,633
3 |Feb 2,200 2,700 2,600 2,500
& Mar 2,100 2,600 2,300 2,500
7 |Total 6,300 8,400 7,700

Select cells B4:B6 and cells D4:D6 at the same time and then read the total London and New York
sales figure for Jan, Feb and March from the summary information displayed on the status bar.

Select cells B4:D6 and zoom the selection so that these cells fill the screen.

Save your work as Exercise2-End.

If you need help
slide the page to
the left
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These are the questions that students find the most difficult to answer:

1. Hover over the center of | 1. Click on the column | 1. Click in cell B7. 1. Type Jan into cell
cell B4 so that you see the | A header. 2 Click: A4 and press the
white cross cursor shape. T ' ) <Enter> key.
. 5| Home->Editing—>
d::JZ,S{K] 1 JProﬁt Analysis 2. Click cell A4 once
AutoSum

to make it the active

i 2.Hold d th
2. Click and drag down to old down the S| A cell
cell B6. <Ctrl> key. i zZY
' Sort & Find & | | 3. Hover the mouse

i. Hold down the <Ctrl> % ﬁ;‘;l;?n the column & Clear -  Filter= Select~ | | cursor over the

€y ’ EA bottom right corner
4. Hover over cell D4 until | 4. Click: 3. Either press the of the cell until you
you see the white cross Home->Font->Bold <Enter> key or click the see the black cross
cursor Shape. AutoSum button agajn‘ cursor shape.
5. Click and drag down to Calibri ML This was covered in: lan
cell Dé6. [1'4\5‘ I U~ |~ Lesson 2-3: Use AutoSum :
6. Look at the status bar at Font to quickly calculate totals. 4. Click and drag
the bottom right of the This was covered in: down to cell A6.
screen. Lesson 2-6: Select This was covered in:
This was covered in: Lesson | adjacent and non-adjacent Lesson 2-14: Use
2-7: Select non-contiguous rows and columns. AutoFill for text and
cell ranges and view numeric series.

summary information.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:
Refer to: Lesson 1-1: Start Excel and open a new blank workbook.

Refer to: Lesson 2-1: Enter text and numbers into a worksheet.

Refer to: Lesson 2-3: Use AutoSum to quickly calculate totals.

Refer to: Lesson 2-15: Use AutoFill to adjust formulas.

Refer to: Lesson 2-15: Use AutoFill to adjust formulas.

Refer to: Lesson 2-6: Select adjacent and non-adjacent rows and columns.

Refer to: Lesson 2-23: Use the zoom control.

= = O N O O W =

N =

Refer to: Lesson 1-6: Save a workbook to a local file.
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Index

arrange all, 64
audio cues, enabling, 22
AutoComplete
formula entry using, 87
AutoFill
custom fill series, creating, 94
date series, examples of, 92
formulas, using to adjust, 90
smart tag options, using, 92
text and numeric series, creating with, 88
AutoFit rows and columns, 79
AutoSave, 36, See also versions
draft versions, explanation of, 36
time interval, changing, 36
AutoSum, 66
AVERAGE functions, creating with, 82
MAX functions, creating with, 82
SUM a non contiguous range with, 80
AVERAGE function, 82

backstage view, 44
backup. See also AutoSave
automatic backups, reverting to, 36
RAID array, use of to improve resilience, 36
time interval for automatic backups, changing,
36

c_

cancel button, 62
cells
active cell, 76
deleting, 82
deselecting, 74
entering text into, 62
entering values into, 62
selecting a range of, 69
selecting all in a worksheet, 79
channels. See update channels
check box, 42
close button, 24
columns
making several the same size, 79
resizing automatically, 78

selecting, 72
selecting non contiguous, 72
width of, manually changing, 79
confirm button, 62
crash, recovering from, 36
currency
prefixes, 63
cursor shapes, explained, 69

delete, recovering work accidentally deleted, 36
dialog launcher, 43
documents. See also files
organization of, 32
pinning, 32
downloading the sample files, 11, 26
draft versions, explanation of, 36
drop-down list, 43

editing cell contents, 62
Excel workbook file format, 28, 30
exponential. See series

files. See also workbooks; documents
default workbook file location, setting, 33
formats supported, 28, 30
organization of, 32
recent workbooks list, increasing the number of

entries in, 32

flash fill
autofill handle, using to apply, 100
automatic, use of, 98
examples, 104
extracting initials with, 98
formula based solution, compared to, 101
header rows, importance of formatting for, 98
manual, use of, 100
multiple examples, use of, 102
numbers, working with, 102
splitting delimited text with, 98
switching on, 98
telephone numbers, formatting with, 100
use of seperators with, 98
using to solve common problems, 104
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formula bar
explanation of, 68
graphic showing location of, 28
formulas
Autocomplete, creating with, 86
AutoFill, adjusting with, 90
AVERAGE function, creating using AutoSum,
82
F2 key to display range addressed by, 83
formula bar, viewing in, 68
MAX function, creating using AutoSum, 82
mouse selection, creating with, 84
multiplication operator (*) using in, 85
SUM function, creating using AutoSum, 66
syntax box, understanding, 87
visual keyboard technique, creating with, 85
fractions, entering into cells, 63
full screen view, 50
functions
AVERAGE, 82
help topics, accessing from formula
AutoComplete, 87
MAX, 82
SUM, 66, 80

gallery, 42
goto special, 77
growth. See series

help system. See also tell me help
F1 key, accessing older help system with, 54
formula AutoComplete, accessing help topics
from, 87
ribbon, accessing help topics directly from, 54

key tips, 46
keyboard shortcuts
AutoSelect a range, 77
AutoSum, 66
bold, 47
close, 25
cycle through worksheets, 35
flash fill, 100
italic, 47
ribbon, show/hide, 40
save, 28
select every cell in a worksheet, 78

underline, 47
workbook, create new, 64

‘

license. See also update channels
Excel 365, 20
perpetual and subscription, differences, 20
subscription, 20

marching ants, 66
marquee, 66
MAX function, creating using AutoSum, 82
maximize button, 24
menus
rich, 43
shortcut (contextual), 47
standard, 42
mini toolbar
shortcut (contextual) menu, 47
using when entering text, 46
minimize button, 24
moving
the Excel window, 24
multiplication operator (*), 85

name box, 26

negative numbers, entering into cells, 63
normal view, 48

number sign (#), 78

office theme, changing, 22
office version
checking Excel version, 21
version number and build number explained,
20
organizing
excel files, 32
sample files folder, 26

page break preview, 48
page layout view, 48
PDF, workbook format, 31
pound sign (¥), 78
printing

page break preview, 48
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previewing on screen, 44
protected view, potential problems when
downloading sample files, 26

quick access toolbar
adding commands to, 44
adding separators to, 44
deleting commands from, 44
quick analysis
totals, creating with, 67
quotations
Aristotle, 42
Baltasar Gracian, 96
Confucius, 5
Euripides, 17
Robert Collier, 24
Winston Churchill, 4

RAID array, 36
ranges
AutoSelect, selecting automatically with, 76
copying data across, 70
entering data into, 70
non contiguous, selecting, 74
select all button, to select a range containing
every cell in a worksheet, 79
selecting, 68
selecting visually for formulas with the mouse,
84
restore down button, 24
ribbon
benefits of wide screen with, 40
command groups on, 42
contextual tabs, explanation of, 40
controls on, 42
customizing, 40
default, resetting to, 40
font panel controls, explanation of, 40
overview, 40
showing and hiding (minimizing), 40
rows
making several the same size, 79
manually setting height of, 79
resizing automatically, 78
selecting, 72
selecting non contiguous, 72

sample files
downloading, 11, 26
organizing folder, 26
potential protected view problem when
downloading, 26
save, 28, 30
AutoSave, using to recover work after crash, 36
selecting cells, 68
series
dialog, 96
exponential, 96
growth, 96
linear, 96
start value, 96
step value, 96
stop value, 96
smart tag
explained, 68
options, 92
sounds
enabling audio cues, 22
split button, 42
start Excel, 18
SUM function
creating manually using formula
AutoComplete, 86
creating using AutoSum, 66
switch windows, 64

tabs. See worksheets
telephone numbers, formatting with flash fill, 100
tell me help
Alt+Q keyboard shortcut, using to access tell
me help box, 52
execute command, using to, 52
using, 52
the smart method
learning by participation, 5
two facing pages rule, 4
themes. See also office theme
title bar, 64
trend. See also series
linear and exponential, 96
trend line. See charts

update channels
automatic updates, enabling, 20
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explained, 20
updates. See update channels

values

currency prefixes, using with, 63

entering into cells, 62

fractions, entering into cells, 63

negative numbers, entering into cells, 63
versions. See also AutoSave

earlier versions, viewing, 38

explanation of, 36

recovering an earlier version of a workbook, 38

windows

arrange all, using to automatically size, 64

closing, 24

moving, 24

resizing, 24

restoring down, 24

switching to view a different workbook, 64
workbooks. See also files

changing default number of worksheets in, 34

creating new, 64
opening, 26
recent workbooks list, increasing the number of
entries in, 32
saving, 28, 30
switching between open workbooks, 64
viewing two at the same time, 64
views, 48
worksheets
adding, 34
changing default number of, 34
chart worksheets, explanation of, 34
deleting, 34
maximum number of rows and columns in, 26
navigating, 26, 34
renaming, 34
tab colors, changing, 35

XPS, workbook format, 31

zoom control, 106
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Moving to the next level

The next book/e-book in this series (Essential

Learn . . . .
il Skills) builds upon the basic skills you’ve
Excel 2016 “"" already learned.

Essential Skills

With The Smart Method When you have c9mpleted this book/e'—book you will have

ether you o compot 2016 oruprocing rom excellent Excel skills, good enough to impress any employer,
and your Excel skills will be better than most office workers
(even those with many years of experience).

You'll be able to create beautifully laid-out worksheets that
will really impress and will have completely mastered all of
Excel’s charting features.

The paper printed book is always in stock at Amazon.

The e-book is published in unlocked, printable PDF format
(just like this basic-skills e-book) and is only available from:
https://thesmartmethod.com (this is the publisher’s own web
site).

Mike Smart

The last book in the series (Expert Skills)

Leam covers only the most advanced Excel features.

Excel 2016 *"
Expert SKi"S This book will give you advanced Excel skills that are rarely

With The Smart Method mastered by the average user. By the end of the book you’'ll
be a true Excel expert, able to use all of the power available
from the world’s most powerful business tool.

Your Excel skills will be greater and broader than almost all
other Excel users in the workplace.

The paper printed book is always in stock at Amazon.

The e-book is published in unlocked, printable PDF format
(just like this basic-skills e-book) and is only available from:
https://thesmartmethod.com (this is the publisher’s own web

Mike Smart site).

About our e-books

XEAD ON ANY DEVIC
e READ ONANY DEVICE QOur e-books are not
very popular web browser and e-book . -
reader can open a PDF file. Our PDF e- locked with DRM (digital

books can be read on just about any rights management)
device without having the bother of finding
and installing reader software.

You can legally print
: your e-book for your
n own personal use.
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- Learn how to apply your new Excel skills with a
E’;ﬁgl I?I.I()c1t(is(;nW;(it #1 Smart Method construction kit

Calendar and Year Planner

: For over 900 years craftsmen have traditionally taught their
| consiruction kit you'l learn how to use and apply advanced . . . .
to construct a robust Excel business application that would be Skﬂls tO an apprentlce. In thls model the apprentlce learned

the powers of most advanced Excel users.

struct the application, you'l leamn advanced Excel techniques his trade by observing how the master craftsman used his

be able to apply in the future to a multitude of Excel business
problems.

skills. This construction kit will teach you advanced Excel
skills in the same way. Even if you only have basic Excel
skills, the construction kit is designed in such a way that
you'll be able to construct a complex, polished professional
Excel application that would be well beyond the powers of
most advanced Excel users. Available as both a printed
paper book and e-book.

Preview the first chapter free at:

The companion Web site has sample files )
at: http:/ExcelCentral.com Mike Smart

https://thesmartmethod.com

Excel Challenges Excel Challenges

Our Excel online challenges are a little like the exercises at the
end of each session in this book. Unlike the exercises, the

online challenges will test the application of many skills
Function (covered in different sessions in the book).

We began trialling challenges in July 2018 and (at time of
writing in August 2018) we have published three challenges
but by the time you read this book we may have produced
more.

Access the challenges online at:
Test Your Excel skills

Challenges are graded to
Basic, Essential and Expert level

https://thesmartmethod.com/excel-challenges/
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Use your new Excel skills to teach your
own classroom courses.

If you’ve worked through this book carefully you will now have excellent Excel skills and if you progress to
the Expert Skills book in the series, you'll be a true Excel expert. There is a huge demand, everywhere in the
world, for Excel training at all levels. The skills you have learned in this book will enable you to teach an
introductory Excel course (providing all of the skills needed by most office workers).

We can directly and rapidly supply books, at educational discount prices, to Excel instructors, corporate
clients, schools, colleges and universities from our warehouses in the USA (also serving Canada), UK (also
serving Europe) and Australia (also serving New Zealand).

Our books are printed in the USA, UK, Australia, Germany, Italy, Spain, Brazil, Poland, South Korea, China,
India, and Russia so are instantly available, in almost every country in the world, by simply quoting the
ISBN number (shown below) to any bookseller or wholesaler.

Use our books to teach all Excel versions.

This book is available for all Excel versions in common use (Excel 2007, 2010, 2013, 2016 for Windows and
2016 for Apple Mac). This means that you'll be able to teach Excel classes even if the client uses an
earlier/later version or uses Apple computers. You can use the books as courseware during your classes and
then give each student a copy of the book to take home as reference material when the course is over.

Windows Titles Mac Titles

Learn Leam Learn Leamn
Excel 2013 Excel 2013 Excel 2016 55 § Excel 2016 55"
Expert Skllls Essential Skills Ess Expert Skills

Learn

Excel 2016 '
Expert Ski

With The Smart Method

With The Smart Method With The Smart

978-1-909253-08-7 978-1-909253-07-0 978-1-909253-06-3 978-1-909253-11-7 978-1-909253-12-4

Leam

Excel 2010
Expert Skill

r|1h The Sm

Leam ea Leamn
Excel 2010 Excel 2007 Excel 2007
Essential Skllls Expert Skills Essential Skills

With The Smart Method With The Smart Method

978-0-9554599-8-6 978-0-9554599-7-9 978-0-9554599-3-1 978-0-9554599-2-4

You can quote the ISBN numbers shown above to any book retailer or wholesaler. All major distributors (in
every country of the world) have our books in stock for immediate delivery.

Place a direct order for 5+ books for
wholesale prices and free delivery

To place a publisher-direct order you only need to order five books or more (of the same title). To view
wholesale prices, go to this web page:

https://thesmartmethod.com/wholesale-printed-books
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